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1MRS752008-MUM Tools for Relays and Terminals
1. SM/RED

1.1. Description
SM/RED includes RED object types. An object type is a package that contains relay 
configuration descriptions, profile files, standard function pictures and data files, 
format pictures and texts.

SM/RED package is used in the CAP 501 Relay Setting Tools, CAP 505 Relay 
Product Engineering Tools, SMS 510 Substation Monitoring System and 
MicroSCADA application libraries LIB 500/510.

Object types are named according to the relay type. For example, all configuration 
descriptions of the relays REF541, REF543 and REF545 will be stored under the 
object type REF54x.

1.1.1. Communication support

1.1.1.1. CAP 501/505, SMS 510
• LON
• SPA

1.1.1.2. LIB 500/510 in MicroSCADA
• LON
• SPA

1.2. Installation and configuration

1.2.1. CAP 501/505
After a SM/RED relay has been inserted (use Add function) to the project tree, it has 
to be configured with the Properties/Attributes... function, see Fig. 1.5.2.-1. This is 
described in Section 1.4. SM/RED Object Types. Communication settings are 
described in Section 1.5.Configuring Communication Settings.

1.2.2. SMS 510
Please see SMS 510 Operator’s Manual.

1.2.3. LIB 510/MIcroSCADA: installing and configuring REx terminals
The following steps and tools are required for a REx terminal picture function in 
MicroSCADA:

1. Installation of the terminal picture function (Installation Tool)
2. Configuration of the terminal picture function (Standard Configuration Tool)

• Attributes 
• REx Configuration (Object Configuration Tool)
• Communication settings (Cconfig Tool)
• Event handling (Event Editor)
• Picture function object (Representation Tool)
1
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3. Terminal parametrization (RED Relay Tool)

Steps one and two are shortly described in the following sections, but relay 
parametrization is beyond the scope of this manual, please see LIB 510 Operator’s 
Manual, RED Relay Tool.

Steps 1 and 2 above are accessed from the Tool Manager/Picture Editor. The 
document LIB 500 Base Configuration Manual (Introduction), gives a general 
description of the principles for installing and configuring picture functions. For 
every terminal a separate picture function is added to the process picture. Please see 
the Operator’s Manual and the Technical Reference Manual of the relevant terminal 
for further information.

1.2.3.1. Installing terminal picture functions
In the installation tool, choose LIB4/LIB 510/PROTECTION & CONTROL. Select 
an appropriate object type, e.g. REF54x and click once by mouse. After the RED 
standard function has been highlighted, enter a Picture Function Name for the 
function and click the Install button. Place the function anywhere in the base picture. 

Fig. 1.2.3.1.-1 The procedure for installing a terminal picture function, terminal picture function REF2 was 
successfully installed, visible icon in the upper left corner.
2
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1.2.3.2. Terminal picture function configuration
The following flowchart shows the procedure of adding and preparing relay 
terminals for the process picture.

Fig. 1.2.3.2.-1 The procedure of the terminal configuration

The Object Configuration Tool is opened from the Tools menu of the Standard 
Configuration Tool. The configuration of the relay can be divided into four phases.

1. Relay terminal object type selection and configuration, SW library and APL 
library (Object Configuration Tool). (Function described in this manual, Section 
1.4. SM/RED Object types.)

2. Storing terminal specific data (e.g. communication type in CConfig tool). 
(Function described in this manual, Section 1.5. Configuring Communication 
Settings.)

3. Event configuration (Event Editor). (Function described in LIB 510 
Configuration Manual, Event Editor Configuration Manual.)

4. Storing terminal picture function data is done by the Standard Configuration 
Tool by selecting Apply or OK.

� Before starting the configuration, please ensure that the base system objects 
concerning the stations and nodes are correctly configured.
3
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1.2.3.3. Standard Configuration Tool functions
Select the terminal picture function. Start the Standard Configuration Tool to modify 
the configurable attributes and to start the REx Configuration Tool. The pages 
Attributes and Tools are described in this section. The Representation Tool in the 
Tools menu is not described.

Attributes page
The following configurable attributes of the installed object are possible to change. 
A description of the configurables and the different choices follows below.

Fig. 1.2.3.3.-1 Standard Configuration Tool/Attributes page
4
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Table 1.2.3.3-1 Configurable attributes that can be changed for the installed 
objects.

Saving relay data to the picture function
After you have configured the relay terminal using the configuration tools, the data 
has to be saved to the picture function. This is done by using the Standard LIB 
Configuration Tool commands Save attributes or Apply attributes.

Copying picture function data
To copy picture function data and to paste it into another picture function, use the 
commands Copy attributes and Paste attributes in the Standard Configuration Tool. 
After you have copied the picture function data, open the Object Configuration Tool 
and make the necessary definitions (addresses etc.).

Deleting picture function
To delete the picture function, select the option Delete in the Standard Configuration 
Tool.

� Remember to save the picture function data before you exit the Standard 
Configuration Tool.

Configurable Choices

STATION_NAME The name of the substation. As a default the maximum length 
of the text is 9 characters. This text will be used as a 
substation identifier of the relay objects on event list, alarm 
list, printout, database query, etc. It is very important that this 
text is similar to all objects within the same substation.

BAY_NAME The name of the bay/feeder. As a default the maximum length 
of the text is 14 characters. This text will be used as a bay/
feeder identifier of the relay objects on event list, alarm list, 
printout, database query, etc. It is very important that this text 
is similar to all objects within the same bay/feeder.

DEVICE_NAME The name (identifier) of the relay. As a default the maximum 
length of the text is 5 characters. This text will be used as an 
identifier of the relay on event list, alarm list, printout, 
database query, etc.

AUTHORIZATION GROUP The authorization group used for the object.

VISIBLE Visibility of the relay unit object button in the process picture.

LIB_OBJECT_NAME Identifies the relay object. The name should be unique within 
the application. The logical names of event process objects 
will be created by using this name:
 LN = LIB_OBJECT_NAME + Index (A-Z, 1..). (A specific 
character is defined by the Event Editor) 
Max. length of attribute: 9 characters.
5
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Tools page

Fig. 1.2.3.3.-2 The Standard Configuration Tool dialog

The following tools can be started from the Tools page in the Standard 
Configuration Tool:

• Object Configuration Tool for selection of terminal type and application library 
(Function described in this manual, Section 1.4.SM/RED Object types)

• Cconfig Tool for communication settings (Function described in this manual, 
Section 1.5 Configuring Communication Settings)

• Event Editor for event handling (Function described in LIB 510 Configuration 
Manual, Event Editor Configuration Manual)

• Representation Tool for picture function symbol used for the terminal object

Object Configuration Tool
• The standard function parameters for the relay unit are configured via the Object 

Configuration Tool. The main function of the tool is to configure the relay 
terminal.

The Object Configuration Tool is started from the Standard Configuration Tool by 
selecting Tools/Object Configuration Tool.

The data for the units is read from the REF 54x object type library. These 
descriptions are stored in the directory lib4/fmod/sm_red.

The following example concerns the REF 54x relay.
6
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Fig. 1.2.3.3.-3 The dialog appearing when REF 54x Configuration is selected

1.2.3.4. Terminal parametrization
After the terminal picture function configuration, the terminals are parametrized by 
the RED Relay Tool, see LIB 510 Operator’s Manual, Chapter 3. Relay RED Tool 
Operator’s Manual.

1.3. Object types general

1.3.1. Projects
A project is a collection of object instances arranged in a hierarchical order. Object 
hierarchy is achieved by the use of nodes. Each node behaves like a directory in a 
file system where each directory may contain files (in this case object instances). A 
project always has a root node (resembling the root directory in a file system) and it 
is also possible that this is the only node in the whole project. In CAP 5xx the default 
project is named SOST for Simple Object Selection Tool. In MicroSCADA both the 
project and directory name is PRJ in the PROTECTION directory under application.

In technical terms, a project is stored on disk in directories. Each project has its home 
root directory, for example SOST. The next directory level has OBJ#### directories 
7
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where #### stands for a sequence number. Each object has a home directory of its 
own in the directory structure, e.g. SOST\OBJ0001.

1.3.2. Object types
Object types determine the information structure and functionality of an object 
instance. 

All dialogs and program codes that control the behaviour and structural design of the 
object instance are stored in the object type resource files. This relationship between 
object types and object instances resembles drivers in an operating system, where 
some drivers control physical devices and some control the behaviour of the 
operating environment itself.

1.3.3. Object type groups
Object type group can be considered as a collection of object types that serve the 
same purpose. For example, among a number of other types, the SPACOM and 
REF54X object types belong to the object type group Protection & Control.

1.3.4. Objects
Each object in a project is an instance of an object type. Generally applicable 
information is taken from the object type, while the instance stores settings, e.g. 
parameter values. These values are later used by the object type or by a tool that is 
adapted to use the information structure of the object.

The object type determines the file structure for the object instance. Some object 
types prefer to save all object specific parameters in a single file in the object 
directory. Other object types use subdirectories with a various number of files. Tools 
that have been adapted for use with the object type information structure then use 
object information stored in these parameter files when the object instance is 
selected for a tool.

1.3.5. Languages
The languages used for the HSI files of the Relay Setting Tool are supported 
according to the ISO 639 standard. In practise this means that the relay setting tool 
will use the defined monitor language for the HSI texts. The directories containing 
the language texts are made in accordance with ISO 639. 

1.4. SM/RED object types

1.4.1. General

Fig. 1.4.1.-1 Icon for standard function in LIB 510/MicroSCADA

Table 1.4.1-1 The file names and their locations in the package 

File Name FRI_REF54x.DAT

FRI_REC52x.DAT

FRI_REM54x.DAT
8
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1.4.2. REF 54x, REC 52x, REM 54x
This paragraph describes the operation and properties of the object types REF 54x, 
REM 54x and REC 52x. However, as these object types share the same operating 
principle, this paragraph refers to the REF 54x object type only.

1.4.2.1. General
The REF 54x object type configures object instances for REF 541, REF 543 and 
REF 545 terminals. The software configuration determines which REF terminal is 
being configured. Used function blocks determine the relay functionality. This 
information is stored in the application configuration. The REF 54x object type only 
configures the object instance, no communication takes place against the actual 
relay. When an object instance is configured, it is possible to apply its configuration 
in an appropriate tool. For instance, Relay Setting tool, Relay Configuration tool and 
the Relay Mimic Editor apply to object instances that belong to the REF 54x object 
type.

In the REF 54x configuration dialog you can choose the following functions:

• Select relay unit software and application configurations
• Save an application configuration to the application library
• Delete an application from the application library
• Export from the application library 
• Import to the application library
• Receive an application from the relay to the user application library

The page REF 54x Config is divided into two sections: SW configuration and Apl 
configuration. 

FRI_REJ5xx.DAT

FRI_REU5xx.DAT

FRI_REX52x.DAT

File Location in Package SM_RED/REF54x/INST

SM_RED/REC52x/INST

SM_RED/REM54x/INST

SM_RED/REJ5xx/INST

SM_RED/REU5xx/INST

SM_RED/REX52x/INST
9
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Fig. 1.4.2.1.-1 The REF 54x object type dialog

1.4.2.2. SW configuration

Selecting SW configuration
A new SW configuration can be selected from the SW library list. Before you select 
a new SW configuration, the SW library list must be activated by checking the Select 
New check box. You can select a specific SW library version from the Rev Nr list.

The Installed configuration field displays the most recently installed SW 
configuration.
10
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Fig. 1.4.2.2.-1 Selecting a new SW configuration

1.4.2.3. Apl configuration

Selecting Apl configuration
A new Apl configuration can be selected from the Apl library list. Before you select 
a new Apl configuration, the Apl library list must be activated by checking the Select 
New check box. You can select a specific application configuration version from the 
Rev Nr list. If the Apl configuration is a ‘user-made’ application (see Fig. 1.4.2.4.-
2), it has no version number.

The Installed configuration field shows the most recently installed Apl 
configuration.

The Description field shows the application description.
11
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Fig. 1.4.2.3.-1 Selecting a new Apl configuration. The Apl library list also 
contains applications made by the user

1.4.2.4. Apl Utils
This section gives an overview of additional application library management 
functions.
12
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Fig. 1.4.2.4.-1 Application library utilities. The Receive function is not available 
in LIB 500 environment 

Save
A designed application can be saved from the target object to the application library 
by using the Save command. In the following dialog the Application Name is a 
single-word name and the optional Application Description is a short description of 
the application.

Choose the Save button to save the application as a ‘user-made’ application. ‘User-
made’ applications appear in the Apl library list (see Fig. 1.4.2.3.-1).
 

Fig. 1.4.2.4.-2 Save dialog

Rename
An application name can be changed by using the Rename command. An application 
can be renamed and the Application Description can be changed in the following 
dialog.
13
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Fig. 1.4.2.4.-3 Dialog for renaming an application and changing its description

Delete
Deleting an application from the application library is an irreversible operation. All 
files belonging to the application are deleted. In the following dialog you are 
requested to select an application from the Apl library list. Only applications made 
by the user appear in the list.

Fig. 1.4.2.4.-4 Dialog for deleting an application from the application library

Export
A relay application can be exported from the application library to some other 
location specified by the user. The destination location can be on the local system or 
on a network drive or a floppy: The destination location is specified as a directory 
path, e.g. C:\APPLICATIONS (the destination directory must already exist when 
you choose Export command). Select the application from the Apl library list and 
click Export. Only applications made by the user are shown in the list. 

An example of the usage of this export function is e.g. when the relay application is 
made by CAP tools and should be transferred to MicroSCADA. Before it can be 
taken into use, it should also be imported by the Import function. More information 
is provided in the section dealing with importing. 
14
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Fig. 1.4.2.4.-5 Dialog for exporting an application

Import
The import function adds applications to the apl library. After you have exported the 
application, you should import it to the target system in order to add the application 
to the Apl list. Please ensure that the REF 54x version, which is imported, is the 
same version or is compatible with the REF 54x version to which it is imported.

If the applications are exported by using the REF54x object type version 1.2.4 or 
later, select the option Compressed application file. Give a full path of the file. In 
this case the application subject to import is always in a compressed format.

If the application is exported by using an earlier version than the REF54x object type 
version 1.2.4, select the option Uncompressed application folder. Give a path of the 
folder containing the application.

Click the Import button in order to import the an application to the Apl library.

Fig. 1.4.2.4.-6 Import dialog
15
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Receive
A Relay application can be received from the relay to the user application library by 
using the Receive command. After clicking the Receive button, the following dialog 
requesting a confirmation appears on the screen. At this moment it is only possible 
to receive Relay Setting Tool configuration from the relay. This means that the 
received application is not complete and that it only contains data for the Relay 
Setting Tool.

Fig. 1.4.2.4.-7 Dialog for confirming selection

If the Receiving process was completed successfully, the following dialog appears 
for the naming of the application.

Fig. 1.4.2.4.-8 Dialog for naming application
16
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1.4.2.5. Transducer settings

Fig. 1.4.2.5.-1 Giving transducer settings

When you set the transducer values, the expectation is that the input values to the 
relay function blocks are of the same type; i.e. that an Io input on the relay function 
block gets the input from an Io source. The same is expected for In, Uo and Un. See 
example in Fig. 1.4.2.5.-2:
17
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Fig. 1.4.2.5.-2 Example of function block configuration where the In inputs are connected to In inputs on the 
function block and the Io inputs are connected to Io function block inputs

If the inputs to the function block input are different from the inputs that the function 
block normally uses, it is recommended that the transducer settings are taken out of 
use. Remove the In Use selection (see Fig. 1.4.2.5.-1.)

When the transducer settings are taken out of use, settings in the RED Relay Tool 
can be done only by time nominal values. See Fig. 1.4.2.5.-3.
18
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Fig. 1.4.2.5.-3 The encapsulated area (primary values) is disabled when there are no transducer settings in use.

1.4.3. REX 52x
This section describes the REX 52x object type and its properties.

1.4.3.1. General
The REX 52x object type configures object instances for REX 521 terminal. The 
HW configuration determines, which REX terminal is being configured. Used 
function blocks determine the relay functionality. This information is stored in the 
Standard Configuration. The REX 52x object type only configures the object 
instance, no communication takes place against the actual relay. When an object 
instance is configured, you can apply its configuration in an appropriate tool. For 
instance, Relay Setting Tool applies to object instances that belong to the REX 52x 
object type.

Use the REX 52x configuration dialog to select the relay unit HW and Standard 
Configurations. The REX 52x Config page (see Fig. 1.4.3.1.-1) is divided into two 
sections: HW configuration (described in Section 1.4.3.2.) and Standard 
configuration (described in Section 1.4.3.3.).
19
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Fig. 1.4.3.1.-1 REX 52x Config page is divided into two sections: Hardware 
configuration and Standard configuration.

1.4.3.2. HW configuration

Selecting HW configuration
The HW configuration can be selected from a list where all supported HW 
configurations for the specific relay type are listed. Before you select a new HW 
configuration, you must activate the HW library list by checking the Select New 
check box (see Fig. 1.4.3.2.-1). From the Rev list you can select a specific HW 
library version. The Installed configuration field displays the most recently installed 
HW configuration.
20
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Fig. 1.4.3.2.-1 Before you select a new HW configuration, you must activate the 
HW library list by checking the Select new check box.

1.4.3.3. Standard configuration

Selecting standard configuration
The standard configuration can be selected from a list where all available standard 
configurations for the specific HW configuration are listed. A specific Standard 
configuration version can be selected from the Rev list (see Fig. 1.4.3.3.-1). The 
Installed standard configuration field shows the most recently installed standard 
configuration. The Description field shows the Standard configuration description.
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Fig. 1.4.3.3.-1 A specific standard configuration can be selected from the 
Standard configuration library. The Installed standard 
configuration field shows the most recently installed standard 
configuration.
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1.4.3.4. Transducer settings

Fig. 1.4.3.4.-1 Giving transducer setting 

When you set the transducer values, the expectation is that the input values of the 
relay function blocks are of the same type; i.e. that an Io input on the relay function 
block gets the input from an Io source. The same is expected for In, Uo and Un. See 
example in Fig. 1.4.3.4.-2:
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Fig. 1.4.3.4.-2 Example of a function block configuration, where the nominal currents are connected to the In 
inputs and the Io current is connected to the Io input in the function block.

If the inputs to the function block input are different from the inputs that the function 
block normally uses, it is recommended that the transducer settings are taken out of 
use. In this case, remove the In Use selection, see Fig. 1.4.3.4.-1.

When the transducer settings are taken out of use, settings in the RED Relay Tool 
can be done only by the time nominal values (see Fig. 1.4.3.4.-3).
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Fig. 1.4.3.4.-3 The encapsulated area (primary values) is disabled when there are no transducer settings in use

1.4.4. REJ 5xx, REU 5xx
This section describes the operation and properties of the object types REJ 5xx and 
REU 5xx. However, as these object types share the same operating principle, only 
REJ5xx object type is mentioned in this section.

1.4.4.1. General
The REJ 5xx object type configures object instances for REJ 511, REJ 521, REJ 
513, REJ 523, REJ 515 and REJ 525 terminals. The software configuration 
determines which REJ terminal is being configured. Used function blocks determine 
the relay functionality. This information is stored in the application configuration.

 You can the REJ 5xx configuration dialog to select relay unit software and saving 
transducer settings.
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Fig. 1.4.4.1.-1 The REJ5xx Object type dialog

1.4.4.2. SW configuration

Selecting SW configuration
A new SW configuration can be selected from the SW library list. Before you select 
a new SW configuration, you must activate the SW library list by checking the 
Select New check box. A specific SW library version can be selected from the Rev 
Nr list.

The Installed configuration field displays the most recently installed SW 
configuration.
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Fig. 1.4.4.2.-1 Selecting a new SW configuration
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1.4.4.3. Transducer settings

Fig. 1.4.4.3.-1 Giving transducer settings

When the transducer settings are taken out of use, settings in the Relay Tool can be 
set only by time nominal values. See Fig. 1.4.4.3.-2.
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Fig. 1.4.4.3.-2 The encapsulated area (primary values) is disabled when there are no transducer settings in use 

1.5.• Configuring communication settings

1.5.1. General
The visual representation of the communication configuration dialog/page varies 
according to the type of the relay being configured and the environment in which the 
tool is invoked.

1.5.2. CAP 501/505, SMS 510
General Object Attributes Communication page is used for configuring the 
communication settings of the SM/RED objects in CAP 501/505 and SMS 510 
environments.
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Fig. 1.5.2.-1 General Object Attributes/Communication page

1.5.2.1. Communication support

Table 1.5.2.1-1 Communication support

LON communication
Select Card Number, Channel and type in the appropriate values for the Subnet 
Number, Node Number and SPA address fields. These values should match the 
respective values assigned to the targeted relay unit.

SPA communication
Select Serial port and type in the appropriate value for the SPA address field. The 
value should match the respective value assigned to the targeted relay unit.

1.5.3. LIB 500/510 in MicroSCADA
The Cconfig tool is used for setting up the needed communication settings of the 
SM/RED objects in LIB 500/510 environments. The settings in the dialog may 
change depending on the type of relay. The following example concerns REF 54x 
relay.

• The host type can be selected 
• The station addressing can be configured

REF 54x LON, SPA

REM 54x LON, SPA

REC 52x LON, SPA

REX 52x LON, SPA

REJ 5xx SPA

REU 5xx SPA
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Fig. 1.5.3.-1 CConfig dialog for REF54x

1.5.3.1. Communication support

Table 1.5.3.1-1 Communication support

LON communication
Enter an appropriate value for the Station Nr field. The value should match the 
respective value assigned to the targeted relay unit.

SPA communication
Enter an appropriate value for the Station Nr field. The value should match the 
respective value assigned to the targeted relay unit.

1.6. Application engineering information in LIB 510/MicroSCADA

1.6.1. Process objects
The event process objects of RED relay units can be created with the Event Editor. 
For detailed information about events see the CD-ROM (Technical Descriptions of 
Functions) (1MRS750889-MCD).

The contents of this paragraph applies only to the LIB 500/510 environment.

The event process objects are created according to the following procedure:

The Event Editor creates the process objects. The Event Editor checks which 
function blocks are included in the relay unit and presents the events of these 
function blocks in the Event Editor. In the Editor, you can select which events you 
want to include in the event reporting and those events to include in both event & 
alarm reporting. 

The events that are masked in the relay settings will not have any corresponding 
process object. Select only those events of interest, because events that are not 
important are better not to be mixed with the events of importance, e.g. at some 

REF 54x LON, SPA

REM 54x LON, SPA

REC 52x LON, SPA

REX 52x LON, SPA

REJ 5xx SPA

REU5xx SPA
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disturbance situation in the supervised process. (See the documentation of the Event 
Editor in LIB 510 Configuration Manual).

Each channel (usually one channel corresponds to one function block) reserves 64 
indexes from one process object group. This means that one process object group 
(seen as one logical name) can contain the events of 3 function blocks

Logical names (LN) of the process objects will be:

LIB_OBJECT_NAME + index,

where index = character in range A..Z or 0..9, Indexing is done automatically 
by the Event Editor.

For example, if a user has named the relay as "VAA_H01RE" on the SCT, the 
logical names of the process objects will be "VAA_H01REA", VAA_H01REB" etc.

1.6.2. Files
The files that are used for LIB 510 SM/RED are listed in this paragraph:

The contents of this paragraph applies only to the LIB500/510 environment only.

1.6.2.1. REF 54x

Format pictures
Format pictures used during runtime for event and alarm presentation.

Table 1.6.2.1-1 Format pictures for event and alarm presentation.

*) /SC/LIB4/FMOD/SM_RED/REF54x/ 1)

Texts
The text files, used during installation/configuration and runtime, are language 
dependent.

Table 1.6.2.1-2 Language dependent text files.

*) /SC/LIB4/FMOD/SM_RED/REF54x/ 1)(L = IS A VALUE >=0)

File name Name Location *)

FORM4RE3B1.PIC Event texts USE 1)

FORM4RE3B2.PIC Event texts USE 1)

FORM4REDB1.PIC Event texts USE 1)

FORM4REAI1.PIC Event texts USE 1)

FORM4REBI1.PIC Event texts USE 1)

FORM4REPC1.PIC Event texts USE 1)

File name Name Location *)

*.TXT Dynamic event texts LANG’L’ 1)
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Format pictures and status texts
The following format pictures and status texts (dynamic event texts) are used by the 
REF54x object type. You can add new texts into the format text files by using the 
Event Editor.

Table 1.6.2.1-3 Format pictures and status texts (dynamic event texts) used 
by the REF54x object type.

File name Value (OV) Status text

FORM4RE3B1.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on L1
on L2
on L1 and L2
on L3
on L3 and L1
on L2 and L3
on L1,L2 and L3

FORM4RE3B2.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on U12
on U23
on U12 and U23
on U31
on U31 and U12
on U31 and U23
on U12,U23 and U31

FORM4REDB1.PIC
(object DB events)

0
1
2
3

Open (01)
Close (10)
Faulty (11)
Middle (00)

FORM4REAI1.PIC
(object AI events)

0
1
2
3
4
5

Normal
Low Alarm
High Alarm
Low Warning
High Warning
Alarm/warning limit changed

FORM4REBI1.PIC
(object BI events)

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Reset
Activated
Off
On
Enabled
Disabled
Inactive
Active
Completed
Started
Deactivated
Activated
Normal
Alarm
Nack
Ack
Unsuccessful
Unsuccessful

FORM4REPC1.PIC
(object PC events)

0
1 Updated
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1.6.2.2. REC 52x

Format pictures
Format pictures used during runtime for event and alarm presentation.

Table 1.6.2.2-1 Format pictures for event and alarm presentation.

*) /SC/LIB4/FMOD/SM_RED/REC52x/ 1)

Texts
The text files, used during installation/configuration and runtime, are language 
dependent.

Table 1.6.2.2-2 Language dependent text files used during installation/
configuration and runtime.

*) /SC/LIB4/FMOD/SM_RED/REC52x/ 1)(L = IS A VALUE >=0)

Format pictures and status texts
The following format pictures and status texts (dynamic event texts) are used by the 
REC52x object type. You can add new texts in to the format text files by using the 
Event Editor.

Table 1.6.2.2-3 Format pictures and status texts (dynamic event texts) used 
by REC52x object type.

File name Name Location *)

FORM4RC3B1.PIC Event texts USE 1)

FORM4RC3B2.PIC Event texts USE 1)

FORM4RCDB1.PIC Event texts USE 1)

FORM4RCAI1.PIC Event texts USE 1)

FORM4RCBI1.PIC Event texts USE 1)

FORM4RCPC1.PIC Event texts USE 1)

File name Name Location *)

*.TXT Dynamic event texts LANG’L’ 1)

File name Value (OV) Status text

FORM4RC3B1.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on L1
on L2
on L1 and L2
on L3
on L3 and L1
on L2 and L3
on L1,L2 and L3
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1.6.2.3. REM 54x

Format pictures
Format pictures used during runtime for event and alarm presentation.

Table 1.6.2.3-1 Format pictures for event and alarm presentation.

FORM4RC3B2.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on U12
on U23
on U12 and U23
on U31
on U31 and U12
on U31 and U23
on U12,U23 and U31

FORM4RCDB1.PIC
(object DB events)

0
1
2
3

Open (01)
Close (10)
Faulty (11)
Middle (00)

FORM4RCAI1.PIC
(object AI events)

0
1
2
3
4
5

Normal
Low Alarm
High Alarm
Low Warning
High Warning
Alarm/warning limit changed

FORM4RCBI1.PIC
(object BI events)

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Reset
Activated
Off
On
Enabled
Disabled
Inactive
Active
Completed
Started
Deactivated
Activated
Normal
Alarm
Nack
Ack
Unsuccessful
Unsuccessful

FORM4RCPC1.PIC
(object PC events)

0
1 Updated

File name Value (OV) Status text

File name Name Location *)

FORM4RM3B1.PIC Event texts USE 1)

FORM4RM3B2.PIC Event texts USE 1)

FORM4RMDB1.PIC Event texts USE 1)
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*) /SC/LIB4/FMOD/SM_RED/REM54x/ 1)

Texts
The text files, used during installation/configuration and runtime, are language 
dependent.

Table 1.6.2.3-2 Language dependent text files used during installation/
configuration and runtime.

*) /SC/LIB4/FMOD/SM_RED/REM54x/ 1) (L = IS A VALUE >=0)

Format pictures and status texts
The following format pictures and status texts (dynamic event texts) are used by the 
REM54x object type. You can add new texts in to the format text files by using the 
Event Editor.

Table 1.6.2.3-3 Format pictures and status texts (dynamic event texts) used 
by REM54x object type.

FORM4RMAI1.PIC Event texts USE 1)

FORM4RMBI1.PIC Event texts USE 1)

FORM4RMPC1.PIC Event texts USE 1)

File name Name Location *)

File name Name Location *)

*.TXT Dynamic event texts LANG’L’ 1)

File name Value (OV) Status text

FORM4RM3B1.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on L1
on L2
on L1 and L2
on L3
on L3 and L1
on L2 and L3
on L1,L2 and L3

FORM4RM3B2.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on U12
on U23
on U12 and U23
on U31
on U31 and U12
on U31 and U23
on U12,U23 and U31

FORM4RMDB1.PIC
(object DB events)

0
1
2
3

Open (01)
Close (10)
Faulty (11)
Middle (00)
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1.6.2.4. REX 52x

Format pictures
Format pictures used during runtime for event and alarm presentation.

Table 1.6.2.4-1 Format pictures for event and alarm presentation.

*) /SC/LIB4/FMOD/SM_RED/REX52x/ 1)

Texts
The text files, used during installation/configuration and runtime, are language 
dependent.

FORM4RMAI1.PIC
(object AI events)

0
1
2
3
4
5

Normal
Low Alarm
High Alarm
Low Warning
High Warning
Alarm/warning limit changed

FORM4RMBI1.PIC
(object BI events)

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Reset
Activated
Off
On
Enabled
Disabled
Inactive
Active
Completed
Started
Deactivated
Activated
Normal
Alarm
Nack
Ack
Unsuccessful
Unsuccessful

FORM4RMPC1.PIC
(object PC events)

0
1 Updated

File name Value (OV) Status text

File name Name Location *)

FORM4RX3B1.PIC Event texts USE 1)

FORM4RX3B2.PIC Event texts USE 1)

FORM4RXDB1.PIC Event texts USE 1)

FORM4RXAI1.PIC Event texts USE 1)

FORM4RXBI1.PIC Event texts USE 1)

FORM4RXPC1.PIC Event texts USE 1)
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Table 1.6.2.4-2 Language dependent text files.

*) /SC/LIB4/FMOD/SM_RED/REX52x/ 1)(L = IS A VALUE >=0)

Format pictures and status texts
The following format pictures and status texts (dynamic event texts) are used by 
REX52x object type. You can add new texts into the format text files by using the 
Event Editor.

Table 1.6.2.4-3 Format pictures and status texts (dynamic event texts) used 
by the REX52x object type.

File name Name Location *)

*.TXT Dynamic event texts LANG’L’ 1)

File name Value (OV) Status text

FORM4RX3B1.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on L1
on L2
on L1 and L2
on L3
on L3 and L1
on L2 and L3
on L1,L2 and L3

FORM4RX3B2.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on U12
on U23
on U12 and U23
on U31
on U31 and U12
on U31 and U23
on U12,U23 and U31

FORM4RXDB1.PIC
(object DB events)

0
1
2
3

Open (01)
Close (10)
Faulty (11)
Middle (00)

FORM4RXAI1.PIC
(object AI events)

0
1
2
3
4
5

Normal
Low Alarm
High Alarm
Low Warning
High Warning
Alarm/warning limit changed
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1.6.2.5. REJ 5xx

Format pictures
Format pictures used during runtime for event and alarm presentation.

Table 1.6.2.5-1 Format pictures used during runtime.

*) /SC/LIB4/FMOD/SM_RED/REJ5xx/ 1)

Texts
The text files, used during installation/configuration and runtime, are language 
dependent.

Table 1.6.2.5-2 Language dependent text files used during installation/
configuration and runtime:

*) /SC/LIB4/FMOD/SM_RED/REJ5xx/ 1)(L = IS A VALUE >=0)

FORM4RXBI1.PIC
(object BI events)

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Reset
Activated
Off
On
Enabled
Disabled
Inactive
Active
Completed
Started
Deactivated
Activated
Normal
Alarm
Nack
Ack
Unsuccessful
Unsuccessful

FORM4RXPC1.PIC
(object PC events)

0
1 Updated

File name Value (OV) Status text

File name Name Location *)

FORM4RJ3B1.PIC Event texts USE 1)

FORM4RJ3B2.PIC Event texts USE 1)

FORM4RJDB1.PIC Event texts USE 1)

FORM4RJAI1.PIC Event texts USE 1)

FORM4RJBI1.PIC Event texts USE 1)

FORM4RJPC1.PIC Event texts USE 1)

File name Name Location *)

*.TXT Dynamic event texts LANG’L’ 1)
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Format pictures and status texts
The following format pictures and status texts (dynamic event texts) are used by the 
REJ5xx object type. You can add new texts in to the format text files by using the 
Event Editor.

Table 1.6.2.5-3 Format pictures and status text (dynamic event texts) used 
by the REF5xx object type.

File name Value (OV) Status text

FORM4RJ3B1.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on L1
on L2
on L1 and L2
on L3
on L3 and L1
on L2 and L3
on L1,L2 and L3

FORM4RJ3B2.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on U12
on U23
on U12 and U23
on U31
on U31 and U12
on U31 and U23
on U12,U23 and U31

FORM4RJDB1.PIC
(object DB events)

0
1
2
3

Open (01)
Close (10)
Faulty (11)
Middle (00)

FORM4RJAI1.PIC
(object AI events)

0
1
2
3
4
5

Normal
Low Alarm
High Alarm
Low Warning
High Warning
Alarm/warning limit changed

FORM4RJBI1.PIC
(object BI events)

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Reset
Activated
Off
On
Enabled
Disabled
Inactive
Active
Completed
Started
Deactivated
Activated
Normal
Alarm
Nack
Ack
Unsuccessful
Unsuccessful

FORM4RJPC1.PIC
(object PC events)

0
1 Updated
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1.6.2.6. REU 54x

Format pictures
Format pictures used during runtime for event and alarm presentation.

Table 1.6.2.6-1 Format pictures for event and alarm presentation.

*) /SC/LIB4/FMOD/SM_RED/REU54x/ 1)

Texts
The text files, used during installation/configuration and runtime, are language 
dependent.

Table 1.6.2.6-2 Language dependent text files used during installation/
configuration and runtime.

*) /SC/LIB4/FMOD/SM_RED/REU54x/ 1)(L = IS A VALUE >=0)

Format pictures and status texts
The following format pictures and status texts (dynamic event texts) are used by the 
REU54x object type. You can add new texts in to the format text files by using the 
Event Editor.

Table 1.6.2.6-3 Format pictures and status texts (dynamic event texts) used 
by the REU54x object type.

File name Name Location *)

FORM4RU3B1.PIC Event texts USE 1)

FORM4RU3B2.PIC Event texts USE 1)

FORM4RUDB1.PIC Event texts USE 1)

FORM4RUAI1.PIC Event texts USE 1)

FORM4RUBI1.PIC Event texts USE 1)

FORM4RUPC1.PIC Event texts USE 1)

File name Name Location *)

*.TXT Dynamic event texts LANG’L’ 1)

File name Value (OV) Status text

FORM4RU3B1.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on L1
on L2
on L1 and L2
on L3
on L3 and L1
on L2 and L3
on L1,L2 and L3
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1.6.3. Libraries

1.6.3.1. REF 54x

Software libraries

Table 1.6.3.1-1 Software libraries

FORM4RU3B2.PIC
(object 3bit/AI events)

0
1
2
3
4
5
6
7

Normal
on U12
on U23
on U12 and U23
on U31
on U31 and U12
on U31 and U23
on U12,U23 and U31

FORM4RUDB1.PIC
(object DB events)

0
1
2
3

Open (01)
Close (10)
Faulty (11)
Middle (00)

FORM4RUAI1.PIC
(object AI events)

0
1
2
3
4
5

Normal
Low Alarm
High Alarm
Low Warning
High Warning
Alarm/warning limit changed

FORM4RUBI1.PIC
(object BI events)

0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1
0
1

Reset
Activated
Off
On
Enabled
Disabled
Inactive
Active
Completed
Started
Deactivated
Activated
Normal
Alarm
Nack
Ack
Unsuccessful
Unsuccessful

FORM4RUPC1.PIC
(object PC events)

0
1 Updated

File name Value (OV) Status text

REF unit MRS number Revision Languages

REF541 1MRS118500 A, B
C

EN, DE
EN, DE, FI, SV

REF541R 1MRS118523 A EN, DE, FI, SV

REF543 1MRS118501 C,D,E
F

EN, DE
EN, DE, FI, SV
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Application libraries

Table 1.6.3.1-2 Application libraries

1.6.3.2. REC 52x

Software libraries

Table 1.6.3.2-1 Software libraries

Application libraries

Table 1.6.3.2-2 Application libraries

1.6.3.3. REM 54x

Software libraries

Table 1.6.3.3-1 Software libraries

REF543R 1MRS118522 A EN, DE, FI, SV

REF545 1MRS118502 A, B
C

EN, DE
EN, DE, FI, SV

REF unit MRS number Revision Languages

MRS number Revision

1MRS114500 An empty application A

1MRS114501 A sample application A

1MRS114502 A sample application for REF 543 
1MRS118501 revisions C and D

A

1MRS114503 A sample application for REF 545 
1MRS118502 revision A

A

REC unit MRS number Revision Languages

REC523 1MRS118505
1MRS118516
1MRS118517
1MRS118519
1MRS118518

A
C
C, D
C, D
D

EN, DE
EN, DE
EN, DE
EN, DE
EN, DE

MRS number Revision

1MRS114500 An empty application A

REM unit MRS number Revision Languages

REM543 1MRS118503 A
B

EN, DE
EN, DE, FI, SV

REM543R 1MRS118520 A EN, DE, FI, SV

REM545 1MRS118513 A EN, DE, FI, SV

REM545R 1MRS118521 A EN, DE, FI, SV
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Application libraries

Table 1.6.3.3-2 Application libraries

1.6.3.4. REX 52x libraries

HW libraries

Table 1.6.3.4-1 Hardware libraries

Standard configuration libraries

Table 1.6.3.4-2 Standard configuration libraries

MRS number Revision

1MRS114500 An empty application A

REX Unit HW Configuration Revision Supported Standard Configurations

REX521 REX521_Basic A, B B01-B
B02-B

REX521_Medium A, B M01-B
M02-B

REX521_High B H02-C 
H03-C
H04-C
H05-C
H06-C

REX521_High_Sensor B H01S-C
H02S-C
H03S-C
H04S-C
H05S-C
H06S-C

Standard Configurations Revision Languages

B01 B
C

DE, EN, ES, FI, SV
DE, EN, ES, F,I SV, FR,PT

B02 B
C

DE, EN, ES, FI, SV
DE, EN, ES, FI, SV, FR,PT

M01 B
C

DE, EN, ES, FI, SV
DE, EN, ES, FI, SV, FR,PT

M02 B
C

DE, EN, ES, FI, SV
DE, EN, ES, FI, SV, FR,PT

H02 C DE, EN, ES, FI, SV, FR,PT

H03 C DE, EN, ES, FI, SV, FR,PT

H04 C DE, EN, ES, FI, SV, FR,PT

H05 C DE, EN, ES, FI, SV, FR,PT

H06 C DE, EN, ES, FI, SV, FR,PT

H01S C DE, EN, ES, FI, SV, FR,PT

H02S C DE, EN, ES, FI, SV, FR,PT
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1.6.3.5. REJ 5xx

Software libraries

Table 1.6.3.5-1 Software libraries

1.6.3.6. REU 5xx

Software libraries

Table 1.6.3.6-1 Software libraries

H03S C DE, EN, ES, FI, SV, FR,PT

H04S C DE, EN, ES, FI, SV, FR,PT

H05S C DE, EN, ES, FI, SV, FR,PT

H06S C DE, EN, ES, FI, SV, FR,PT

REJ unit MRS number Revision Languages

REJ511 1MRS118013 A, B EN

REJ513 1MRS118012 A, B EN

REJ515 1MRS118011 A, B EN

REJ517 1MRS118014 A, B EN

REJ521 1MRS118013 A, B EN

REJ523 1MRS118012 A, B EN

REJ525 1MRS118011 A, B EN

ReJ527 1MRS118014 A, B EN

REU unit MRS number Revision Languages

REU513 1MRS118017 A, B EN

REU523 1MRS118017 A, B EN
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1MRS752008-MUM
2. SM/SPACOM

2.1. Overview

2.1.1. Description
SM/SPACOM includes SPACOM object types. An object type is a package that 
contains relay configuration descriptions, profile files, standard function pictures 
and data files, format pictures and texts.

SM/SPACOM package is used in the CAP 501 Relay Setting Tools, CAP 505 Relay 
Product Engineering Tools, SMS 510 Substation Monitoring System and 
MicroSCADA application libraries LIB 500/510.

In LIB/MicroSCADA Environment, the standard function of SM/SPACOM is 
presented with the following icon:

Fig. 2.1.1.-1 Standard Function icon:

File name: FRI_SPASM.DAT
File location in package: SM_SPACOM/SPACOM/INST

2.1.2. Communication support
CAP 501/505

Table 2.1.2-1 Communication support for CAP 501/505.

SMS 510

Table 2.1.2-2 Communication support for SMS 510.

LIB 510 in MicroSCADA

Table 2.1.2-3 Communication support for LIB 510 in MicroSCADA.

Communication options CAP 501/505

SPA via serial port x

Communication options SMS 510

SPA via SPANET or LON/SPA gateway x

SPA via serial port x

Communication options SYS/LIB510

SPA via SPANET or LON/SPA gateway x

Transparent SPA via SRIO (ANSI) x

Transparent SPA via REC200 (RP570) x

Transparent SPA via RTU2x0 (RP571) x

SPA via serial port x

IEC 870-5-103 via IEC/SPA gateway x *)
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*) No transparent SPA

2.2. Basic concepts/terminology
If you are unfamiliar with the basic concepts and terminology, such as object types, 
object type groups or projects, see Section 1.3 Object types general.

2.3. Installation and configuration

2.3.1. LIB 510/MicroSCADA: installing and configuring SPACOM 
relays picture functions
Following steps and tools are required for a SPACOM relay picture function in 
MicroSCADA:

1. Installation of the relay picture function, (Installation Tool)
2. Configuration of the relay picture function (Standard Configuration Tool)

• Attributes 
• Rack configuration (Object Configuration Tool)
• Communication settings (Cconfig Tool)
• Event handling (Event Editor)
• Picture function object (Representation Tool)

3. Relay parametrization (SPA Relay Tool)

Steps one and two are shortly described in the following sections, but relay 
parametrization is beyond the scope of this manual, please see LIB 510 Operator’s 
Manual, SPA Relay Tool.

2.3.1.1. Installing relay picture functions
The document LIB 500 Configuration Manual, Introduction, gives a general 
description of the principles for installing and configuring picture functions in LIB. 
For every relay terminal a separate picture function is added to the process picture. 
Please also see relevant relay manuals for further information. 

When installing a picture function, choose LIB4/LIB 510/PROTECTION/
SPACOM in the Standard Installation Tool. Select SPACOM and click with the 
mouse button. After the standard function SPACOM has been highlighted, enter a 
Picture Function Name for the function and click the Install button. Place the 
function anywhere in the base picture.
48



1MRS752008-MUM CAP, LIB, SMSTools for Relays and Terminals
User’s Guide 2.  SM/SPACOM

2

Fig. 2.3.1.1.-1 The procedure for installing a relay picture function. Relay picture function SPA3 was 
successfully installed, icon visible in the upper left corner.

2.3.1.2. Relay picture function configuration
The following flowchart shows the procedure of the relay configuration:
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Fig. 2.3.1.2.-1 The procedure of the relay configuration

The Object Configuration tool is opened from the Tools menu of the Standard 
Configuration Tool. The configuration of the relay can be divided into three phases.

1. Rack and module configuration
2. Storing relay specific data to the database
3. Storing picture function data

Phases 1 and 2 are done within the Object Configuration Tool.

Phase 3, storing picture function data, is done using the Standard Configuration Tool 
by selecting Apply or Save.

� Before starting the configuration, please ensure that the base system objects 
concerning the stations and nodes are configured correctly.

2.3.1.3. Standard Configuration Tool functions
The pages Attributes and Tools are described in this section. The Representation 
Tool in the Tools menu is not described.

Select the relay picture function and start the Standard Configuration Tool. Now you 
can modify the configurable attributes and to start the Object Configuration Tool.
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Attributes page

Fig. 2.3.1.3.-1 Standard Configuration Tool dialog with focus on Attributes page

The following attributes can be configured in the Standard Configuration Tool.

Table 2.3.1.3-1 Attributes that can be configured in the Standard 
Configuration Tool.

Configurable Choices

STATION_NAME The name of the substation. As a default the maximum length 
of the text is 9 characters. This text will be used as a substation 
identifier of the relay objects on event list, alarm list, printout, 
database query, etc. It is very important that this text is similar 
to all objects within the same substation.

BAY_NAME The name of the bay/feeder. As a default the maximum length 
of the text is 14 characters. This text will be used as a bay/
feeder identifier of the relay objects on event list, alarm list, 
printout, database query, etc. It is very important that this text is 
similar to all objects within the same bay/feeder.

DEVICE_NAME The name (identifier) of the relay. As a default the maximum 
length of the text is 5 characters. This text will be used as an 
identifier of the relay on event list, alarm list, printout, database 
query, etc.
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Saving relay data to the picture function
After the relay has been configured using the relay configuration tools, the data has 
to be saved to the picture function. Save the data by using the Standard 
Configuration Tool commands Save attributes or Apply attributes.

Copying picture function data
To copy picture function data and to paste it into another picture function, use the 
commands Copy attributes and Paste attributes of the Standard Configuration Tool. 
After you have copied the picture function data, open the Object Configuration Tool 
and make the necessary definitions (addresses etc.).

Deleting picture function
To delete the picture function, select the option Delete in the Standard Configuration 
Tool.

� Remember to save the picture function data before you exit the Standard 
Configuration Tool.

Tools page
The following tools can be started from the Tools page in the Standard 
Configuration Tool (see Fig. 2.3.1.3.-2):

• Object Configuration Tool for rack configuration (Function described in a later 
section)

• Cconfig Tool for communication settings (Function described in a later section)
• Event Editor for event handling (Function described in LIB 510 Configuration 

Manual, Event Editor Configuration Manual)
• Representation Tool for picture function symbol used for the relay object, not 

described

AUTHORIZATION 
GROUP

The authorization group used for the object.

VISIBLE Visibility of the object.

LIB_OBJECT_NAME Identifies the relay object. Name should be unique within the 
application. The logical names of event process objects will be 
created by using this name:LN = LIB_OBJECT_NAME + GT 
specific character. (GT specific character is defined by LIB500 
installation tools.) Max. length of attribute: 9 characters.

Configurable Choices
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Fig. 2.3.1.3.-2 The Standard Configuration Tool dialog - Tools page

2.3.1.4. Relay parametrization
After the Relay picture function has been configured, you can set the relay module 
parameters with the SPA Relay Tool. For more information, see LIB 510 Operator’s 
Manual, SPA Relay Tool.

2.3.2. CAP 501/505 and SMS 510
In CAP 501/505 and SMS 510 environments, you start the Object Configuration 
Tool by clicking first the Object Properties shortcut button in the tool bar. Then you 
click the Attributes... button in the dialog General Object Attributes. 

2.3.3. Object Configuration Tool dialog
Rack configuration and transducers are defined in the Object type configuration 
dialog, see the following sections.

2.3.3.1. Rack configuration page
By clicking the Attributes button in the General Object Attributes dialog, the 
configuration dialog containing three tabbed pages appears on the screen (see Fig. 
2.3.3.1.-1).
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Fig. 2.3.3.1.-1 Rack Configuration dialog

Add relay/module
The type of module to be configured can be selected in the drop-down combo in the 
upper left-hand corner of the Rack Configuration page (see Fig. 2.3.3.1.-1, item 1). 
This drop-down combo box contains a list of preconfigured relays or a list of 
different modules depending on which type has been selected. Possible types are 
presented in Table 2.3.3.1-1.

Table 2.3.3.1-1 Different groups in the Types drop-down menu

If e.g. the option Complete racks has been selected in the Types drop-down combo 
box (see Fig. 2.3.3.1.-1, item 1), preconfigured relays /modules can be selected in 
the combo box named Modules (see Fig. 2.3.3.1.-1, item 2 and Fig. 2.3.3.1.-2). Click 
Add (2.3.3.1.-1, item 3), and the relay description appears in the field named Relay 
Description in the upper right-hand corner (see Fig. 2.3.3.1.-1, item 4). A list of 
corresponding modules is presented in the combo box named Rack (see Fig.2.3.3.1.-
1, item 5).

Complete racks Predefined relay packages

Alarm Modules SACO

Auto Reclose Mod. SPCT

Control Modules SPTO

Current Modules SPCJ, SPCS, SPCP

Differential Mod. SPCD

Motor Prot. Mod. SPAM

Voltage Modules SPCU

Various Modules SPC 000, SPCF, SPEF

Disturbance recorder SPCR
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If the Rack combo box (see Fig. 2.3.3.1.-1, item 5) contains modules, the Relay 
Description field (item 4) is empty. If, in turn, you have selected the option 
Complete Racks, the name of the relay will automatically turn up in the Relay 
Description field. After the rack has been configured, it is always possible to enter a 
description manually into the Relay Description field. 

In case modules need to be removed, click the Remove button. Click OK to execute 
the operation. If you wish to cancel the operation, click Cancel.

Fig. 2.3.3.1.-2 Selection of the Complete racks. The rest of the modules can be 
scrolled

2.3.3.2. Transducers page

Fig. 2.3.3.2.-1 Transducers dialog

Nominal Values can be entered (and altered) in the fields on the Transducers page 
(see Fig. 2.3.3.2.-1). To exit the dialog, click OK. The operation may be cancelled 
by clicking Cancel.

Nominal values fields:
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The nominal values fields represent the nominal values of the transducers of the 
module. 

The nominal values are calculated according to the following rules:

Currents (I, I0):

Ip = The nominal primary current for the transducer

Is = The nominal secondary current for the transducer

Ir = The nominal current for the input to the SPA relay

Residual voltage (U0):

or, if using the busbar voltage

Up = The nominal primary voltage for the transducer

U = The nominal busbar voltage

Us = The nominal secondary voltage for the transducer

Ur = The nominal voltage for the input to the SPA relay

Example:

The "nominal" value to be invoked is:

2.3.4. Communication configuration
In order for the relay to communicate with the Relay Setting Tool, communication 
between them has to be configured. This is performed in different ways in LIB and 
in CAP environments (see the following sections).

Nominal value 
Ip
Is
----- Ir×=

Nominal value 
Up
Us
------- Ur×=

Nominal value 
U

1 732 Us×,
---------------------------- Ur×=

Nominal value 
300A

5A
------------- 5A 300=×=
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2.3.4.1. LIB 510 in MicroSCADA

Fig. 2.3.4.1.-1 Standard Configuration Tool - Starting CConfig Tool

To start the Cconfig Tool in the Standard Configuration Tool/Tools page, double-
click Cconfig Tool, or activate the name and click Open.
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Protocol page

Fig. 2.3.4.1.-2 The Protocol page

The available protocols are shown on the first page named Protocol. In the Relay 
Setting Tool the Serial SPA is the only protocol that can be used (see Fig.2.3.4.1-2). 

Address Settings page

Fig. 2.3.4.1.-3 Address Settings page

On the second page named Address Settings (see Fig. 2.3.4.1.-3) it is possible to 
select the installed modules in the combo box. The Unit number of the Module 
addresses can be entered in the Sta Nr -field on the lower part of the page.
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Port Settings

Fig. 2.3.4.1.-4 Port Settings page

In the Communication Configuration dialog on the Port Settings page, you can select 
values and alternatives from the drop-down combo boxes (see Fig. 2.3.4.1.-4).

To confirm the made selections and the given values and to exit the dialog, click OK. 
To exit the dialog without confirming the made selections and the given values, click 
Cancel.

2.3.4.2. CAP 501/505 and SMS 510
In CAP 501/505 and SMS 510 environments, communication between the relay and 
the Relay Setting Tool is configured in the General Object Attributes dialog/
Communication page. To open the General Object Attributes dialog, first select a 
relay in the navigation tree and then click the Object Properties button (the last 
shortcut button) in the toolbar. Select the Communication page in the General Object 
Attributes dialog (see Fig. 2.3.4.2.-1).
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Fig. 2.3.4.2.-1 Communication page in the General Object Attributes dialog

Insert the Station number in the Module addresses field.

The serial port is defined in the System Configuration dialog (see Fig. 2.3.4.2.-2), 
Click the System Configuration button in the Communication page to open the 
dialog (see Fig. 2.3.4.2.-1).

Fig. 2.3.4.2.-2 System Configuration dialog

Click Add, after which the Add serial port dialog appears on the screen (see Fig. 
2.3.4.2.-3). 
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Fig. 2.3.4.2.-3 Add serial port dialog

Insert the port number and click OK. The program returns to the System 
Configuration dialog (see Fig. 2.3.4.2.-4), where the relevant information can be 
seen. Click OK to confirm the made changes and to close the dialog.Click Cancel to 
cancel the operation.

Fig. 2.3.4.2.-4 System Configuration dialog with relevant information

2.4. Application engineering information in LIB 510/MicroSCADA
The contents of this section only concern LIB510/MicroSCADA environment.

2.4.1. Process objects
The process objects in SM/SPACOM are described in Section 2.4.3 Process Objects 
later on in this document.

2.4.2. Files
The files that are used for LIB 510 SM/SPACOM are described below.
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2.4.2.1. Format pictures
Format pictures used during runtime for event and alarm presentation (see Table 
2.4.2.1-1).

Table 2.4.2.1-1 Format pictures used for event and alarm presentation.

*) SC/LIB4/FMOD/SM_SPACOM/SPACOM/ 1)

2.4.2.2. Texts
Language dependent text files are used during installation/configuration and 
runtime.

Table 2.4.2.2-1 Language dependent text files used during installation/
configuration and runtime.

*) SC/LIB4/FMOD/SM_SPACOM/ SPACOM/ 1)(L = IS A VALUE >=0)

2.4.3. Process objects
Process objects are created in the Event Editor. Event codes, Object texts and 
indexes are shown in Tables 2.4.3.2-1 - 2.4.3.49-1.

2.4.3.1. Used abbreviations

Table 2.4.3.1-1 Used abbreviations.

Filename Name Location *)

FORM4FRALI.PIC Event texts USE 1)

FORM4UMEV.PIC Unmapped events USE 1)

Filename Name Location *)

*.TXT Event texts LANG’L’ 1)

*.SPT Group texts LANG’L’ 1)

*.CFG Relay unit texts LANG’L’ 1)

ACT. ACTIVATION

AR AUTORECLOSE

BLK. BLOCK

BS BLOCKING SIGNAL

C CLOSE

CB CIRCUIT BREAKER

CH CHANNEL

COM. COMMAND

CS COMMAND SIGNAL

DEF. DEFINITE

DEL. DELAYED

DEVI. DEVIATION

DISC. DISCONNECTOR
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DISCON. DISCONNECTOR

DWNW DOWNWARD

E/F EARTH FAULT

EXT. EXTERNAL

H-SET HI-SET

HSAR HI-SPEED AUTORECLOSE

IND. INDICATION

INHIB. INHIBIT

INIT. INITIALIZATION

INT. INTERNAL

INTER. INTERRUPTED

L-SET LO-SET

L/R LOCAL/REMOTE

MEAS. MEASUREMENT

MEM. MEMORY

O OPEN

OSC. OSCILLATION

OVERL. OVERLOAD

O/C OVERCURRENT

PARAM. PARAMETER

PROTEC. PROTECTION

RECONN. RECONNECTION

REG. REGISTER

REV. REVERSE

SC SYNCROCHECK

SEL. SELECTION

SET-P. SET-POINT

SG SWITCH GROUP

SIGN. SIGNAL

SSAR SLOW-SPEED

ST. STATE

TD RECLAIM TIME

TN DISCRIMINATING TIME

U.W UPWARD

UNDEF. UNDEFINED

UPW UPWARD

V. VALUE

VAL VALUE

VC VOLTAGE CHECK

W.OUT WITHOUT
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2.4.3.2. SPAM050C, SPAM051C and SPAM052C

Table 2.4.3.2-1 SPAM050C, SPAM051C and SPAM052C

2.4.3.3. SPCD3C21

Table 2.4.3.3-1 SPCD3C21

E-code Index Object Text (OX+status)

E1 120 STARTUP                  BEGIN

E2 120 STARTUP                  OVER 

E3 121 ALARM SIGNAL        ON

E4 121 ALARM SIGNAL        RESET

E5 122 TRIP SIGNAL            ON

E6 122 TRIP SIGNAL            RESET

E7 123 RESTART INHIBIT   ON

E8 123 RESTART INHIBIT   OFF

E9 124 ALARM SIGNAL        ON 

E10 124 ALARM SIGNAL        RESET

E11 125 TRIP SIGNAL            ON

E12 125 TRIP SIGNAL            RESET

E13 126 TRIP SIGNAL            ON

E14 126 TRIP SIGNAL            RESET

E15 127 ALARM SIGNAL        ON

E16 127 ALARM SIGNAL        RESET

E17 128 TRIP SIGNAL            ON

E18 128 TRIP SIGNAL            RESET

E19 129 TRIP SIGNAL            ON

E20 129 TRIP SIGNAL            RESET

E21 130 INT. RELAY FAULT  ON

E22 130 INT. RELAY FAULT  OFF

E50 202 RESTARTING

E51 203 REG. OVERFLOW

E52 204 COMMUNICATION

E53 205 RESPONDS               FAILED

E54 205 RESPONDS                AGAIN

E-code Index Object Text

E1   31 HARMONICS BLOCKING   ON

E2   31 HARMONICS BLOCKING   OFF

E3   32 L1 TRIP                                  ON 

E4   32 L1 TRIP                                  OFF 

E50 180 RESTARTING
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2.4.3.4. SPCD3C22

Table 2.4.3.4-1 SPCD3C22

2.4.3.5. SPCD3C23

Table 2.4.3.5-1 SPCD3C23

2.4.3.6. SPCJ1C20

Table 2.4.3.6-1 SPCJ1C20

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1   33 HARMONICS BLOCKING   ON

E2   33 HARMONICS BLOCKING   OFF

E3   34 L2 TRIP                                  ON

E4   34 L2 TRIP                                  OFF

E50 184 RESTARTING

E51 185 REG. OVERFLOW

E52 186 COMMUNICATION

E53 187 RESPONDS                         FAILED

E54 187 RESPONDS                         AGAIN

E-code Index Object Text

E1   35 HARMONICS BLOCKING   ON

E2   35 HARMONICS BLOCKING   OFF

E3   36 L3 TRIP                                  ON

E4   36 L3 TRIP                                  OFF

E50 188 RESTARTING

E51 189 REG. OVERFLOW

E52 190 COMMUNICATION

E53 191 RESPONDS                          FAILED

E54 191 RESPONDS                          AGAIN

E-code Index Object Text

E1   26 I1F> START                          ON

E2   26 I1F> START                          OFF

E3   27 BLOCKING                           ON 

E4   27 BLOCKING                           OFF
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2.4.3.7. SPCJ1C7

Table 2.4.3.7-1 SPCJ1C7

2.4.3.8. SPCJ1C8

Table 2.4.3.8-1 SPCJ1C8

E50 196 RESTARTING

E51 197 REG. OVERFLOW

E52 198 COMMUNICATION

E53 199 RESPONDS                  FAILED

E54 199 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1   11 I0> START                      ON

E2   11 I0> START                      OFF

E3   12 I0> TRIP                          ON

E4   12 I0> TRIP                          OFF

E5   13 I0>> START                    ON

E6   13 I0>> START                    OFF

E7   14 I0>> TRIP                       ON

E8   14 I0>> TRIP                       OFF

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN 

E-code Index Object Text

E1   15 I0> START            ON

E2   15 I0> START            OFF

E3   16 I0> TRIP                ON

E4   16 I0> TRIP                OFF

E5   17 I0>> START          ON

E6   17 I0>> START          OFF

E7   18 I0>> TRIP              ON

E8   18 I0>> TRIP             OFF

E50 184 RESTARTING

E51 185 REG. OVERFLOW
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2.4.3.9. SPCJ2C30

Table 2.4.3.9-1 SPCJ2C30

2.4.3.10. SPCJ3C3

Table 2.4.3.10-1 SPCJ3C3

E52 186 COMMUNICATION

E53 187 RESPONDS                  FAILED

E54 187 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Ojbect Text

E1   23 D I0> TRIP            ON

E2   23 D I0> TRIP            OFF

E3   24 I0> START            ON

E4   24 I0> START            OFF

E5   25 I0> TRIP               ON

E6   25 I0> TRIP               OFF

E50 192 RESTARTING

E51 193 REG. OVERFLOW

E52 194 COMMUNICATION

E53 195 RESPONDS                  FAILED

E54 195 RESPONDS                  AGAIN

E-code Index Ojbect Text

E1   19 I> START             ON

E2   19 I> START             OFF

E3   20 I> TRIP                 ON 

E4   20 I> TRIP                 OFF

E5   21 I>> START           ON

E6   21 I>> START           OFF

E7   22 I>> TRIP               ON

E8   22 I>> TRIP               OFF

E50 188 RESTARTING

E51 189 REG. OVERFLOW

E52 190 COMMUNICATION

E53 191 RESPONDS                  FAILED

E54 191 RESPONDS                  AGAIN
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2.4.3.11. SPCJ3C48

Table 2.4.3.11-1 SPCJ3C48

2.4.3.12. SPCJ3D35

Table 2.4.3.12-1 SPCJ3D35

E-code Index Object Text

E1   56 I> START             ON

E2   56 I> START             OFF

E3   57 I> TRIP                 ON 

E4   57 I> TRIP                 OFF

E5   58 I>> START            ON 

E6   58 I>> START            OFF

E7   59 I>> TRIP                ON 

E8   59 I>> TRIP                OFF

E9   60 I0> START            ON

E10   60 I0> START            OFF

E11   61 I0> TRIP                ON 

E12   61 I0> TRIP                OFF

E50 192 RESTARTING

E51 193 REG. OVERFLOW

E52 194 COMMUNICATION

E53 195 RESPONDS                  FAILED

E54 195 RESPONDS                  AGAIN

E-code Index Object Text

E1  40 I1> START            ON

E2  40 I1> START            OFF 

E3  41 I1> TRIP                ON 

E4  41 I1> TRIP                OFF

E5  42 I2> START            ON

E6  42 I2> START            OFF

E7  43 I2> TRIP                ON 

E8  43 I2> TRIP                OFF

E9  44 I3> START            ON

E10  44 I3> START            OFF

E11  45 I3> TRIP                ON

E12  45 I3> TRIP                OFF

E13  46 I4> START            ON

E14  46 I4> START            OFF

E15  47 I4> TRIP                ON
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2.4.3.13. SPCJ4D24

Table 2.4.3.13-1 SPCJ4D24

E16  47 I4> TRIP                    OFF 

E17  48 OUTPUT SS1           ON

E18  48 OUTPUT SS1           OFF

E19  49 OUTPUT TS1           ON 

E20  49 OUTPUT TS1           OFF

E21  50 OUTPUT SS2           ON

E22  50 OUTPUT SS2           OFF

E23  51 OUTPUT TS2           ON

E24  51 OUTPUT TS2           OFF

E25  52 OUTPUT SS3           ON

E26  52 OUTPUT SS3           OFF

E27  53 OUTPUT TS3           ON

E28  53 OUTPUT TS3           OFF

E29  54 OUTPUT SS4           ON  

E30  54 OUTPUT SS4           OFF

E31  55 OUTPUT TS4           ON

E32  55 OUTPUT TS4           OFF 

E50 188 RESTARTING

E51 189 REG. OVERFLOW

E52 190 COMMUNICATION

E53 191 RESPONDS                  FAILED

E54 191 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1   32 I> START              ON

E2   32 I> START              OFF       

E3   33 I> TRIP                  ON        

E4   33 I> TRIP                  OFF       

E5   34 I>> START            ON        

E6   34 I>> START            OFF       

E7   35 I>> TRIP               ON

E8   35 I>> TRIP               OFF

E9   36 I0> START            ON

E10   36 I0> START            OFF  

E11   37 I0> TRIP               ON 

E12   37 I0> TRIP               OFF

E13   38 I0>> START         ON
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2.4.3.14. SPCJ4D29

Table 2.4.3.14-1 SPCJ4D29

E14   38 I0>> START             OFF

E15   39 I0>> TRIP                 ON

E16   39 I0>> TRIP                 OFF

E17   40 OUTPUT TS1           ON

E18   40 OUTPUT TS1           OFF

E19   41 OUTPUT SS1           ON

E20   41 OUTPUT SS1           OFF

E21   42 OUTPUT SS2           ON

E22   42 OUTPUT SS2           OFF

E23   43 OUTPUT SS3           ON

E24   43 OUTPUT SS3           OFF

E25   44 OUTPUT TS2           ON

E26   44 OUTPUT TS2           OFF

E50 204 RESTARTING

E51 205 REG. OVERFLOW

E52 206 COMMUNICATION

E53 207 RESPONDS                  FAILED

E54 207 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1   45 I> START             ON

E2   45 I> START             OFF       

E3   46 I> TRIP                 ON        

E4   46 I> TRIP                 OFF       

E5   47 I>> START            ON        

E6   47 I>> START            OFF       

E7   48 I>> TRIP                ON

E8   48 I>> TRIP                OFF

E9   49 I0> START            ON

E10   49 I0> START            OFF

E11   50 I0> TRIP                ON

E12   50 I0> TRIP                OFF

E13   51 I0>> START           ON

E14   51 I0>> START           OFF

E15   52 I0>> TRIP               ON

E16   52 I0>> TRIP               OFF

E17   53 OUTPUT TS1         ON

E18   53 OUTPUT TS1         OFF

E19   54 OUTPUT SS1         ON

E20   54 OUTPUT SS1         OFF
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2.4.3.15. SPCJ4D34

Table 2.4.3.15-1 SPCJ4D34

E21   55 OUTPUT SS2           ON

E22   55 OUTPUT SS2           OFF

E23   56 OUTPUT SS3           ON   

E24   56 OUTPUT SS3           OFF

E25   57 OUTPUT TS2           ON

E26   57 OUTPUT TS2           OFF

E50 208 RESTARTING

E51 209 REG. OVERFLOW

E52 210 COMMUNICATION

E53 211 RESPONDS                  FAILED

E54 211 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1  58 ENGINE START         ON 

E2  58 ENGINE START         OFF       

E3  59 ST. THERMAL OVERL.            

E4  59 ST. THERMAL OVERL.  RESET     

E5  60 TR. THERMAL ALARM             

E6  60 TR. THERMAL ALARM   RESET     

E7  61 TR. THERMAL OVERL.            

E8  61 TR. THERMAL OVERL.  RESET     

E9  62 IS START             ON

E10  62 IS START             OFF

E11  63 IS TRIP                 ON

E12  63 IS TRIP                  OFF

E13  64 I>> START            ON

E14  64 I>> START            OFF

E15  65 I>> TRIP                ON 

E16  65 I>> TRIP                OFF

E17  66 I0 START               ON

E18  66 I0 START               OFF

E19  67 I0 TRIP                  ON

E20  67 I0 TRIP                 OFF

E21  68 ID START             ON

E22  68 ID START             OFF

E23  69 ID TRIP                 ON

E24  69 ID TRIP                 OFF 
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2.4.3.16. SPCJ4D36

Table 2.4.3.16-1 SPCJ4D36

E25  70 I< START                      ON

E26  70 I< START                      OFF 

E27  71 I< TRIP                         ON 

E28  71 I< TRIP                         OFF

E29  72 EXT. TRIP SIGNAL     ON

E30  72 EXT. TRIP SIGNAL     OFF

E31  73 RESTARTING INHIBIT

E32  73 RESTARTING INHIBIT   RESET

E33  74 OUTPUT TS1           ON

E34  74 OUTPUT TS1           OFF 

E35  75 OUTPUT SS1           ON

E36  75 OUTPUT SS1           OFF

E37  76 OUTPUT SS2           ON

E38  76 OUTPUT SS2           OFF

E39  77 OUTPUT SS3           ON

E40  77 OUTPUT SS3           OFF

E41  78 OUTPUT TS2           ON 

E42  78 OUTPUT TS2           OFF

E50 212 RESTARTING

E51 213 REG. OVERFLOW

E52 214 COMMUNICATION

E53 215 RESPONDS                  FAILED

E54 215 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1  27 I> START              ON

E2  27 I> START              OFF       

E3  28 I> TRIP                  ON        

E4  28 I> TRIP                  OFF       

E5  29 I>> START            ON        

E6  29 I>> START            OFF       

E7  30 I>> TRIP                ON       

E8  30 I>> TRIP                OFF        

E9  31 I0> START            ON 

E10  31 I0> START            OFF      

E11  32 I0> TRIP                ON       

E12  32 I0> TRIP                OFF        
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2.4.3.17. SPCJ4D40

Table 2.4.3.17-1 SPCJ4D40

E13  33 I0>> START              ON

E14  33 I0>> START              OFF       

E15  34 I0>> TRIP                 ON        

E16  34 I0>> TRIP                  OFF         

E17  35 OUTPUT TS1           ON

E18  35 OUTPUT TS1           OFF

E19  36 OUTPUT SS1           ON

E20  36 OUTPUT SS1           OFF

E21  37 OUTPUT SS2           ON

E22  37 OUTPUT SS2           OFF

E23  38 OUTPUT SS3           ON 

E24  38 OUTPUT SS3           OFF 

E25  39 OUTPUT TS2           ON

E26  39 OUTPUT TS2           OFF

E50 184 RESTARTING

E51 185 REG. OVERFLOW

E52 186 COMMUNICATION

E53 187 RESPONDS                  FAILED

E54 187 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1  79 IB> START            ON

E2  79 IB> START            OFF       

E3  80 IB> TRIP                ON        

E4  80 IB> TRIP                OFF       

E5  81 IA> START            ON        

E6  81 IA> START            OFF       

E7  82 IA> TRIP                ON        

E8  82 IA> TRIP                OFF

E9  83 I< START               ON

E10  83 I< START               OFF

E11  84 I< TRIP                  ON

E12  84 I< TRIP                   OFF

E13  85 ID1> START           ON

E14  85 ID1> START           OFF

E15  86 ID1> TRIP               ON

E16  86 ID1> TRIP               OFF
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2.4.3.18. SPCJ4D44

Table 2.4.3.18-1 SPCJ4D44

E17  87 ID2> START                ON

E18  87 ID2> START                OFF

E19  88 ID2> TRIP                    ON

E20  88 ID2> TRIP                    OFF

E21  89 EXT. TRIP SIGNAL     ON

E22  89 EXT. TRIP SIGNAL     OFF

E23  90 RECONN. INHIBIT      ON

E24  90 RECONN. INHIBIT      OFF

E25  91 OUTPUT TS1               ON

E26  91 OUTPUT TS1               OFF

E27  92 OUTPUT SS1               ON

E28  92 OUTPUT SS1               OFF

E29  93 OUTPUT SS2               ON

E30  93 OUTPUT SS2               OFF

E31  94 OUTPUT SS3               ON 

E32  94 OUTPUT SS3               OFF

E33  95 OUTPUT TS2               ON 

E34  95 OUTPUT TS2               OFF

E50 216 RESTARTING

E51 217 REG. OVERFLOW

E52 218 COMMUNICATION

E53 219 RESPONDS                  FAILED

E54 219 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1  96 I> START             ON

E2  96 I> START             OFF       

E3  97 I> TRIP                 ON        

E4  97 I> TRIP                 OFF       

E5  98 I>> START           ON        

E6  98 I>> START           OFF       

E7  99 I>> TRIP               ON

E8  99 I>> TRIP               OFF

E9 100 I01> START         ON

E10 100 I01> START         OFF

E11 101 I01> TRIP            ON

E12 101 I01> TRIP            OFF
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2.4.3.19. SACO16A3

Table 2.4.3.19-1 SACO16A3

E13 102 U0> START                ON

E14 102 U0> START                OFF   

E15 103 I02>> TRIP                ON

E16 103 I02>> TRIP                OFF

E17 104 OUTPUT TS1           ON

E18 104 OUTPUT TS1           OFF

E19 105 OUTPUT SS1           ON

E20 105 OUTPUT SS1           OFF

E21 106 OUTPUT SS2           ON

E22 106 OUTPUT SS2           OFF

E23 107 OUTPUT SS3           ON  

E24 107 OUTPUT SS3           OFF

E25 108 OUTPUT TS2           ON

E26 108 OUTPUT TS2           OFF

E50 220 RESTARTING

E51 221 REG. OVERFLOW

E52 222 COMMUNICATION

E53 223 RESPONDS                  FAILED

E54 223 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 150 HI SET-POINT VAL.        ACTIVE

E2 150 HI SET-POINT VAL.        RESET    

E3 151 BLK. SET-POINT VAL.   ACTIVE   

E4 151 BLK. SET-POINT VAL.   RESET    

E7 153 PARAM. MEM. INIT.         START    

E8 153 PARAM. MEM. INIT.         EXEC     

E10 154 INT. UNIT FAULT                

E13 156 EVENT REG. OVERFLOW

E22 157 EARTH-FAULT                 ACTIVE

E23 157 EARTH-FAULT                  RESET

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

Channel 1
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E1  11 CH1 HI SET-P. VAL.    START

E2  11 CH1 HI SET-P. VAL.    RESET

E3  12 CH1 HI TRIP SET-P V   START

E4  12 CH1 HI TRIP SET-P V   RESET

E5  13 CH1 LO SET-P. VAL.    START

E6  13 CH1 LO SET-P. VAL.    RESET

E7  14 CH1 LO TRIP SET-P V   START

E8  14 CH1 LO TRIP SET-P V   RESET

E15  15 CH1 MEAS. DEVI. REG   UPWARDS

E16  15 CH1 MEAS. DEVI. REG   DOWNWARDS

E20  16 CH1 MEAS. RANGE UPW   ACTIVE

E21  17 CH1 MEAS. RANGE DWNW  ACTIVE

E23  18 CH1 TRIP. IND. OSC.   ALARM

E24  16 CH1 MEAS. RANGE UPW   RESET

E25  17 CH1 MEAS. RANGE DWNW  RESET

Channel 2

E1  19 CH2 HI SET-P. VAL.    START

E2  19 CH2 HI SET-P. VAL.    RESET

E3  20 CH2 HI TRIP SET-P V   START

E4  20 CH2 HI TRIP SET-P V   RESET

E5  21 CH2 LO SET-P. VAL.    START

E6  21 CH2 LO SET-P. VAL.    RESET

E7  22 CH2 LO TRIP SET-P V   START

E8  22 CH2 LO TRIP SET-P V   RESET

E15  23 CH2 MEAS. DEVI. REG   UPWARDS

E16  23 CH2 MEAS. DEVI. REG   DOWNWARDS

E20  24 CH2 MEAS. RANGE UPW   ACTIVE

E21  25 CH2 MEAS. RANGE DWNW  ACTIVE

E23  26 CH2 TRIP. IND. OSC.   ALARM

E24  24 CH2 MEAS. RANGE UPW   RESET

E25  25 CH2 MEAS. RANGE DWNW  RESET

Channel 3

E1  27 CH3 HI SET-P. VAL.    START

E2  27 CH3 HI SET-P. VAL.    RESET

E3  28 CH3 HI TRIP SET-P V   START

E4  28 CH3 HI TRIP SET-P V   RESET

E5  29 CH3 LO SET-P. VAL.    START

E6  29 CH3 LO SET-P. VAL.    RESET

E7  30 CH3 LO TRIP SET-P V   START

E-code Index Object Text
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E8  30 CH3 LO TRIP SET-P V   RESET

E15  31 CH3 MEAS. DEVI. REG   UPWARDS

E16  31 CH3 MEAS. DEVI. REG   DOWNWARDS

E20  32 CH3 MEAS. RANGE UPW   ACTIVE

E21  33 CH3 MEAS. RANGE DWNW  ACTIVE

E23  34 CH3 TRIP. IND. OSC.   ALARM

E24  32 CH3 MEAS. RANGE UPW   RESET

E25  33 CH3 MEAS. RANGE DWNW  RESET

Channel 4

E1  35 CH4 HI SET-P. VAL.    START

E2  35 CH4 HI SET-P. VAL.    RESET

E3  36 CH4 HI TRIP SET-P V   START

E4  36 CH4 HI TRIP SET-P V   RESET

E5  37 CH4 LO SET-P. VAL.    START

E6  37 CH4 LO SET-P. VAL.    RESET

E7  38 CH4 LO TRIP SET-P V   START

E8  38 CH4 LO TRIP SET-P V   RESET

E15  39 CH4 MEAS. DEVI. REG   UPWARDS

E16  39 CH4 MEAS. DEVI. REG   DOWNWARDS

E20  40 CH4 MEAS. RANGE UPW   ACTIVE

E21  41 CH4 MEAS. RANGE DWNW  ACTIVE

E23  42 CH4 TRIP. IND. OSC.   ALARM

E24  40 CH4 MEAS. RANGE UPW   RESET

E25  41 CH4 MEAS. RANGE DWNW  RESET

Channel 5

E1  43 CH5 HI SET-P. VAL.    START

E2  43 CH5 HI SET-P. VAL.    RESET

E3  44 CH5 HI TRIP SET-P V   START

E4  44 CH5 HI TRIP SET-P V   RESET

E5  45 CH5 LO SET-P. VAL.    START

E6  45 CH5 LO SET-P. VAL.    RESET

E7  46 CH5 LO TRIP SET-P V   START

E8  46 CH5 LO TRIP SET-P V   RESET

E15  47 CH5 MEAS. DEVI. REG   UPWARDS

E16  47 CH5 MEAS. DEVI. REG   DOWNWARDS

E20  48 CH5 MEAS. RANGE UPW   ACTIVE

E21  49 CH5 MEAS. RANGE DWNW  ACTIVE

E23  50 CH5 TRIP. IND. OSC.   ALARM

E24  48 CH5 MEAS. RANGE U.W   RESET

E-code Index Object Text
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E25  49 CH5 MEAS. RANGE DWNW  RESET

Channel 6

E1  51 CH6 HI SET-P. VAL.    START

E2  51 CH6 HI SET-P. VAL.    RESET

E3  52 CH6 HI TRIP SET-P V   START

E4  52 CH6 HI TRIP SET-P V   RESET

E5  53 CH6 LO SET-P. VAL.    START

E6  53 CH6 LO SET-P. VAL.    RESET

E7  54 CH6 LO TRIP SET-P V   START

E8  54 CH6 LO TRIP SET-P V   RESET

E15  55 CH6 MEAS. DEVI. REG   UPWARDS

E16  55 CH6 MEAS. DEVI. REG   DOWNWARDS

E20  56 CH6 MEAS. RANGE UPW   ACTIVE

E21  57 CH6 MEAS. RANGE DWNW  ACTIVE

E23  58 CH6 TRIP. IND. OSC.   ALARM

E24  56 CH6 MEAS. RANGE UPW   RESET

E25  57 CH6 MEAS. RANGE DWNW  RESET

Channel 7

E1  59 CH7 HI SET-P. VAL.    START

E2  59 CH7 HI SET-P. VAL.    RESET

E3  60 CH7 HI TRIP SET-P V   START

E4  60 CH7 HI TRIP SET-P V   RESET

E5  61 CH7 LO SET-P. VAL.    START

E6  61 CH7 LO SET-P. VAL.    RESET

E7  62 CH7 LO TRIP SET-P V   START

E8  62 CH7 LO TRIP SET-P V   RESET

E15  63 CH7 MEAS. DEVI. REG   UPWARDS

E16  63 CH7 MEAS. DEVI. REG   DOWNWARDS

E20  64 CH7 MEAS. RANGE UPW   ACTIVE

E21  65 CH7 MEAS. RANGE DWNW  ACTIVE

E23  66 CH7 TRIP. IND. OSC.   ALARM

E24  64 CH7 MEAS. RANGE UPW   RESET

E25  65 CH7 MEAS. RANGE DWNW  RESET

Channel 8

E1  67 CH8 HI SET-P. VAL.    START

E2  67 CH8 HI SET-P. VAL.    RESET

E3  68 CH8 HI TRIP SET-P V   START

E4  68 CH8 HI TRIP SET-P V   RESET

E5  69 CH8 LO SET-P. VAL.    START

E-code Index Object Text
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E6  69 CH8 LO SET-P. VAL.    RESET

E7  70 CH8 LO TRIP SET-P V   START

E8  70 CH8 LO TRIP SET-P V   RESET

E15  71 CH8 MEAS. DEVI. REG   UPWARDS

E16  71 CH8 MEAS. DEVI. REG   DOWNWARDS

E20  72 CH8 MEAS. RANGE UPW   ACTIVE

E21  73 CH8 MEAS. RANGE DWNW  ACTIVE

E23  74 CH8 TRIP. IND. OSC.   ALARM

E24  72 CH8 MEAS. RANGE UPW   RESET

E25  73 CH8 MEAS. RANGE DWNW  RESET

Channel 9

E1  75 CH9 HI SET-P. VAL.    START

E2  75 CH9 HI SET-P. VAL.    RESET    

E3  76 CH9 HI TRIP SET-P V   START    

E4  76 CH9 HI TRIP SET-P V   RESET    

E5  77 CH9 LO SET-P. VAL.    START    

E6  77 CH9 LO SET-P. VAL.    RESET    

E7  78 CH9 LO TRIP SET-P V   START    

E8  78 CH9 LO TRIP SET-P V   RESET    

E15  79 CH9 MEAS. DEVI. REG   UPWARDS

E16  79 CH9 MEAS. DEVI. REG   DOWNWARDS

E20  80 CH9 MEAS. RANGE UPW   ACTIVE

E21  81 CH9 MEAS. RANGE DWNW  ACTIVE

E23  82 CH9 TRIP. IND. OSC.   ALARM

E24  80 CH9 MEAS. RANGE UPW   RESET

E25  81 CH9 MEAS. RANGE DWNW  RESET

Channel 10

E1  83 CH10 HI SET-P. VAL.   START

E2  83 CH10 HI SET-P. VAL.   RESET

E3  84 CH10 HI TRIP SET-P V  START

E4  84 CH10 HI TRIP SET-P V  RESET

E5  85 CH10 LO SET-P. VAL.   START

E6  85 CH10 LO SET-P. VAL.   RESET

E7  86 CH10 LO TRIP SET-P V  START

E8  86 CH10 LO TRIP SET-P V  RESET

E15  87 CH10 MEAS. DEVI. REG  UPWARDS

E16  87 CH10 MEAS. DEVI. REG  DOWNWARDS

E20  88 CH10 MEAS. RANGE UPW  ACTIVE

E21  89 CH10 MEAS. RANGE DWNW ACTIVE

E-code Index Object Text
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E23  90 CH10 TRIP. IND. OSC.  ALARM

E24  88 CH10 MEAS. RANGE UPW  RESET

E25  89 CH10 MEAS. RANGE DWNW RESET

Channel 11

E1  91 CH11 HI SET-P. VAL.   START

E2  91 CH11 HI SET-P. VAL.   RESET

E3  92 CH11 HI TRIP SET-P V  START

E4  92 CH11 HI TRIP SET-P V  RESET

E5  93 CH11 LO SET-P. VAL.   START

E6  93 CH11 LO SET-P. VAL.   RESET

E7  94 CH11 LO TRIP SET-P V  START

E8  94 CH11 LO TRIP SET-P V  RESET

E15  95 CH11 MEAS. DEVI. REG  UPWARDS

E16  95 CH11 MEAS. DEVI. REG  DOWNWARDS

E20  96 CH11 MEAS. RANGE UPW  ACTIVE

E21  97 CH11 MEAS. RANGE DWNW ACTIVE

E23  98 CH11 TRIP. IND. OSC.  ALARM

E24  96 CH11 MEAS. RANGE UPW  RESET

E25  97 CH11 MEAS. RANGE DWNW RESET

Channel 12

E1  99 CH12 HI SET-P. VAL.   START

E2  99 CH12 HI SET-P. VAL.   RESET

E3 100 CH12 HI TRIP SET-P V  START

E4 100 CH12 HI TRIP SET-P V  RESET

E5 101 CH12 LO SET-P. VAL.   START

E6 101 CH12 LO SET-P. VAL.   RESET

E7 102 CH12 LO TRIP SET-P V  START

E8 102 CH12 LO TRIP SET-P V  RESET

E15 103 CH12 MEAS. DEVI. REG  UPWARDS

E16 103 CH12 MEAS. DEVI. REG  DOWNWARDS

E20 104 CH12 MEAS. RANGE UPW  ACTIVE

E21 105 CH12 MEAS. RANGE DWNW ACTIVE

E23 106 CH12 TRIP. IND. OSC.  ALARM

E24 104 CH12 MEAS. RANGE UPW  RESET

E25 105 CH12 MEAS. RANGE DWNW RESET

Channel 13

E1 107 CH13 HI SET-P. VAL.   START

E2 107 CH13 HI SET-P. VAL.   RESET

E3 108 CH13 HI TRIP SET-P V  START

E-code Index Object Text
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E4 108 CH13 HI TRIP SET-P V  RESET

E5 109 CH13 LO SET-P. VAL.   START

E6 109 CH13 LO SET-P. VAL.   RESET

E7 110 CH13 LO TRIP SET-P V  START

E8 110 CH13 LO TRIP SET-P V  RESET

E15 111 CH13 MEAS. DEVI. REG  UPWARDS

E16 111 CH13 MEAS. DEVI. REG  DOWNWARDS

E20 112 CH13 MEAS. RANGE UPW  ACTIVE

E21 113 CH13 MEAS. RANGE DWNW ACTIVE

E23 114 CH13 TRIP. IND. OSC.  ALARM

E24 112 CH13 MEAS. RANGE UPW  RESET

E25 113 CH13 MEAS. RANGE DWNW RESET

Channel 14

E1 115 CH14 HI SET-P. VAL.   START

E2 115 CH14 HI SET-P. VAL.   RESET

E3 116 CH14 HI TRIP SET-P V  START

E4 116 CH14 HI TRIP SET-P V  RESET

E5 117 CH14 LO SET-P. VAL.   START

E6 117 CH14 LO SET-P. VAL.   RESET

E7 118 CH14 LO TRIP SET-P V  START

E8 118 CH14 LO TRIP SET-P V  RESET

E15 119 CH14 MEAS. DEVI. REG  UPWARDS

E16 119 CH14 MEAS. DEVI. REG  DOWNWARDS

E20 120 CH14 MEAS. RANGE UPW  ACTIVE

E21 121 CH14 MEAS. RANGE DWNW ACTIVE

E23 122 CH14 TRIP. IND. OSC.  ALARM

E24 120 CH14 MEAS. RANGE UPW  RESET

E25 121 CH14 MEAS. RANGE DWNW RESET

Channel 15

E1 123 CH15 HI SET-P. VAL.   START

E2 123 CH15 HI SET-P. VAL.   RESET

E3 124 CH15 HI TRIP SET-P V  START

E4 124 CH15 HI TRIP SET-P V  RESET

E5 125 CH15 LO SET-P. VAL.   START

E6 125 CH15 LO SET-P. VAL.   RESET

E7 126 CH15 LO TRIP SET-P V  START

E8 126 CH15 LO TRIP SET-P V  RESET

E15 127 CH15 MEAS. DEVI. REG  UPWARDS

E16 127 CH15 MEAS. DEVI. REG  DOWNWARDS

E-code Index Object Text
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2.4.3.20. SACO16D2

Table 2.4.3.20-1 SACO16D2

E20 128 CH15 MEAS. RANGE UPW  ACTIVE

E21 129 CH15 MEAS. RANGE DWNW ACTIVE

E23 130 CH15 TRIP. IND. OSC.  ALARM

E24 128 CH15 MEAS. RANGE UPW  RESET

E25 129 CH15 MEAS. RANGE DWNW RESET

Channel 16

E1 131 CH16 HI SET-P. VAL.   START

E2 131 CH16 HI SET-P. VAL.   RESET

E3 132 CH16 HI TRIP SET-P V  START

E4 132 CH16 HI TRIP SET-P V  RESET

E5 133 CH16 LO SET-P. VAL.   START

E6 133 CH16 LO SET-P. VAL.   RESET

E7 134 CH16 LO TRIP SET-P V  START

E8 134 CH16 LO TRIP SET-P V  RESET

E15 135 CH16 MEAS. DEVI. REG  UPWARDS

E16 135 CH16 MEAS. DEVI. REG  DOWNWARDS

E20 136 CH16 MEAS. RANGE UPW  ACTIVE

E21 137 CH16 MEAS. RANGE DWNW ACTIVE

E23 138 CH16 TRIP. IND. OSC.  ALARM

E24 136 CH16 MEAS. RANGE UPW  RESET

E25 137 CH16 MEAS. RANGE DWNW RESET

E-code Index Object Text

E-code Index Object Text

E10 125 INT. UNIT FAULT                

E13 126 EVENT REG. OVERFLOW            

E50 220 RESTARTING

E51 221 REG. OVERFLOW

E52 222 COMMUNICATION

E53 223 RESPONDS                  FAILED

E54 223 RESPONDS                  AGAIN

Channel 1

E1  91 CH1                   ALARM

E2  91 CH1                   RESET

E3  91 CH1                   ALARM

E4  91 CH1                   RESET
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Channel 2

E1  92 CH2                   ALARM

E2  92 CH2                   RESET

E3  92 CH2                   ALARM

E4  92 CH2                   RESET

Channel 3

E1  93 CH3                   ALARM

E2  93 CH3                   RESET

E3  93 CH3                   ALARM

E4  93 CH3                   RESET

Channel 4

E1  94 CH4                   ALARM

E2  94 CH4                   RESET

E3  94 CH4                   ALARM

E4  94 CH4                   RESET

Channel 5

E1  95 CH5                   ALARM

E2  95 CH5                   RESET

E3  95 CH5                   ALARM

E4  95 CH5                   RESET

Channel 6

E1  96 CH6                   ALARM

E2  96 CH6                   RESET

E3  96 CH6                   ALARM

E4  96 CH6                   RESET

Channel 7

E1  97 CH7                   ALARM

E2  97 CH7                   RESET

E3  97 CH7                   ALARM

E4  97 CH7                   RESET

Channel 8

E1  98 CH8                   ALARM

E2  98 CH8                   RESET

E3  98 CH8                   ALARM

E4  98 CH8                   RESET

Channel 9

E1  99 CH9                   ALARM

E2  99 CH9                   RESET

E3  99 CH9                   ALARM

E-code Index Object Text
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E4  99 CH9                   RESET

Channel 10

E1 100 CH10                  ALARM

E2 100 CH10                  RESET

E3 100 CH10                  ALARM

E4 100 CH10                  RESET

Channel 11

E1 101 CH11                  ALARM

E2 101 CH11                  RESET

E3 101 CH11                  ALARM

E4 101 CH11                  RESET

Channel 12

E1 102 CH12                  ALARM

E2 102 CH12                  RESET

E3 102 CH12                  ALARM

E4 102 CH12                  RESET

Channel 13

E1 103 CH13                  ALARM

E2 103 CH13                  RESET

E3 103 CH13                  ALARM

E4 103 CH13                  RESET

Channel 14

E1 104 CH14                  ALARM

E2 104 CH14                  RESET

E3 104 CH14                  ALARM

E4 104 CH14                  RESET

Channel 15

E1 105 CH15                  ALARM

E2 105 CH15                  RESET

E3 105 CH15                  ALARM

E4 105 CH15                  RESET

Channel 16

E1 106 CH16                  ALARM

E2 106 CH16                  RESET

E3 106 CH16                  ALARM

E4 106 CH16                  RESET

E-code Index Object Text
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2.4.3.21. SACO16D1B

E-code Index Object Text

E10 79 INT. UNIT FAULT                

E13 80 EVENT REG. OVERFLOW            

E50 194 RESTARTING

E51 195 REG. OVERFLOW

E52 196 COMMUNICATION

E53 197 RESPONDS                  FAILED

E54 197 RESPONDS                  AGAIN

Channel 1

E1 81 CH1                   ALARM

E2 81 CH1                   RESET

E3 81 CH1                   ALARM

E4 81 CH1                   RESET

Channel 2

E1 82 CH2                   ALARM

E2 82 CH2                   RESET

E3 82 CH2                   ALARM

E4 82 CH2                   RESET

Channel 3

E1 83 CH3                   ALARM

E2 83 CH3                   RESET

E3 83 CH3                   ALARM

E4 83 CH3                   RESET

Channel 4

E1 84 CH4                   ALARM

E2 84 CH4                   RESET

E3 84 CH4                   ALARM

E4 84 CH4                   RESET

Channel 5

E1 85 CH5                   ALARM

E2 85 CH5                   RESET

E3 85 CH5                   ALARM

E4 85 CH5                   RESET

Channel 6

E1 86 CH6                   ALARM

E2 86 CH6                   RESET

E3 86 CH6                   ALARM

E4 86 CH6                   RESET

Channel 7
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E1 87 CH7                   ALARM

E2 87 CH7                   RESET

E3 87 CH7                   ALARM

E4 87 CH7                   RESET

Channel 8

E1 88 CH8                   ALARM

E2 88 CH8                   RESET

E3 88 CH8                   ALARM

E4 88 CH8                   RESET

Channel 9

E1 89 CH9                   ALARM

E2 89 CH9                   RESET

E3 89 CH9                   ALARM

E4 89 CH9                   RESET

Channel 10

E1 90 CH10                  ALARM

E2 90 CH10                  RESET

E3 90 CH10                  ALARM

E4 90 CH10                  RESET

Channel 11

E1 91 CH11                  ALARM

E2 91 CH11                  RESET

E3 91 CH11                  ALARM

E4 91 CH11                  RESET

Channel 12

E1 92 CH12                  ALARM

E2 92 CH12                  RESET

E3 92 CH12                  ALARM

E4 92 CH12                  RESET

Channel 13

E1 93 CH13                  ALARM

E2 93 CH13                  RESET

E3 93 CH13                  ALARM

E4 93 CH13                  RESET

Channel 14

E1 94 CH14                  ALARM

E2 94 CH14                  RESET

E3 94 CH14                  ALARM

E4 94 CH14                  RESET

Channel 15

E1 95 CH15                  ALARM
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2.4.3.22. SACO16D2B

Table 2.4.3.22-1 SACO16D2B

E2 95 CH15                  RESET

E3 95 CH15                  ALARM

E4 95 CH15                  RESET

Channel 16

E1 96 CH16                  ALARM

E2 96 CH16                  RESET

E3 96 CH16                  ALARM

E4 96 CH16                  RESET

E-code Index Object Text

E10 100 INT. UNIT FAULT                

E13 101 EVENT REG. OVERFLOW            

E50 198 RESTARTING

E51 199 REG. OVERFLOW

E52 200 COMMUNICATION

E53 201 RESPONDS                  FAILED

E54 201 RESPONDS                  AGAIN

Channel 1

E1 102 CH1                   ALARM

E2 102 CH1                   RESET

E3 102 CH1                   ALARM

E4 102 CH1                   RESET

Channel 2

E1 103 CH2                   ALARM

E2 103 CH2                   RESET

E3 103 CH2                   ALARM

E4 103 CH2                   RESET

Channel 3

E1 104 CH3                   ALARM

E2 104 CH3                   RESET

E3 104 CH3                   ALARM

E4 104 CH3                   RESET

Channel 4

E1 105 CH4                   ALARM

E2 105 CH4                   RESET

E3 105 CH4                   ALARM

E4 105 CH4                   RESET

Channel 5
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E1 106 CH5                   ALARM

E2 106 CH5                   RESET

E3 106 CH5                   ALARM

E4 106 CH5                   RESET

Channel 6

E1 107 CH6                   ALARM

E2 107 CH6                   RESET

E3 107 CH6                   ALARM

E4 107 CH6                   RESET

Channel 7

E1 108 CH7                   ALARM

E2 108 CH7                   RESET

E3 108 CH7                   ALARM

E4 108 CH7                   RESET

Channel 8

E1 109 CH8                   ALARM

E2 109 CH8                   RESET

E3 109 CH8                   ALARM

E4 109 CH8                   RESET

Channel 9

E1 110 CH9                   ALARM

E2 110 CH9                   RESET

E3 110 CH9                   ALARM

E4 110 CH9                   RESET

Channel 10

E1 111 CH10                  ALARM

E2 111 CH10                  RESET

E3 111 CH10                  ALARM

E4 111 CH10                  RESET

Channel 11

E1 112 CH11                  ALARM

E2 112 CH11                  RESET

E3 112 CH11                  ALARM

E4 112 CH11                  RESET

Channel 12

E1 113 CH12                  ALARM

E2 113 CH12                  RESET

E3 113 CH12                  ALARM

E4 113 CH12                  RESET

E-code Index Object Text
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2.4.3.23. SPCP3C2

Table 2.4.3.23-1 SPCP3C2

Channel 13

E1 114 CH13                  ALARM

E2 114 CH13                  RESET

E3 114 CH13                  ALARM

E4 114 CH13                  RESET

Channel 14

E1 115 CH14                  ALARM

E2 115 CH14                  RESET

E3 115 CH14                  ALARM

E4 115 CH14                  RESET

Channel 15

E1 116 CH15                  ALARM

E2 116 CH15                  RESET

E3 116 CH15                  ALARM

E4 116 CH15                  RESET

Channel 16

E1 117 CH16                  ALARM

E2 117 CH16                  RESET

E3 117 CH16                  ALARM

E4 117 CH16                  RESET

E-code Index Object Text

E-code Index Object Text

E1 61 U>, U>> START               ON

E2 61 U>, U>> START               OFF        

E3 62 U>, U>> TRIP                   ON         

E4 62 U>, U>> TRIP                   OFF        

E5 63 REV. POWER START     ON

E6 63 REV. POWER START     OFF  

E7 64 REV. POWER TRIP         ON  

E8 64 REV. POWER TRIP         OFF  

E50 200 RESTARTING

E51 201 REG. OVERFLOW

E52 202 COMMUNICATION

E53 203 RESPONDS                  FAILED

E54 203 RESPONDS                  AGAIN
89



1MRS752008-MUMTools for Relays and TerminalsCAP, LIB, SMS
2. SM/SPACOM User’s Guide
2.4.3.24. SPCS2D37

Table 2.4.3.24-1 SPCS2D37

E-code Index Object Text

E1 11 I01> START                    ON

E2 11 I01> START                    OFF       

E3 12 I01> FIRST TRIP           ON        

E4 12 I01> FIRST TRIP           OFF       

E7 14 I01> SECOND TRIP     ON        

E8 14 I01> SECOND TRIP     OFF

E9 15 I02> START                    ON

E10 15 I02> START                    OFF

E11 16 I02> TRIP                       ON

E12 16 I02> TRIP                       OFF

E13 17 I03> START                   ON

E14 17 I03> START                   OFF

E15 18 I03> TRIP                      ON

E16 18 I03> TRIP                      OFF

E17 19 OUTPUT SS1               ON

E18 19 OUTPUT SS1               OFF

E19 20 OUTPUT TS1               ON

E20 20 OUTPUT TS1               OFF 

E21 21 OUTPUT SS2               ON

E22 21 OUTPUT SS2               OFF

E23 22 OUTPUT TS2               ON 

E24 22 OUTPUT TS2               OFF

E25 23 OUTPUT SS3               ON

E26 23 OUTPUT SS3               OFF

E27 24 OUTPUT TS3               ON

E28 24 OUTPUT TS3               OFF

E29 25 OUTPUT SS4               ON

E30 25 OUTPUT SS4               OFF

E31 26 OUTPUT TS4               ON

E32 26 OUTPUT TS4               OFF

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN
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2.4.3.25. SPCS3C4

Table 2.4.3.25-1 SPCS3C4

2.4.3.26. SPCS4D11

Table 2.4.3.26-1 SPCS4D11

E-code Index Object Text

E1 28 IF> START            ON

E2 28 IF> START            OFF        

E3 29 IF> TRIP                ON         

E4 29 IF> TRIP                OFF        

E5 30 IF>> START          ON

E6 30 IF>> START          OFF

E7 31 IF>> TRIP              ON

E8 31 IF>> TRIP               OFF

E50 200 RESTARTING

E51 201 REG. OVERFLOW

E52 202 COMMUNICATION

E53 203 RESPONDS                  FAILED

E54 203 RESPONDS                  AGAIN

E-code Index Object Text

E1 109 I> START FORWARD    ON

E2 109 I> START FORWARD    OFF       

E3 110 I> START REVERSE     ON        

E4 110 I> START REVERSE     OFF       

E5 111 I> TRIP                            ON        

E6 111 I> TRIP                            OFF       

E7 112 I>> START                      ON

E8 112 I>> START                      OFF

E9 113 I>> TRIP                          ON

E10 113 I>> TRIP                          OFF

E11 114 I>>> START                    ON

E12 114 I>>> START                    OFF

E13 115 I>>> TRIP                        ON

E14 115 I>>> TRIP                        OFF

E15 116

E16 116

E17 117 OUTPUT TS1                   ON

E18 117 OUTPUT TS1                   OFF

E19 118 OUTPUT SS1                   ON 
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2.4.3.27. SPCS4D12

Table 2.4.3.27-1 SPCS4D12

E20 118 OUTPUT SS1           OFF

E21 119 OUTPUT SS2           ON

E22 119 OUTPUT SS2           OFF

E23 120 OUTPUT SS3           ON

E24 120 OUTPUT SS3           OFF

E25 121 OUTPUT TS2           ON 

E26 121 OUTPUT TS2           OFF

E50 224 RESTARTING

E51 225 REG. OVERFLOW

E52 226 COMMUNICATION

E53 227 RESPONDS                  FAILED

E54 227 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 122 I> START FORWARD    ON

E2 122 I> START FORWARD    OFF       

E3 123 I> START REVERSE     ON        

E4 123 I> START REVERSE     OFF       

E5 124 I> TRIP                             ON

E6 124 I> TRIP                             OFF

E7 125 I>> START                       ON

E8 125 I>> START                       OFF

E9 126 I>> TRIP                          ON

E10 126 I>> TRIP                          OFF

E11 127 I>>> START                    ON

E12 127 I>>> START                    OFF

E13 128 I>>> TRIP                       ON

E14 128 I>>> TRIP                       OFF

E15 129

E16 129

E17 130 OUTPUT TS1           ON

E18 130 OUTPUT TS1           OFF

E19 131 OUTPUT SS1           ON 

E20 131 OUTPUT SS1           OFF

E21 132 OUTPUT SS2           ON

E22 132 OUTPUT SS2           OFF

E23 133 OUTPUT SS3           ON
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2.4.3.28. SPCS4D13

Table 2.4.3.28-1 SPCS4D13

E24 133 OUTPUT SS3           OFF

E25 134 OUTPUT TS2           ON 

E26 134 OUTPUT TS2           OFF

E50 228 RESTARTING

E51 229 REG. OVERFLOW

E52 230 COMMUNICATION

E53 231 RESPONDS                  FAILED

E54 231 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 135 I> START FORWARD     ON

E2 135 I> START FORWARD     OFF       

E3 136 I> START REVERSE      ON        

E4 136 I> START REVERSE      OFF       

E5 137 I> TRIP                              ON        

E6 137 I> TRIP                              OFF       

E7 138 I>> START                        ON

E8 138 I>> START                       OFF

E9 139 I>> TRIP                           ON

E10 139 I>> TRIP                           OFF

E11 140 I>>> START                     ON

E12 140 I>>> START                     OFF

E13 141 I>>> TRIP                        ON

E14 141 I>>> TRIP                        OFF

E15 142

E16 142

E17 143 OUTPUT TS1           ON

E18 143 OUTPUT TS1           OFF

E19 144 OUTPUT SS1           ON

E20 144 OUTPUT SS1           OFF

E21 145 OUTPUT SS2           ON

E22 145 OUTPUT SS2           OFF

E23 146 OUTPUT SS3           ON

E24 146 OUTPUT SS3           OFF

E25 147 OUTPUT TS2           ON

E26 147 OUTPUT TS2           OFF

E50 232 RESTARTING
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2.4.3.29.‘ SPCT2C17

Table 2.4.3.29-1 SPCT2C17

2.4.3.30. SPCT2C5

Table 2.4.3.30-1 SPCT2C5

E51 233 REG. OVERFLOW

E52 234 COMMUNICATION

E53 235 RESPONDS                  FAILED

E54 235 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 151 AR START                 ON

E2 151 AR START                 OFF       

E3 152 CLOSING CB                     

E4 152 CLOSING CB           RESET     

E5 153 ALARM

E6 153 ALARM                       RESET

E7 154 OPENING CB

E8 154 OPENING CB           RESET  

E9 155 DEF. TRIPPING CB

E10 156 MANUAL OPENING CB

E11 156 MANUAL OPENING CB    RESET

E50 216 RESTARTING

E51 217 REG. OVERFLOW

E52 218 COMMUNICATION

E53 219 RESPONDS                  FAILED

E54 219 RESPONDS                  AGAIN

E-code Index Object Text

E1 65 AR START                  ON

E2 65 AR START                  OFF        

E3 66 CLOSING CB                     

E4 66 CLOSING CB            RESET      

E5 67 ALARM

E6 67 ALARM                       RESET

E7 68 OPENING CB

E8 68 OPENING CB          RESET

E50 197 RESTARTING

E51 198 REG. OVERFLOW
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2.4.3.31. SPCT2D38

Table 2.4.3.31-1 SPCT2D38

E52 199 COMMUNICATION

E53 200 RESPONDS                  FAILED

E54 200 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 70 HSAR START           ON

E2 70 HSAR START           OFF       

E3 71 HSAR STARTED BY AR1            

E4 72 HSAR STARTED BY AR2            

E5 73 HSAR STARTED BY AR3            

E6 74 SSAR START           ON        

E7 74 SSAR START           OFF       

E8 75 SSAR STARTED BY AR1

E9 76 SSAR STARTED BY AR2

E10 77 SSAR STARTED BY AR3

E11 78 DELAYED SSAR         STARTED

E12 78 DELAYED SSAR         RESET

E13 79 DEL. SSAR ST. BY AR1

E14 80 DEL. SSAR ST. BY AR2

E15 81 DEL. SSAR ST. BY AR3

E16 82 AUTO RECLOSE         ON

E17 82 AUTO RECLOSE         OFF

E18 83 AR INHIBITED

E19 83 AR RESETTED

E20 84 CB TRIPPING FAILED

E21 85 CB CLOSING           ACTIVATED

E22 85 CB CLOSING           RESET

E23 86 CB OPEN FAILED

E24 87 ARF                  ON

E25 87 ARF                  OFF

E26 88 DEF. CB TRIPPING

E27 89 NON-AR CB CLOSING

E28 90 NON-PROTEC. CB OPEN.

E50 201 RESTARTING

E51 202 REG. OVERFLOW
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2.4.3.32. SPCT2D46

Table 2.4.3.32-1 SPCT2D46

E52 203 COMMUNICATION

E53 204 RESPONDS                  FAILED

E54 204 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 91 HSAR FORWARD         STARTED

E2 91 HSAR FORWARD         RESET     

E3 92 HSAR STARTED BY AR1            

E4 93 HSAR STARTED BY AR2            

E5 94 HSAR STARTED BY AR3            

E6 95 SSAR START           ON        

E7 95 SSAR START           OFF       

E8 96 SSAR STARTED BY AR1

E9 97 SSAR STARTED BY AR2

E10 98 SSAR STARTED BY AR3

E11 99 TD TIME              STARTED

E12 99 TD TIME              RESET

E13 100 TN TIME              STARTED

E14 100 TN TIME              RESET

E15 101 DEFINITE CB TRIPPING

E16 102 DEF. CB TRIP. BY AR1

E17 103 DEF. CB TRIP. BY AR2 

E18 104 DEF. CB TRIP. BY AR3 

E19 105 AUTO RECLOSE         ON

E20 105 AUTO RECLOSE         OFF

E21 106 CB CLOSING                ACTIVATED

E22 106 CB CLOSING                RESET

E23 107 CB OPEN FAILED

E24 108 CB CLOSING FAILED

E25 109 AR INTERRUPTED 

E26 110 INT. BLOCKING RESET

E27 111 NON-AR CB CLOSING

E28 112 NON-PROTEC. CB OPEN.

E50 205 RESTARTING

E51 206 REG. OVERFLOW
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2.4.3.33. SPCU1C1

Table 2.4.3.33-1 SPCU1C1

2.4.3.34. SPCU1C6

Table 2.4.3.34-1 SPCU1C6

E52 207 COMMUNICATION

E53 208 RESPONDS                  FAILED

E54 208 RESPONDS                  AGAIN

E-code Index Object Text

E1 11 U> START            ON

E2 11 U> START            OFF        

E3 12 U> TRIP                ON         

E4 12 U> TRIP                OFF        

E5 13 U< START            ON

E6 13 U< START            OFF

E7 14 U< TRIP                ON

E8 14 U< TRIP                 OFF

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

E-code Index Object Text

E1 15 U0> START                     ON

E2 15 U0> START                     OFF        

E3 16 U0> TRIP                         ON         

E4 16 U0> TRIP                         OFF        

E5 17 U0>> START                   ON

E6 17 U0>> START                   OFF

E7 18 U0>> TRIP                      ON

E8 18 U0>> TRIP                      OFF

E50 184 RESTARTING

E51 185 REG. OVERFLOW

E52 186 COMMUNICATION

E53 187 RESPONDS                  FAILED

E54 187 RESPONDS                  AGAIN
97



1MRS752008-MUMTools for Relays and TerminalsCAP, LIB, SMS
2. SM/SPACOM User’s Guide
2.4.3.35. SPCU1D39

Table 2.4.3.35-1 SPCU1D39

2.4.3.36. SPCU1D47

Table 2.4.3.36-1 SPCU1D47

E-code Index Object Text

E9 119 U0> START                ON

E10 119 U0> START                OFF

E11 120 U0> FIRST TRIP       ON

E12 120 U0> FIRST TRIP       OFF

E17 123 OUTPUT SS1           ON

E18 123 OUTPUT SS1           OFF

E19 124 OUTPUT TS1           ON

E20 124 OUTPUT TS1           OFF

E21 125 OUTPUT SS2           ON

E22 125 OUTPUT SS2           OFF

E23 126 OUTPUT TS2           ON

E24 126 OUTPUT TS2           OFF

E25 127 OUTPUT SS3           ON

E26 127 OUTPUT SS3           OFF

E27 128 OUTPUT TS3           ON

E28 128 OUTPUT TS3           OFF

E29 129 OUTPUT SS4           ON

E30 129 OUTPUT SS4           OFF

E31 130 OUTPUT TS4           ON

E32 130 OUTPUT TS4           OFF

E50 209 RESTARTING

E51 210 REG. OVERFLOW

E52 211 COMMUNICATION

E53 212 RESPONDS                  FAILED

E54 212 RESPONDS                  AGAIN

E-code Index Object Text

E9 135 U0> START                ON

E10 135 U0> START                OFF

E11 136 U0> FIRST TRIP       ON

E12 136 U0> FIRST TRIP       OFF

E17 139 OUTPUT SS1            ON

E18 139 OUTPUT SS1            OFF

E19 140 OUTPUT TS1            ON
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2.4.3.37. SPCU3C14

Table 2.4.3.37-1 SPCU3C14

E20 140 OUTPUT TS1           OFF

E21 141 OUTPUT SS2           ON

E22 141 OUTPUT SS2           OFF

E23 142 OUTPUT TS2           ON

E24 142 OUTPUT TS2           OFF

E25 143 OUTPUT SS3           ON

E26 143 OUTPUT SS3           OFF

E27 144 OUTPUT TS3           ON

E28 144 OUTPUT TS3           OFF

E29 145 OUTPUT SS4           ON

E30 145 OUTPUT SS4           OFF

E31 146 OUTPUT TS4           ON

E32 146 OUTPUT TS4           OFF

E50 213 RESTARTING

E51 214 REG. OVERFLOW

E52 215 COMMUNICATION

E53 216 RESPONDS                  FAILED

E54 216 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 19 U> START              ON

E2 19 U> START              OFF       

E3 20 U> TRIP                  ON        

E4 20 U> TRIP                  OFF       

E5 21 U< START              ON

E6 21 U< START              OFF

E7 22 U< TRIP                  ON

E8 22 U< TRIP                  OFF

E50 188 RESTARTING

E51 189 REG. OVERFLOW

E52 190 COMMUNICATION

E53 191 RESPONDS                  FAILED

E54 191 RESPONDS                  AGAIN
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2.4.3.38. SPCU3C15

Table 2.4.3.38-1 SPCU3C15

2.4.3.39. SPCU3D45

Table 2.4.3.39-1 SPCU3D45

E-code Index Object Text

E1 23 U< START             ON

E2 23 U< START             OFF       

E3 24 U< TRIP              ON        

E4 24 U< TRIP              OFF       

E5 25 3U<< START           ON

E6 25 3U<< START           OFF

E7 26 3U<< TRIP            ON

E8 26 3U<< TRIP            OFF

E50 192 RESTARTING

E51 193 REG. OVERFLOW

E52 194 COMMUNICATION

E53 195 RESPONDS                  FAILED

E54 195 RESPONDS                  AGAIN

E-code Index Object Text

E1 150 SC13 START            ON

E2 150 SC13 START            OFF       

E3 151 SC13 CLOSE           ON        

E4 152 VC13 START            ON        

E5 152 VC13 START            OFF       

E6 153 VC13 CLOSE            ON        

E7 154 SC23 START            ON        

E8 154 SC23 START            OFF

E9 155 SC23 CLOSE           ON

E10 156 VC23 START            ON

E11 156 VC23 START            OFF

E12 157 VC23 CLOSE           ON

E13 158 BS13                 ON

E14 158 BS13                 OFF

E15 159 CS13                 ON

E16 159 CS13                 OFF

E17 160 BS23                 ON

E18 160 BS23                 OFF

E19 161 CS23                 ON
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2.4.3.40. SPTO1C1

Table 2.4.3.40-1 SPTO1C1

E20 161 CS23                  OFF

E21 162 CB13                  ON

E22 162 CB13                  OFF

E23 163 CB23                  ON

E24 163 CB23                  OFF

E25 164 ALARM                ON

E26 164 ALARM                OFF

E50 217 RESTARTING

E51 218 REG. OVERFLOW

E52 219 COMMUNICATION

E53 220 RESPONDS                  FAILED

E54 220 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 10 EARTHING DISCON.      OPEN

E2 10 EARTHING DISCON.      CLOSED   

E3 10 EARTHING DISCON.      UNDEF.   

Channel 1

E1 21 CB 1                        OPEN

E2 21 CB 1                        CLOSE

E3 21 CB 1                        UNDEF.

E4 24 TRUCK 1               OPEN

E5 24 TRUCK 1               CLOSE

E6 24 TRUCK 1               UNDEF.

E7 27 CH1 CONTROL BLOCKED

E8 28 CH1 CONTROL FAILURE

E9 29 CH1 NOT IN ALERT ST.

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN
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2.4.3.41. SPTO1C4

Table 2.4.3.41-1 SPTO1C4

2.4.3.42. SPTO1D2

Table 2.4.3.42-1 SPTO1D2

E-code Index Object Text

E1 11 EARTHING DISCON.      OPEN

E2 11 EARTHING DISCON.      CLOSED   

E3 11 EARTHING DISCON.      UNDEF.   

Channel 1

E1 12 CB 1                              OPEN

E2 12 CB 1                              CLOSE

E3 12 CB 1                              UNDEF.

E4 13 BUSBAR DISC. 1        OPEN

E5 13 BUSBAR DISC. 1        CLOSE

E6 13 BUSBAR DISC. 1        UNDEF.

E7 14 CB1 CONTROL BLOCKED

E8 15 CB1 CONTROL FAILURE

E9 16 CB1 NOT IN ALERT ST.

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

E-code Index Object Text

E1 10 KEY SWITCH L/R

E2 10 KEY SWITCH L/R                 

E3 12 TEST SWITCH (SG1/1)   ON       

E4 12 TEST SWITCH (SG1/1)   OFF      

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

Channel 1

E1 55 CH1 STATUS                OPEN

E2 55 CH1 STATUS                CLOSED

E3 55 CH1 STATUS                 UNDEF.
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E4 55 CH1 STATUS           UNDEF.

E5 59 CH1 OPEN               ACTIVATED

E6 59 CH1 OPEN               RESET

E7 61 CH1 CLOSE             ACTIVATED

E8 61 CH1 CLOSE             RESET

E9 63 CH1 ACTIV. INHIB.

E10 64 CH1 ACTIV. FAILED

E11 65 CH1 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 2

E1 66 CH2 STATUS            OPEN

E2 66 CH2 STATUS            CLOSED

E3 66 CH2 STATUS            UNDEF.

E4 66 CH2 STATUS            UNDEF.

E5 70 CH2 OPEN                 ACTIVATED

E6 70 CH2 OPEN                 RESET

E7 72 CH2 CLOSE               ACTIVATED

E8 72 CH2 CLOSE                RESET

E9 74 CH2 ACTIV. INHIB.

E10 75 CH2 ACTIV. FAILED

E11 76 CH2 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 3

E1 77 CH3 STATUS            OPEN

E2 77 CH3 STATUS            CLOSED

E3 77 CH3 STATUS            UNDEF.

E4 77 CH3 STATUS            UNDEF.

E5 81 CH3 OPEN                ACTIVATED

E6 81 CH3 OPEN                RESET

E7 83 CH3 CLOSE              ACTIVATED

E8 83 CH3 CLOSE              RESET

E9 85 CH3 ACTIV. INHIB.

E10 86 CH3 ACTIV. FAILED

E11 87 CH3 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 4

E1 88 CH4 INPUT                 ACTIVATED

E2 88 CH4 INPUT                 RESET

E3 90 CH4 SIGNAL 1 .. 3     ACTIVATED

E4 90 CH4 SIGNAL 1 .. 3     RESET

Channel 5

E1 92 CH5 INPUT                 ACTIVATED

E-code Index Object Text
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E2 92 CH5 INPUT                 RESET

E3 94 CH5 SIGNAL 1 .. 3     ACTIVATED

E4 94 CH5 SIGNAL 1 .. 3     RESET

Channel 6

E1 96 CH6 INPUT                 ACTIVATED

E2 96 CH6 INPUT                 RESET

E3 98 CH6 SIGNAL 1 .. 3     ACTIVATED

E4 98 CH6 SIGNAL 1 .. 3     RESET

Channel 7

E1 100 CH7 INPUT                 ACTIVATED

E2 100 CH7 INPUT                 RESET

E3 102 CH7 SIGNAL 1 .. 3     ACTIVATED

E4 102 CH7 SIGNAL 1 .. 3     RESET

Channel 8

E1 104 CH8 INPUT                 ACTIVATED

E2 104 CH8 INPUT                 RESET

E3 106 CH8 SIGNAL 1 .. 3     ACTIVATED

E4 106 CH8 SIGNAL 1 .. 3     RESET

Channel 9

E1 108 CH9 INPUT                 ACTIVATED

E2 108 CH9 INPUT                 RESET

E3 110 CH9 SIGNAL 1 .. 3     ACTIVATED

E4 110 CH9 SIGNAL 1 .. 3     RESET

Channel 10

E1 112 CH10 INPUT                ACTIVATED

E2 112 CH10 INPUT                RESET

E3 114 CH10 SIGNAL 1 .. 3    ACTIVATED

E4 114 CH10 SIGNAL 1 .. 3    RESET

Channel 11

E1 116 CH11 INPUT                ACTIVATED

E2 116 CH11 INPUT                RESET

E3 118 CH11 SIGNAL 1 .. 3    ACTIVATED

E4 118 CH11 SIGNAL 1 .. 3    RESET

Channel 12

E1 120 CH12 INPUT               ACTIVATED

E2 120 CH12 INPUT                RESET

E3 122 CH12 SIGNAL 1 .. 3    ACTIVATED

E4 122 CH12 SIGNAL 1 .. 3    RESET

Channel 13

E-code Index Object Text
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2.4.3.43. SPTO1D5

Table 2.4.3.43-1 SPTO1D5

E1 124 CH13 INPUT            ACTIVATED

E2 124 CH13 INPUT            RESET

E3 126 CH13 SIGNAL 1 .. 3    ACTIVATED

E4 126 CH13 SIGNAL 1 .. 3    RESET

E-code Index Object Text

E-code Index Object Text

E1 20 KEY SWITCH L/R

E2 20 KEY SWITCH L/R                 

E3 21 TEST SWITCH (SG1/1)   ON       

E4 21 TEST SWITCH (SG1/1)   OFF      

E50 184 RESTARTING

E51 185 REG. OVERFLOW

E52 186 COMMUNICATION

E53 187 RESPONDS                       FAILED

E54 187 RESPONDS                        AGAIN

Channel 1

E1 22 CH1 STATUS             OPEN

E2 22 CH1 STATUS             CLOSED

E3 22 CH1 STATUS             UNDEF.

E4 22 CH1 STATUS             UNDEF.

E5 23 CH1 OPEN                 ACTIVATED

E6 23 CH1 OPEN                 RESET

E7 24 CH1 CLOSE               ACTIVATED

E8 24 CH1 CLOSE               RESET

E9 25 CH1 ACTIV. INHIB.

E10 26 CH1 ACTIV. FAILED

E11 27 CH1 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 2

E1 28 CH2 STATUS             OPEN

E2 28 CH2 STATUS             CLOSED

E3 28 CH2 STATUS             UNDEF.

E4 28 CH2 STATUS             UNDEF.

E5 29 CH2 OPEN                 ACTIVATED

E6 29 CH2 OPEN                 RESET

E7 30 CH2 CLOSE               ACTIVATED

E8 30 CH2 CLOSE               RESET

E9 31 CH2 ACTIV. INHIB.
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E10 32 CH2 ACTIV. FAILED

E11 33 CH2 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 3

E1 34 CH3 STATUS            OPEN

E2 34 CH3 STATUS            CLOSED

E3 34 CH3 STATUS             UNDEF.

E4 34 CH3 STATUS             UNDEF.

E5 35 CH3 OPEN                 ACTIVATED

E6 35 CH3 OPEN                 RESET

E7 36 CH3 CLOSE               ACTIVATED

E8 36 CH3 CLOSE                RESET

E9 37 CH3 ACTIV. INHIB.

E10 38 CH3 ACTIV. FAILED

E11 39 CH3 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 4

E1 40 CH4 INPUT                   ACTIVATED

E2 40 CH4 INPUT                   RESET

E3 41 CH4 SIGNAL 1 .. 3        ACTIVATED

E4 41 CH4 SIGNAL 1 .. 3        RESET

Channel 5

E1 42 CH5 INPUT                  ACTIVATED

E2 42 CH5 INPUT                  RESET

E3 43 CH5 SIGNAL 1 .. 3     ACTIVATED

E4 43 CH5 SIGNAL 1 .. 3     RESET

Channel 6

E1 44 CH6 INPUT                  ACTIVATED

E2 44 CH6 INPUT                  RESET

E3 45 CH6 SIGNAL 1 .. 3      ACTIVATED

E4 45 CH6 SIGNAL 1 .. 3      RESET

Channel 7

E1 46 CH7 INPUT                  ACTIVATED

E2 46 CH7 INPUT                  RESET

E3 47 CH7 SIGNAL 1 .. 3      ACTIVATED

E4 47 CH7 SIGNAL 1 .. 3      RESET

Channel 8

E1 48 CH8 INPUT                  ACTIVATED

E2 48 CH8 INPUT                 RESET

E3 49 CH8 SIGNAL 1 .. 3     ACTIVATED

E4 49 CH8 SIGNAL 1 .. 3     RESET

E-code Index Object Text
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2.4.3.44. SPTO1D6

Table 2.4.3.44-1 SPTO1D6

Channel 9

E1 50 CH9 INPUT                 ACTIVATED

E2 50 CH9 INPUT                 RESET

E3 51 CH9 SIGNAL 1 .. 3     ACTIVATED

E4 51 CH9 SIGNAL 1 .. 3     RESET

Channel 10

E1 52 CH10 INPUT               ACTIVATED

E2 52 CH10 INPUT               RESET

E3 53 CH10 SIGNAL 1 .. 3   ACTIVATED

E4 53 CH10 SIGNAL 1 .. 3   RESET

Channel 11

E1 54 CH11 INPUT                ACTIVATED

E2 54 CH11 INPUT                RESET

E3 55 CH11 SIGNAL 1 .. 3    ACTIVATED

E4 55 CH11 SIGNAL 1 .. 3    RESET

Channel 12

E1 56 CH12 INPUT                 ACTIVATED

E2 56 CH12 INPUT                 RESET

E3 57 CH12 SIGNAL 1 .. 3     ACTIVATED

E4 57 CH12 SIGNAL 1 .. 3     RESET

Channel 13

E1 58 CH13 INPUT                 ACTIVATED

E2 58 CH13 INPUT                 RESET

E3 59 CH13 SIGNAL 1 .. 3    ACTIVATED

E4 59 CH13 SIGNAL 1 .. 3    RESET

E-code Index Object Text

E-code Index Object Text

E1 10 KEY SWITCH L/R

E2 10 KEY SWITCH L/R                 

E3 12 TEST SWITCH (SG1/1)      ON       

E4 12 TEST SWITCH (SG1/1)      OFF      

E5 14 SWICH (SG1/2)                   ON       

E6 14 SWICH (SG1/2)                   OFF      

E7 16 TRIP CIRCUIT FAILURE           

E8 16 TRIP CIRCUIT FAILURE   RESET   

E9 18 CURRENT INPUT FAIL.            

E10 18 CURRENT INPUT FAIL.    RESET   
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E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

Channel 1

E1 55 CH1 STATUS             OPEN

E2 55 CH1 STATUS             CLOSED

E3 55 CH1 STATUS             UNDEF.

E4 55 CH1 STATUS             UNDEF.

E5 59 CH1 OPEN                 ACTIVATED

E6 59 CH1 OPEN                 RESET

E7 61 CH1 CLOSE               ACTIVATED

E8 61 CH1 CLOSE               RESET

E9 63 CH1 ACTIV. INHIB.

E10 64 CH1 ACTIV. FAILED

E11 65 CH1 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 2

E1 66 CH2 STATUS            OPEN

E2 66 CH2 STATUS            CLOSED

E3 66 CH2 STATUS            UNDEF.

E4 66 CH2 STATUS            UNDEF.

E5 70 CH2 OPEN                ACTIVATED

E6 70 CH2 OPEN                RESET

E7 72 CH2 CLOSE              ACTIVATED

E8 72 CH2 CLOSE              RESET

E9 74 CH2 ACTIV. INHIB.

E10 75 CH2 ACTIV. FAILED

E11 76 CH2 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 3

E1 77 CH3 STATUS            OPEN

E2 77 CH3 STATUS            CLOSED

E3 77 CH3 STATUS            UNDEF.

E4 77 CH3 STATUS            UNDEF.

E5 81 CH3 OPEN                ACTIVATED

E6 81 CH3 OPEN                RESET

E7 83 CH3 CLOSE             ACTIVATED

E8 83 CH3 CLOSE             RESET

E9 85 CH3 ACTIV. INHIB.

E-code Index Object Text
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E10 86 CH3 ACTIV. FAILED

E11 87 CH3 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 4

E1 88 CH4 INPUT                 ACTIVATED

E2 88 CH4 INPUT                 RESET

E3 90 CH4 SIGNAL 1 .. 4     ACTIVATED

E4 90 CH4 SIGNAL 1 .. 4     RESET

Channel 5

E1 92 CH5 INPUT                 ACTIVATED

E2 92 CH5 INPUT                 RESET

E3 94 CH5 SIGNAL 1 .. 4     ACTIVATED

E4 94 CH5 SIGNAL 1 .. 4     RESET

Channel 6

E1 96 CH6 INPUT                 ACTIVATED

E2 96 CH6 INPUT                 RESET

E3 98 CH6 SIGNAL 1 .. 4     ACTIVATED

E4 98 CH6 SIGNAL 1 .. 4     RESET

Channel 7

E1 100 CH7 INPUT                 ACTIVATED

E2 100 CH7 INPUT                 RESET

E3 102 CH7 SIGNAL 1 .. 4     ACTIVATED

E4 102 CH7 SIGNAL 1 .. 4     RESET

Channel 8

E1 104 CH8 INPUT                 ACTIVATED

E2 104 CH8 INPUT                 RESET

E3 106 CH8 SIGNAL 1 .. 4     ACTIVATED

E4 106 CH8 SIGNAL 1 .. 4     RESET

Channel 9

E1 108 CH9 INPUT                  ACTIVATED

E2 108 CH9 INPUT                  RESET

E3 110 CH9 SIGNAL 1 .. 4     ACTIVATED

E4 110 CH9 SIGNAL 1 .. 4     RESET

Channel 10

E1 112 CH10 INPUT                 ACTIVATED

E2 112 CH10 INPUT                 RESET

E3 114 CH10 SIGNAL 1 .. 4    ACTIVATED

E4 114 CH10 SIGNAL 1 .. 4    RESET

Channel 11

E1 116 CH11 INPUT               ACTIVATED

E-code Index Object Text
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2.4.3.45. SPTO2C2

Table 2.4.3.45-1 SPTO2C2

E2 116 CH11 INPUT                RESET

E3 118 CH11 SIGNAL 1 .. 4    ACTIVATED

E4 118 CH11 SIGNAL 1 .. 4    RESET

Channel 12

E1 120 CH12 INPUT                ACTIVATED

E2 120 CH12 INPUT                RESET

E3 122 CH12 SIGNAL 1 .. 4    ACTIVATED

E4 122 CH12 SIGNAL 1 .. 4    RESET

Channel 13

E1 124 CH13 INPUT                ACTIVATED

E2 124 CH13 INPUT                RESET

E3 126 CH13 SIGNAL 1 .. 4    ACTIVATED

E4 126 CH13 SIGNAL 1 .. 4    RESET

E-code Index Object Text

E-code Index Object Text

E1 10 EARTHING DISCON.      OPEN

E2 10 EARTHING DISCON.      CLOSED   

E3 10 EARTHING DISCON.      UNDEF.   

Channel 1

E1 21 CB 1                                   OPEN

E2 21 CB 1                                   CLOSE

E3 21 CB 1                                   UNDEF.

E4 24 TRUCK 1                          OPEN

E5 24 TRUCK 1                          CLOSE

E6 24 TRUCK 1                          UNDEF.

E7 27 CH1 CONTROL BLOCKED

E8 28 CH1 CONTROL FAILURE

E9 29 CH1 NOT IN ALERT ST.

Channel 2

E1 30 CB 2                                  OPEN

E2 30 CB 2                                 CLOSE

E3 30 CB 2                                 UNDEF.

E4 33 TRUCK 2                         OPEN

E5 33 TRUCK 2                         CLOSE

E6 33 TRUCK 2                         UNDEF.

E7 36 CH2 CONTROL BLOCKED

E8 37 CH2 CONTROL FAILURE
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2.4.3.46. SPTO6D3

Table 2.4.3.46-1 SPTO6D3

E9 38 CH2 NOT IN ALERT ST.

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 10 KEY SWITCH L/R

E2 10 KEY SWITCH L/R                 

E3 12 TEST SWITCH (SG1/1)   ON       

E4 12 TEST SWITCH (SG1/1)   OFF      

E5 14 AUTO-RECLOSE             ON       

E6 14 AUTO-RECLOSE             OFF      

E7 16 AR INTERRUPTED                 

E8 17 AR INTER. BY O COM.            

E9 18 AR INTER. BY ARINH             

E10 19 FAILED C COM. BY AR            

E11 20 SHOT 1 IN PROGRESS             

E12 21 CB CLOSED BY SHOT 1            

E13 22 SHOT 1 BY SIGN. AR1            

E14 23 SHOT 1 BY SIGN. AR2            

E15 24 SHOT 1 BY SIGN. AR3            

E16 25 SHOT 2 IN PROGRESS             

E17 26 CB CLOSED BY SHOT 2            

E18 27 SHOT 2 BY SIGN. AR1            

E19 28 SHOT 2 BY SIGN. AR2            

E20 29 SHOT 2 BY SIGN. AR3            

E21 30 SHOT 3 IN PROGRESS             

E22 31 CB CLOSED BY SHOT 3            

E23 32 SHOT 3 BY SIGN. AR1            

E24 33 SHOT 3 BY SIGN. AR2            

E25 34 SHOT 3 BY SIGN. AR3

E26 35 SHOT 4 IN PROGRESS

E27 36 CB CLOSED BY SHOT 4

E28 37 SHOT 4 BY SIGN. AR1
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E29 38 SHOT 4 BY SIGN. AR2

E30 39 SHOT 4 BY SIGN. AR3

E31 40 SHOT 5 IN PROGRESS

E32 41 CB CLOSED BY SHOT 5

E33 42 SHOT 5 BY SIGN. AR1

E34 43 SHOT 5 BY SIGN. AR2

E35 44 SHOT 5 BY SIGN. AR3

E36 45 FINAL TRIP BY AR1

E37 46 FINAL TRIP BY AR2

E38 47 FINAL TRIP BY AR3

E39 48 FINAL TRIP BY H-SET

E40 49 FINAL TRIP BY L-SET

E41 50 FINAL TRIP BY E/F

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

Channel 1

E1 55 CH1 STATUS               OPEN

E2 55 CH1 STATUS               CLOSED

E3 55 CH1 STATUS               UNDEF.

E4 55 CH1 STATUS               UNDEF.

E5 59 CH1 OPEN                   ACTIVATED

E6 59 CH1 OPEN                   RESET

E7 61 CH1 CLOSE                 ACTIVATED

E8 61 CH1 CLOSE                 RESET

E9 63 CH1 ACTIV. INHIB.

E10 64 CH1 ACTIV. FAILED

E11 65 CH1 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 2

E1 66 CH2 STATUS            OPEN

E2 66 CH2 STATUS            CLOSED

E3 66 CH2 STATUS            UNDEF.

E4 66 CH2 STATUS            UNDEF.

E5 70 CH2 OPEN                ACTIVATED

E6 70 CH2 OPEN                RESET

E7 72 CH2 CLOSE             ACTIVATED

E8 72 CH2 CLOSE             RESET

E-code Index Object Text
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E9 74 CH2 ACTIV. INHIB.

E10 75 CH2 ACTIV. FAILED

E11 76 CH2 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 3

E1 77 CH3 STATUS            OPEN

E2 77 CH3 STATUS            CLOSED

E3 77 CH3 STATUS            UNDEF.

E4 77 CH3 STATUS            UNDEF.

E5 81 CH3 OPEN                ACTIVATED

E6 81 CH3 OPEN                RESET

E7 83 CH3 CLOSE             ACTIVATED

E8 83 CH3 CLOSE             RESET

E9 85 CH3 ACTIV. INHIB.

E10 86 CH3 ACTIV. FAILED

E11 87 CH3 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 4

E1 88 CH4 STATUS            OPEN

E2 88 CH4 STATUS            CLOSED

E3 88 CH4 STATUS            UNDEF.

E4 88 CH4 STATUS            UNDEF.

E5 92 CH4 OPEN                ACTIVATED

E6 92 CH4 OPEN                RESET

E7 94 CH4 CLOSE             ACTIVATED

E8 94 CH4 CLOSE             RESET

E9 96 CH4 ACTIV. INHIB.

E10 97 CH4 ACTIV. FAILED

E11 98 CH4 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 5

E1 99 CH5 STATUS            OPEN

E2 99 CH5 STATUS            CLOSED

E3 99 CH5 STATUS            UNDEF.

E4 99 CH5 STATUS            UNDEF.

E5 103 CH5 OPEN                ACTIVATED

E6 103 CH5 OPEN                RESET

E7 105 CH5 CLOSE             ACTIVATED

E8 105 CH5 CLOSE             RESET

E9 107 CH5 ACTIV. INHIB.

E10 108 CH5 ACTIV. FAILED

E11 109 CH5 ATTEMPT TO ACTIV. WITHOUT SEL.

E-code Index Object Text
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Channel 6

E1 110 CH6 STATUS            OPEN

E2 110 CH6 STATUS            CLOSED

E3 110 CH6 STATUS            UNDEF.

E4 110 CH6 STATUS            UNDEF.

E5 114 CH6 OPEN                ACTIVATED

E6 114 CH6 OPEN                RESET

E7 116 CH6 CLOSE              ACTIVATED

E8 116 CH6 CLOSE              RESET

E9 118 CH6 ACTIV. INHIB.

E10 119 CH6 ACTIV. FAILED

E11 120 CH6 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 7

E1 121 CH7 STATUS            OPEN

E2 121 CH7 STATUS            CLOSED

E3 121 CH7 STATUS            UNDEF.

E4 121 CH7 STATUS            UNDEF.

E5 125 CH7 OPEN                ACTIVATED

E6 125 CH7 OPEN                RESET

E7 127 CH7 CLOSE             ACTIVATED

E8 127 CH7 CLOSE             RESET

E9 129 CH7 ACTIV. INHIB.

E10 130 CH7 ACTIV. FAILED

E11 131 CH7 ATTEMPT TO ACTIV. WITHOUT SEL.

Channel 8

E1 132 CH8 INPUT                     ACTIVATED

E2 132 CH8 INPUT                     RESET

E3 134 CH8 SIGNAL 5 OR 6     ACTIVATED

E4 134 CH8 SIGNAL 5 OR 6     RESET

Channel 9

E1 136 CH9 INPUT                       ACTIVATED

E2 136 CH9 INPUT                       RESET

E3 138 CH9 SIGNAL 5 OR 6       ACTIVATED

E4 138 CH9 SIGNAL 5 OR 6       RESET

Channel 10

E1 140 CH10 INPUT                    ACTIVATED

E2 140 CH10 INPUT                    RESET

E3 142 CH10 SIGNAL 5 OR 6    ACTIVATED

E4 142 CH10 SIGNAL 5 OR 6    RESET

E-code Index Object Text
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Channel 11

E1 144 CH11 INPUT                    ACTIVATED

E2 144 CH11 INPUT                    RESET

E3 146 CH11 SIGNAL 5 OR 6    ACTIVATED

E4 146 CH11 SIGNAL 5 OR 6    RESET

Channel 12

E1 148 CH12 INPUT                    ACTIVATED

E2 148 CH12 INPUT                    RESET

E3 150 CH12 SIGNAL 5 OR 6    ACTIVATED

E4 150 CH12 SIGNAL 5 OR 6    RESET

Channel 13

E1 152 CH13 INPUT                    ACTIVATED

E2 152 CH13 INPUT                    RESET

E3 154 CH13 SIGNAL 5 OR 6    ACTIVATED

E4 154 CH13 SIGNAL 5 OR 6    RESET

Channel 14

E1 156 CH14 INPUT                    ACTIVATED

E2 156 CH14 INPUT                    RESET

E3 158 CH14 SIGNAL 5 OR 6    ACTIVATED

E4 158 CH14 SIGNAL 5 OR 6    RESET

Channel 15

E1 160 CH15 INPUT                     ACTIVATED

E2 160 CH15 INPUT                     RESET

E3 162 CH15 SIGNAL 5 OR 6    ACTIVATED

E4 162 CH15 SIGNAL 5 OR 6    RESET

Channel 16

E1 164 CH16 INPUT                    ACTIVATED

E2 164 CH16 INPUT                    RESET

E3 166 CH16 SIGNAL 5 OR 6    ACTIVATED

E4 166 CH16 SIGNAL 5 OR 6    RESET

Channel 17

E1 168 CH17 INPUT                     ACTIVATED

E2 168 CH17 INPUT                     RESET

E3 170 CH17 SIGNAL 5 OR 6    ACTIVATED

E4 170 CH17 SIGNAL 5 OR 6    RESET

E-code Index Object Text
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2.4.3.47. SPTO12D4

Table 2.4.3.47-1 SPTO12D4

E-code Index Object Text

E50 190 RESTARTING

E51 191 REG. OVERFLOW

E52 192 COMMUNICATION

E53 193 RESPONDS               FAILED

E54 193 RESPONDS               AGAIN

Channel 1

E1 63 CH1 STATUS            CLOSED

E2 63 CH1 STATUS            OPEN    

E3 63 CH1 STATUS            UNDEF.

E4 63 CH1 STATUS            UNDEF.

Channel 2

E1 64 CH2 STATUS            CLOSED

E2 64 CH2 STATUS            OPEN    

Channel 3

E1 65 CH3 STATUS            CLOSED

E2 65 CH3 STATUS            OPEN    

E3 65 CH3 STATUS            UNDEF.

E4 65 CH3 STATUS            UNDEF.

Channel 4

E1 66 CH4 STATUS            CLOSED

E2 66 CH4 STATUS            OPEN    

Channel 5

E1 67 CH5 STATUS            CLOSED

E2 67 CH5 STATUS            OPEN    

E3 67 CH5 STATUS            UNDEF.

E4 67 CH5 STATUS            UNDEF.

Channel 6

E1 68 CH6 STATUS            CLOSED

E2 68 CH6 STATUS            OPEN    

Channel 7

E1 69 CH7 STATUS            CLOSED

E2 69 CH7 STATUS            OPEN    

E3 69 CH7 STATUS            UNDEF.

E4 69 CH7 STATUS            UNDEF.

Channel 8

E1 70 CH8 STATUS            CLOSED

E2 70 CH8 STATUS            OPEN    
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2.4.3.48. REC 501

Table 2.4.3.48-1 REC 501

Channel 9

E1 71 CH9 STATUS            CLOSED

E2 71 CH9 STATUS            OPEN    

E3 71 CH9 STATUS            UNDEF.

E4 71 CH9 STATUS            UNDEF.

Channel 10

E1 72 CH10 STATUS           CLOSED

E2 72 CH10 STATUS           OPEN    

Channel 11

E1 73 CH11 STATUS           CLOSED

E2 73 CH11 STATUS           OPEN    

E3 73 CH11 STATUS           UNDEF.

E4 73 CH11 STATUS           UNDEF.

Channel 12

E1 74 CH12 STATUS           CLOSED

E2 74 CH12 STATUS           OPEN    

Channel 13

E1 75 CH13 STATUS           CLOSED

E2 75 CH13 STATUS           OPEN    

E3 75 CH13 STATUS           UNDEF.

E4 75 CH13 STATUS           UNDEF.

Channel 14

E1 76 CH14 STATUS           CLOSED

E2 76 CH14 STATUS           OPEN    

Channel 15

E1 77 CH15 STATUS           CLOSED

E2 77 CH15 STATUS           OPEN    

E3 77 CH15 STATUS           UNDEF.

E4 77 CH15 STATUS           UNDEF.

Channel 16

E1 78 CH16 STATUS           CLOSED

E2 78 CH16 STATUS           OPEN    

E-code Index Object Text

E-code Index Object Text

E1 11 INPUT I1

E2 11 INPUT I1

E3 12 INPUT I2
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E4 12 INPUT I2

E5 13 INPUT I3

E6 13 INPUT I3

E7 14 INPUT I4

E8 14 INPUT I4

E10 15 INPUT I5

E11 15 INPUT I5

E12 16 BATTERY VOLTAGE                    LOW

E13 16 BATTERY VOLTAGE                     NORMAL

E14 17 POWER SUPPLY TEMP.             HIGH

E15 17 POWER SUPPLY TEMP.             NORMAL

E16 18 AUX. SUPPLY CONNECTION

E17 18 AUX. SUPPLY CONNECTION

E18 19 INTERMDT COUNTER 1  NEW VALUE

E19 20 INTERMDT COUNTER 2  NEW VALUE

E20 21 PERIOD COUNTER 1    NEW VALUE

E21 22 PERIOD COUNTER 2    NEW VALUE

E30 17 OUTPUT O1

E31 17 OUTPUT O1

E32 18 OUTPUT O2

E33 18 OUTPUT O2

E34 19 OUTPUT O3

E35 20 OUTPUT O3

E36 21 OUTPUT O4

E37 22 OUTPUT O4

Channel 1

E40 27 OBJECT 1 STATUS->10

E41 27 OBJECT 1 STATUS->01

E42 27 OBJECT 1 STATUS->11

E43 27 OBJECT 1 STATUS->00

E44 28 OBJECT 1,OPEN COMMAND

E45 29 OBJECT 1,CLOSE COMMAND

Channel 2

E40 30 OBJECT 2 STATUS->10

E41 30 OBJECT 2 STATUS->01

E42 30 OBJECT 2 STATUS->11

E43 30 OBJECT 2 STATUS->00

E44 31 OBJECT 2,OPEN COMMAND

E45 32 OBJECT 2,CLOSE COMMAND

E-code Index Object Text
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2.4.3.49. SPCF 1D15

Table 2.4.3.49-1 SPCF 1D15

E50 180 RESTARTING

E51 181 REG. OVERFLOW

E52 182 COMMUNICATION

E53 183 RESPONDS                  FAILED

E54 183 RESPONDS                  AGAIN

E-code Index Object Text

E-code Index Object Text

E1 35 STAGE 1              ON

E2 35 STAGE 1              OFF

E3 36 STAGE 1 TIMER 1 TRIP ON

E4 36 STAGE 1 TIMER 1 TRIP OFF

E5 37 STAGE 1 TIMER 2 TRIP ON

E6 37 STAGE 1 TIMER 2 TRIP OFF

E7 38 STAGE 2                  ON

E8 38 STAGE 2                  OFF

E9 39 STAGE 2 TIMER 1 TRIP ON

E10 39 STAGE 2 TIMER 1 TRIP OFF

E11 40 STAGE 2 TIMER 2 TRIP ON

E12 40 STAGE 2 TIMER 2 TRIP OFF

E13 41 STAGE 3                  ON

E14 41 STAGE 3                  OFF

E15 42 STAGE 3 TIMER 1 TRIP ON

E16 42 STAGE 3 TIMER 1 TRIP OFF

E17 43 STAGE 3 TIMER 2 TRIP ON

E18 43 STAGE 3 TIMER 2 TRIP OFF

E19 44 STAGE 4                  ON

E20 44 STAGE 4                  OFF

E21 45 STAGE 4 TIMER 1 TRIP ON

E22 45 STAGE 4 TIMER 1 TRIP OFF

E23 46 STAGE 4 TIMER 2 TRIP ON

E24 46 STAGE 4 TIMER 2 TRIP OFF

E25 47 OUTPUT SS1           ON

E26 47 OUTPUT SS1           OFF

E27 48 OUTPUT SS2           ON

E28 48 OUTPUT SS2           OFF

E29 49 OUTPUT SS3           ON

E30 49 OUTPUT SS3           OFF
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2.4.4. Format pictures and status texts

Table 2.4.4-1 Format pictures and status texts.

E31 50 OUTPUT SS4           ON

E32 50 OUTPUT SS4           OFF

E33 51 OUTPUT TS1           ON

E34 51 OUTPUT TS1           OFF

E35 52 OUTPUT TS2           ON

E36 52 OUTPUT TS2           OFF

E37 53 OUTPUT TS3           ON

E38 53 OUTPUT TS3           OFF

E39 54 OUTPUT TS4           ON

E40 54 OUTPUT TS4           OFF

E41 55 RECOVERY FUNCTION    ON

E42 55 RECOVERY FUNCTION    OFF

E43 56 RECOV.FUNC INTRRPTD

E44 57 RECOV.FUNC OPERATING

E45 58 RECOV.FUNC RESET

E50 185 RESTARTING

E51 186 REG. OVERFLOW

E52 187 COMMUNICATION

E53 188 RESPONDS                        FAILED

E54 188 RESPONDS                        AGAIN

E-code Index Object Text

Filename Value Status text

FORM4FRALI.PIC 0
1
2
3
4
5

Normal
Alarm
Remote
Local
Off
On

FORM4UMEV.PIC Unmapped event
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1MRS752008-MUM
3. SPA Relay Tool

3.1. Description
The SPA Relay Tool is used for monitoring and setting parameter data of the 
SPACOM relays.

This Tool is used for Relay units regarding:

• Parametrization

3.1.1. Target systems
• Relay units based on SPACOM object type.

3.1.2. Features/options
• Parametrization
• Upload/Download all parameters
• Upload/Download group of parameters
• Selection of setting group
• Reset of registers
• Authorization support
• Printing
• Compare
• Help in all dialogs

3.2. Tool environments
Depending on software environment, the SPA Relay Tool can be started in different 
ways:

• In LIB 510/MicroSCADA, the SPA Relay Tool can be started from the relay 
symbol (push button) in the station picture (see Fig. 3.2.1.-1). 

• In CAP 501/505 and SMS 510, you can use a tree navigator and select a relay. 
After this a list of tools is displayed and you can double click the item SPA Relay 
Tool (Fig. 3.2.1.-1)

3.2.1. Starting from LIB 510 in MicroSCADA
The relay units are displayed as push-buttons in station pictures as seen in 
Fig. 3.2.1.-1 (“push button”). The relay functions can also be installed to be selected 
from the control panel of the bay function.
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Fig. 3.2.1.-1 Station picture provided with a relay unit push button

By clicking the push button of any relay unit, the Relay Tool main view opens (see 
Fig. 3.2.2.-1).
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3.2.2. Starting from CAP 501/505, SMS 510

Fig. 3.2.2.-1 Starting Relay Setting Tool from the Project Structure Navigator
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3.3. Relay Setting Tool

3.3.1. Main view

Fig. 3.3.1.-1 Relay Setting Tool main overview

1. Title Bar
2. Main Menu
3. Toolbar
4. Module Selection Box
5. Tool Area
6. Parameter Group List Box
7. Status Bar

The Relay Setting Tool automatically selects the first module of the relay to the 
module list (see Fig. 3.3.1.-1, item 4) and the first parameter group item from the 
parameter group list (see Fig. 3.3.1.-1, item 6). After that the tool opens the data for 
selections.

The tool uses the internal parameter file (values.ini) for storing the parameter values. 
The parameter file is created with the default values by the relay configuration 
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dialog when the relay is installed into the project structure. The Relay Setting Tool 
maintains the file. The parameter values are updated to the parameter file every time 
when uploading is performed. All the values displayed by the tool are read from the 
parameter file. For example, if the user uploads parameter values, they are first 
updated to the file and after that read from the file to the tool.

1 Title bar
In LIB/MicroSCADA environment, the title bar shows the following information:

• Name of the application. Shown in LIB5x0/MicroSCADA application only
• Monitor number. Shown in LIB5x0/MicroSCADA application only
• Name of the object that the tool is using
• The name of the tool, e.g. Relay Setting Tool

2 Main menu
The main menu contains functions and commands for the Relay Tool.

3 Tool bar
The tool bar is a bar with buttons that perform some of the most common tasks. 
These functions are described in more detail further on in connection to File menu 
and Transfers menu.

Table 3.3.1.0-1 The Tool Bar buttons and their functions.

4 Module Selection
The Module Selection box beside the toolbar buttons shows a list of installed 
modules. By selecting a module from the drop-down combo list, the user can focus 
the operations to the selected module.

Button Functionality

Import (importing of parameter values)

Export (saving of parameter values into the directory)

Printing

Upload parameters (data sent to the relay)

Download parameters (data sent to the relay)
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5 Tool area
The tool area consists of a drop-down combo box and numbered pages. The tool area 
displays the selected view. The view is selected from the View menu. The default 
view is the Setting Tool.

The Relay Tool (Settings, Registers, Setting Tool) is displayed on this part of the 
HSI. The Settings and Registers views present the most frequently used information 
from the relay. The Setting Tool function offers a complete tool for monitoring and 
configuring the relay.

6 Parameter Group List Box
The Parameter Group List box shows a list of parameters and current values.Click 
the drop-down combo box to select the values you wish to change.

7 Status bar
The status bar shows information about the current status of the tool. The status bar 
has the following fields:

1. Information about the relay type, e.g. SPAC 531
2. Upload status of the parameters. The status may be:
• Uploaded 0000-00-00 00:00, when the parameter values of the selected 

parameter group/view have been read from the default file or they have been 
imported.

• Uploaded 1999-10-08 10:17, when the parameter values of the selected 
parameter group/view have been read from the relay.

3.4. Using Relay Setting Tool
This section describes the submenus and commands that are available in the Relay 
Tool menus.

3.4.1. File menu
The File menu contains the functions belonging to the file handling.

Fig. 3.4.1.-1 The File menu
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3.4.1.1. Importing

Fig. 3.4.1.1.-1 Import dialog 

With the help of the Import dialog (see Fig. 3.4.1.1.-1) it is possible to read 
parameter values from the selected file that will be used by the Relay Setting Tool. 
The imported parameter values replace the old values in the parameter file.

To import parameters, select the desired file and directory and click Open. To exit 
the dialog without executing the importing process, click Cancel.

Access: Authorization level 2. 
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3.4.1.2. Exporting

Fig. 3.4.1.2.-1 Export dialog 

Parameter values can be saved into files with the help of the Export dialog (see Fig. 
3.4.1.2.-1). To export parameter values, select the desired file and directory by 
clicking the relevant fields. Enter the name of the directory/file into the field named 
Save as, and click the Save button. To exit the dialog without executing the 
exporting operation, click Cancel.

Access: Authorization level 2. 

3.4.1.3. Page Setup

Fig. 3.4.1.3.-1 Page Setup dialog
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Before printing, the margins (Top, Left, Bottom, Right) can be defined. The Page 
Setup dialog (see Fig. 3.4.1.3.-1) can be found by clicking the Page Setup option in 
the File menu. The margins can be set in this dialog by selecting the appropriate 
values in the list. Confirm the set margins by clicking OK. Click Cancel to cancel.

3.4.1.4. Print Setup

Fig. 3.4.1.4.-1 Print Setup dialog 

Setup for the printer and for the paper is defined in the Print Setup dialog (see Fig. 
3.4.1.4.-1) which is also found in the File menu. Click OK to confirm setup. Click 
Cancel to cancel.

�
If you cancel printing in the Print dialog (see Fig. 3.4.1.5-1), cancellation has to be 
selected separately for each page that had been selected for printing, e.g. if pages 1-
3 had been selected for printing, cancellation is requested for pages 1, 2, and 3 
separately.

3.4.1.5. Printing

Fig. 3.4.1.5.-1 Print dialog
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It is possible to print parameter data of selected relay to the printer. In the Print 
dialog (see Fig. 3.4.1.5.-1) printing can be selected either for all modules, only for 
the selected module or for the selected group. To start the printing process, select the 
desired alternative by clicking the relevant option button and click OK. To exit the 
Print dialog without making any selection, click Cancel.

The following information is included in the printed document:

• Object identification 
• Date and time of parameter value upload
• Parameter values including both installed and edited values
• Date and time of printing
• Description of the type of the relay
• Description of the relay module

Access: No limitations. The print may look as in the following:

Printouts can be made from a Visual SCIL tool, such as the SPA Relay Tool, to a 
local or network printer defined in the operating system. The availability of printers 
and the configuration work needed depends on which context the MicroSCADA 
monitor is opened in. This varies in different MicroSCADA technology products, as 
described in the following sections.

CAP 501, CAP 505 and SMS 510
In CAP 501, CAP 505 and SMS 510 tools are always opened in accordance with the 
current user that has logged in to the operating system. In this case, all the printers 

Table 1: 

Relay parameters - Present and New Values

Parameter Parameter Name Present Value New Value

Type designation of the module F SPCD 2D55 SPCD 2D55

V150 - Select valid setting group. 
Main or second

V150 1 1

V180 – Settings for rated 
frequency (Hz part)

V180 050 050

V181 - Setting for rated frequency V181 000 000

Module version V205 124 A 124 A

Table 2: 

Object
PM_SPAC

Module Name
SPCD 3D53

Project Application
Sost -

Object Type
SPACOM ver. 1.1

Printed
99-05-03 09:13:27

Page
1 (1)
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that are provided by the operating system for the user are available also for printing 
from SPA Relay Tools.

LIB 510/MicroSCADA
In these products a monitor is by default opened in accordance with the 
MicroSCADA user, i.e. the user with the user name “MicroSCADA”. In this case 
only local printers can be used for printing from SPA Relay Tool. Local printers 
are:

• Printers connected directly to computer's serial or parallel port
• Network printers defined as local port.

The procedure how to define a network printer as local port is described in the SYS 
500 System Management Operator’s Manual.

If a monitor is opened from a command prompt or from SCIL with an operating 
system call, it can be opened to the context of the current operating system user. This 
requires that the command line option start_as_logon_user is used when opening the 
monitor. Further details for the opening of monitors can be found in the SYS 500 
System Management Operator’s Manual. When a monitor is opened in accordance 
with of the current operating system user, printers can be used as in CAP 501, CAP 
505 and SMS 510.

� When local printers are used, the MicroSCADA user should have access to these 
printers

3.4.1.6. Exit
By selecting the Exit option, the program exits the Relay Setting Tool and returns to 
the Project Structure Navigator (see Fig. 3.2.2.-1) in CAP 501/505 and SMS 510 
environment. In LIB 510/MicroSCADA environment, the Relay Setting Tool 
window is closed.

3.4.2. View menu
The parameter data can be viewed and set in the view menus. The View menu 
contains three views (Settings, Registers, Setting Tool), which each shows a 
different subset of the parameters of the selected module. 

By default, when the SPA Relay Tool is started, the Setting Tool view is opened to 
the tool area. The check mark in the View menu indicates which view is currently 
selected (see the following figure).

Fig. 3.4.2.-1 View menu
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3.4.2.1. Settings
By selecting Settings in the View menu, the active view is closed and the Settings 
view is opened (which is not necessarily supported by all modules).

The Settings view shows the values of the most important setting parameters.The 
settings parameters are fetched from the parameter file. Both main and second 
setting groups are shown and the active setting group is indicated. Values cannot be 
edited in Settings view, but you can get an explanation for each of the parameters by 
clicking an option button on the left side of the parameter value. 

If the parameter values from the default file have been used or the values have been 
imported, the tool shows the “?” character instead of the value. The character “?” 
indicates that the values shown on the screen are not the ones stored in the relay. An 
example of the Settings view is shown in Fig. 3.4.2.1.-1.

Access: No limitations

Fig. 3.4.2.1.-1 Settings View – Main Settings page
134



1MRS752008-MUM CAP, LIB, SMSTools for Relays and Terminals
User’s Guide 3.  SPA Relay Tool

3

3.4.2.2. Registers
By selecting Registers (which is not necessarily supported by all modules) in the 
View menu, the active view is closed and the Registers view is opened on the tool 
area. 

The Registers view shows the values of the registration parameters and they are 
fetched from the parameter file. It is not possible to edit the values. If the parameter 
values from the default file have been used or the values have been imported, the tool 
shows the “?” character instead of the value. The character “?” indicates that the 
values shown on the screen are not the ones stored in the relay. An example of the 
Registers view is shown in Fig. 3.4.2.2.-1.

Access: No limitations

Fig. 3.4.2.2.-1 Registers View for SPCD 3D53

3.4.2.3. Setting Tool
By selecting Setting Tool in the View menu, the Setting Tool is opened on the tool 
area. The Setting Tool is the default view.
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Setting Tool view

Fig. 3.4.2.3.-1 Setting Tool view

The Setting Tool view consists of the following parts (see Fig. 3.4.2.3.-1):

1 Parameter group selection 
Each module contains a number of parameter groups. In the Setting Tool, a list of 
the function groups available for the relay module can be seen in the parameter 
group selection. 

2 Settings notebook 
After selecting the parameter group, the parameters of the selected parameter group 
are displayed in a settings notebook. The number of pages depends on which group 
is selected in the group selection box. If a new group is selected, the Setting Tool 
notebook is updated. 

3 Present values field 
The values that are currently used are shown in the relay Present values field. If the 
parameter values from the default file have been used or the values have been 
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imported, the tool displays the “?” character instead of the present values to indicate 
that the values shown on the screen are not the ones stored in the relay.

4 New values field 
The values given by the user are shown in the New values field. When you click the 
values displayed in this field, the input dialog opens, where you can give the new 
values.

5 Value input dialog 
The values are given in separate dialogs. There can be different kinds of dialogs 
depending on parameter type.

Storing principle
The values of the parameters are stored in the parameter files. A parameter file 
contains two kinds of values for each parameter:

• Present value. A value that is currently used in the relay. The present value 
should always be valid and consistent with the value stored in the relay.

• New value. A value that can be edited by the user. New value may differ from 
the value stored in the relay.

The parameter files are created during the configuration process of the relay object 
by the configuration dialog of the object type. When the files are created, the values 
from the default files are used. The parameter values in the parameter files are 
maintained automatically by the tool.

Parametrization
You can set the parameters by using the Setting Tool view. Parameter settings can 
be changed by clicking the New Value field, after which a dialog named New Value 
appears on the screen. The allowed range for the values is given in the dialog. The 
new value can be entered in the field. Give the new value and click <Enter> or OK. 
To exit the dialog without confirming the new value, click Cancel.

After changing the values, the changes can be downloaded to the relay. If the 
changes have not been downloaded when closing the tool, the tool asks whether the 
changes are to be saved to the parameter file or discarded. Downloading or saving 
the changes is not allowed if the user has not been authorized to do the 
parametrization.

If there are only two alternatives, clicking with the mouse button will toggle between 
the two alternatives. If there are multiple choices, a dialog with a list is presented for 
selection (see Fig. 3.4.2.3.-2). If the relay module is protected with a password, the 
password is prompted before saving the changes. An example of main settings for 
output relay matrix switches of the module SPCJ 4D29 is shown in Fig. 
Fig. 3.4.2.3.-3.
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Fig. 3.4.2.3.-2 The dialog presenting possible alternatives for the new value in the Setting Tool view for main 
switches of the relay module SPCJ 4D29.
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Fig. 3.4.2.3.-3 The main settings for output relay matrix switches of the module SPCJ 4D29

3.4.3. Transfers menu
The Transfers menu contains commands used to communicate with the relay 
module.

Fig. 3.4.3.-1 Transfers menu
139



1MRS752008-MUMTools for Relays and TerminalsCAP, LIB, SMS
3. SPA Relay Tool User’s Guide
3.4.3.1. Upload parameters

Fig. 3.4.3.1.-1 Upload Parameters dialog 

Uploading is a process where the parameters are read from the relay to the relay 
setting tool. The function of the Upload dialog (see Fig. 3.4.3.1.-1) is to make a 
connection either to all modules, to the selected module, or to the selected parameter 
group of the selected module, and to upload parameters. To select the desired 
alternative, click the option button. Confirm the choice made by clicking OK and 
cancel by clicking Cancel.

Access: Authorization level 0.

3.4.3.2. Download parameters

Fig. 3.4.3.2.-1 Download Parameters dialog 

Downloading is a process where the parameters are transferred to the relay from the 
relay setting tool. Parameters can be downloaded either for all modules, only for the 
selected module, or for the selected parameter group of the selected module in the 
Download dialog (see Fig. 3.4.3.2.-1). To select the desired alternative, click the 
relevant option button. Confirm the choice made by clicking OK and cancel by 
clicking Cancel.

Access: Authorization level 2.

You can select the desired alternative from the Download dialog. It is not possible 
to perform downloading, when the Settings and Registers views are active. 

The third download option cannot be used (see Fig.3.4.3.2.-1), if the selected 
parameter group in the Setting tool view does not contain any editable 
parameters.The upload function is performed automatically after the downloading 
has been finished.
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3.4.4. Tools menu

Fig. 3.4.4.-1 Tools menu

The Tools menu contains the tools Compare, Reset Registers, Change Active Setting 
Group, View Transducers, and View Communication Settings. Each tool can be 
opened by clicking the appropriate alternative in the Tools menu.

3.4.4.1. Compare…
The purpose of the Compare function is to compare the values in the relay 
parameters with the settings. Both the present and the new values can be compared. 
The Compare function does not update the values in the parameter file. You can use 
either the values from the parameter file or you can import the values from some 
other file and then proceed with the Compare function. 

Fig. 3.4.4.1.-1 Compare dialog 

Present values and new values can be compared. Parameters can be compared either 
for all modules, for the selected module or only for the selected parameter group, see 
Compare dialog, Fig. 3.4.4.1.-1). Click the option button of the desired alternative 
and confirm the selection by clicking OK. To exit the dialog without confirming the 
selection, click Cancel.

After clicking OK in the Compare dialog, the dialog presented in Fig. 3.4.4.1.-3 
appears on the screen. The Compare dialog contains Present Values and New Values 
pages. 

To list the values that are different in the parameter file and in the relay, click the 
Compare button in the lower part of the dialog, after which the uploading dialog (see 
Fig. 3.4.4.1.-2) appears on the screen. If the data is the same in the file and in the 
relay, the report indicates that no differences have been found.

Access: No limitations.
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Fig. 3.4.4.1.-2 Uploading of values to be presented in the Compare dialog 

In the Present Values (see Fig. 3.4.4.1.-3) and in the New Values pages (see 
Fig. 3.4.4.1.-4) there are several fields: 

• in the first field the character # stands for a consecutive number 
• in the second field the name of the module is indicated
• in the third field the parameter name is presented 
• in the fourth field File Value is given 
• in the last field the Relay Value is given 

The values will be shown only if the values in the parameter file differ from the 
values in the relay. In case there has been an error during the reading process, an 
error message will be shown in Relay Value field.

Present Values page (see Fig. 3.4.4.1.-3) shows the differences between the Present 
Values in the file and the values in the relay.

Fig. 3.4.4.1.-3 Present Values page

New Values page (see Fig. 3.4.4.1.-4) shows the differences between the New 
Values in the file and the values in the relay.
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Fig. 3.4.4.1.-4 New Values page

3.4.4.2. Reset Registers

Fig. 3.4.4.2.-1 Reset registers dialog 

Registers can be reset either for all modules or only for the selected module by 
clicking the relevant option button in the Reset registers dialog (see Fig. 3.4.4.2.-1). 
To confirm the selection, click OK. To exit the dialog without confirming the 
selection, click Cancel.

Access: Authorization level 1.

3.4.4.3. Change Active Setting Group
The relay may contain a number of setting groups, but only one can be active at a 
time. You can change the active setting group for all modules or for some of the 
modules. When you have selected the function, the tool displays a dialog which 
shows the active setting groups for all modules. After that you can select another 
setting group and download the changes to the modules.

Access: Authorization level 1.
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Fig. 3.4.4.3.-1 The dialog for changing active settings

3.4.4.4. View Transducers

Fig. 3.4.4.4.-1 View Transducers dialog 

In the View Transducers dialog (see Fig. 3.4.4.4.-1) it is possible to view nominal 
values. To exit the dialog, click Close.

Access: No limitations.

3.4.4.5. View Communication Settings
View Communication Setting displays the communication settings for all modules.

Access: No limitations.

Fig. 3.4.4.5.-1 Communication Settings list 

3.4.5. Help menu
The Help menu contains only the About Relay Setting Tool dialog.
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Fig. 3.4.5.-1 Help menu

3.4.5.1. About Setting Tool
The dialog About Relay Setting Tool contains information about the current version 
of the Relay Setting Tool.
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1MRS752008-MUM
4. RED Relay Tool

4.1. Description
This tool is used for relay units regarding:

• Configuration for use in control system
• Parametrization
• Creation of needed process objects

4.1.1. Features/Options
• On-line parametrization
• Off-line parametrization
• Upload/Download all parameters
• Upload/Download group of parameters
• Selection of setting group
• Reset of registers (user settable)
• Tool can be started from a process picture (LIB 510/MicroSCADA)
• Alarm indication (in the station picture)
• Authorization support
• Compare
• Parametrization of times nominal values and primary values

4.2. Tool Environments
Depending on software environment, the RED Relay Tool can be started in different 
ways:

•  In LIB 510/MicroSCADA, the RED Relay Tool can be started from the relay 
symbol (push button) in the station picture (see Fig. 4.2.1.-1). 

• In CAP 501/505 and SMS 510, you can use a tree navigator and select a relay. 
After this a list of tools is displayed and you can double click the item RED Relay 
Tool (see Fig. 4.2.1.-1).
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4.2.1. Starting from LIB 510 in MicroSCADA
The relay units are displayed as push-buttons in the station picture (see Fig. 4.2.1.-1

Fig. 4.2.1.-1 The station picture including a relay unit push button

In case objects need updating, a dialog as presented in Fig. 4.2.1.-2 appears when 
you press the relay units’ push-button. You can update objects either manually in the 
Picture Editor or automatically by selecting Yes in the new dialog that will appear 
on the screen. In case you update objects manually in the Picture Editor, the whole 
configuration procedure has to be updated. In case you select the automatic 
updating, a dialog confirming that updating was successful appears on the screen 
(see Fig. 4.2.1.-3).
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Fig. 4.2.1.-2 Dialog indicating that an object needs updating

Fig. 4.2.1.-3 Dialog indicating that an object has been updated successfully

After the object has been updated successfully or a picture function has been clicked 
in the station picture (in case updating was not necessary), the Tool Menu dialog (see 
Fig. 4.2.1.-4) for the chosen object appears on the screen. This dialog contains a list 
of tools available for the relay unit.

Fig. 4.2.1.-4 The Tool Menu for a relay unit object

Select the desired tool and click Run if you want to change or view the Relay unit 
setting parameters. The main view of the Tool is shown in Fig. 4.3.3.-1 further on in 
this manual.
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4.2.2. Starting from CAP 501/505, SMS 510

Fig. 4.2.2.-1 Starting Relay Setting Tool from the Project Structure Navigator

Navigate to the desired relay object in the Project Structure navigation tree on the 
left and click it. The tools that are available for the selected object appear in the 
Object Tools list box on the right. Open the Relay Setting Tool by double-clicking 
it in the list.

4.3. Relay Setting Tool

4.3.1. General
The HSI of a RED Relay unit is built up with the same menu structure as the local 
HSI. The available RED Relay configurations are included in the object types (e.g. 
REF54x) of the SW Package SM/RED. The representation of the parameters in the 
Relay Setting Tool is based on HSI files (Menu, Image, Index and Help files). These 
files are included in the used relay configuration. 

When you select a new relay unit object for the first time, you need to build an 
Active Menu File. This is needed to present the HSI in the Relay Setting Tool. You 
must also build a new Active Menu File when the relay unit object application has 
been configured. The active menu file is built by using the HSI files as input.

4.3.2. Start-up

4.3.2.1. Build Active Menu
The message in Fig. 4.3.2.1.-1 and the Build Active Menu File dialog appear if the 
active menu of the used relay configuration is not found. Click Build in the Build 
Active Menu File dialog to build the active menu for the relay configuration. This 
dialog can also be opened from the Options menu.
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Fig. 4.3.2.1.-1 Active menu of the used relay configuration has not been found

Fig. 4.3.2.1.-2 The dialog for building the Active Menu File

� The Build Active Menu function does not apply to the REX52x relays.
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4.3.2.2. Import relay parameter settings from external programs
The relay parametrization that is made by another program (e.g. Event Editor) can 
be imported to the Relay Setting Tool. This import function appears automatically 
at startup. Click Yes if you want to update the values in the columns New Values. 
The dialog will appear only once.

Fig. 4.3.2.2.-1 The dialog for importing relay settings
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4.3.3. Main view

Fig. 4.3.3.-1 The main view for the Relay Setting Tool

The main view includes the following functions (see Fig. 4.3.3.-1):

1 Menu bar

The menu with commands for the Relay Setting Tool.

2 Toolbar

A bar with buttons that perform some of the most common tasks.

Table 4.3.3-1  The main view toolbar buttons 

Button Functionality

Import parameters

Export parameters
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In addition, the toolbar includes the drop-down list for selecting the highest-level 
node from the parameter tree representation. However, currently there is only one 
item “MAIN MENU” available for selection,1 i.e. there is no actual use for the drop-
down list.

3 Relay unit menu tabbed pages

These pages represent the functions of the selected relay unit. Click the page tab to 
select the function that you want to operated.

4 Minimise button

The relay tool can be minimized to an icon in the station picture.

5  Tool area
The relay tool is opened into this part of the HSI. The Setting tool function offers a 
complete tool for monitoring and configuring the relay unit. 

6 Status bar

The status bar shows information about the current situation in the Relay Setting 
Tool. The status bar has two fields. The first one shows information of the relay unit 
type e.g. REF 541. The second field shows the upload status of the parameters. The 
status might be:

• Uploaded 00-00-00 00:00:00, when the parameters of the selected page have 
been read from the default file.

• Uploaded 00-00-00 00.00.00, when the parameters of the selected page have 
been uploaded from the relay

Fig. 4.3.3.-2 The status bar

4.4. Using Relay Setting Tool

4.4.1. File menu
The file menu contains the functions belonging to file handling.

Printing

Upload (receive) parameters

Download (send) parameters

Button Functionality

1. This implementation is due to the parameter format specification the tool 
follows.
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Fig. 4.4.1.-1 The File menu

4.4.1.1. Importing

Table 4.4.1.1-1 The Import function:

Fig. 4.4.1.1.-1 The Import dialog for the import function

Access: User level 2.

Selection Functionality

Import Opens a parameter database for importing parameters. The parameter 
file is selected on the Import dialog (see Fig. 4.4.1.1.-1).
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4.4.1.2. Exporting

Table 4.4.1.2-1 The Export function:

Access: User level 2

Fig. 4.4.1.2.-1 The Export dialog for the export function

Access: User level 2. 

4.4.1.3. Page Setup

Table 4.4.1.3-1 The Page Setup function:

Selection Functionality

Export Saves all parameters for exporting into the file being currently 
selected. The file name can be selected from the dialog, which is 
opened first.

Selection Functionality

Page Setup Opens a dialog in which page setup/margins (Top, Left, Bottom, Right) 
can be defined.
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Fig. 4.4.1.3.-1 Page Setup dialog

4.4.1.4. Print Setup

Table 4.4.1.4-1 The Print Setup function:

Fig. 4.4.1.4.-1 Print Setup dialog

�
In case the option VS Remote has been selected in the MicroSCADA Monitor dialog 
(see Fig. 4.4.1.4.-2), the option Print Setup in the File menu is unavailable, and the 
dialog presented in Fig. 4.4.1.4.-3 pops up. In this case, information about the printer 
is given in the MicroSCADA Monitor dialog (the last field on the left-hand side of 
the dialog in Fig. 4.4.1.4.-2).

Selection Functionality

Print Setup Opens a dialog in which print setup for the paper as well as for the 
printer can be defined, if you have selected the option VS Local in the 
MicroSCADA Monitor.
157



1MRS752008-MUMTools for Relays and TerminalsCAP, LIB, SMS
4. RED Relay Tool User’s Guide
Fig. 4.4.1.4.-2 VS Remote monitor selected in the MicroSCADA Monitor dialog

Fig. 4.4.1.4.-3 Dialog indicating that print setup cannot be opened when VS 
Remote Monitor has been selected

4.4.1.5. Printing

Table 4.4.1.5-1 The Print function:

Selection Functionality

Print Opens a dialog in which it is possible to select printing of the current 
page, all pages or of certain pages (the page numbers can be entered 
in the field, see Fig. 4.4.1.5.-1). It is also possible to select whether 
present values, new values, or both present and new values are 
printed. When you select printing of both present and new values, 
printing requires more pages than when you select printing of either 
present values or new values. 
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Fig. 4.4.1.5.-1 Print dialog

Fig. 4.4.1.5.-2 Print dialog 2

After you have the desired printing option selected and clicked OK in the Print 
dialog (see Fig. 4.4.1.5.-1), the second Print dialog (see Fig. 4.4.1.5.-2) pops up. In 
this dialog you either confirm printing or cancel it.

Printouts can be made from a Visual SCIL tool, such as the RED Relay Tool, to a 
local or network printer defined in the operating system. The availability of printers 
and the configuration work needed depends on which context the MicroSCADA 
monitor is opened in. This varies in different MicroSCADA technology products, as 
described in the following sections.
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CAP 501, CAP 505 and SMS 510
In CAP 501, CAP 505 and SMS 510 a tool is always opened in accordance with the 
current user that has logged in to the operating system. In this case, all the printers 
that are provided by the operating system for the user are available also for printing 
from RED Relay Tools.

LIB 510/MicroSCADA
In these products a monitor is by default opened in accordance with the 
MicroSCADA user, i.e. the user with the user name “MicroSCADA”. In this case 
only local printers can be used for printing from RED Relay Tool. Local printers 
are:

• Printers connected directly to computer's serial or parallel port
• Network printers defined as local port.

The procedure how to define a network printer as local port is described in the SYS 
500 System Management Operator’s Manual.

If a monitor is opened from command prompt or from SCIL with an operating 
system call, it can be opened to the context of the current operating system user. This 
requires that the command line option start_as_logon_user is used when opening the 
monitor. Further details for the opening of monitors can be found in the SYS 500 
System Management Operator’s Manual. When a monitor is opened in accordance 
with current operating system user, printers can be used as in CAP 501, CAP 505 
and SMS 510.

� When local printers are used, the MicroSCADA user should have access to these 
printers.

4.4.1.6. Exit

Table 4.4.1.6-1 The Exit function:

Fig. 4.4.1.6.-1 The Exit dialog

Access: No limitations 

Selection Functionality

Exit Exits the Relay Setting Tool and returns to the station picture from 
where the tool is started.
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4.4.2. View menu
The View menu contains a selection of views for the currently selected relay 
configuration. The All view is always available and it shows all parameters of the 
active menu. The other possible views are subviews of the All view and they are 
user-specific. These additional alternatives may be added by using the Options/
Menu configuration (described in Section 4.4.5.3.).

Fig. 4.4.2.-1 The View menu

4.4.3. Transfer menu
The Transfer menu contains commands used to communicate with the relay unit. 
The offered selections below the line in the menu are user-specific. These additional 
possibilities are to be added by using the Options/Menu configuration (described in 
Section 4.4.5.3).

Fig. 4.4.3.-1 The Transfers menu, the Reset... selection is shown as an example 
of an user-specific configuration

Reservation of communication
The RED Relay Setting Tool reserves communication to the selected object upon a 
transaction between the tool and the relay unit. Communication is reserved until 
either the tool is closed or fifteen (15) minutes has elapsed since the transaction 
ended.

�
Persistence of write-only parameter settings
All write-only parameters that have been changed and thereafter saved to the 
parameter file, remain effective until manually reset to their initial ineffective state. 
For example, if the value of the "Reset registers" command is set to "Reset" in the 
New Value field and the values are stored when exiting the tool, then the "Reset 
registers" command is still active the next time the tool is opened. In order to take 
the "Reset" command out of use, the value in the New Value field must be set to "0" 
(the original value) and, after that saved to, the parameter file.

It is recommended that whenever a write-only parameter has been activated it should 
be immediately deactivated once used in a download. By following this practice, 
write-only parameters are never inadvertently used in future downloads.

Distinction between the types ("write-only" or "normal") of individual parameters 
should be based on the information which is available in the respective relay 
terminal unit manual. The values of the write-only parameters cannot be read from 
the relay terminal unit. The Relay Setting Tool does not provide this information.
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4.4.3.1. Upload

Table 4.4.3.1-1 The Upload function:

Fig. 4.4.3.1.-1 The dialog for selecting the uploading method

Access: User level 0.

4.4.3.2. Download

Table 4.4.3.2-1 The Download function:

Fig. 4.4.3.2.-1 The dialog for selecting the downloading method

Access: User level 2.

Selection Functionality

Upload Connects to the selected unit and uploads (receives):
1) parameters that are defined in the current page
2) all parameters of the current view (selected in the View menu)
3) parameters on the entered pages.

Selection Functionality

Download 1) parameters that are defined in the current page
2) all parameters of the current view (selected in the View menu)
3) parameters on the entered pages.
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After uploading/downloading has been started, the dialog shown in Fig. 4.4.3.2.-2 
appears on the screen. The dialog gives you information about the current operation 
(uploading/downloading). It also shows how downloading proceeds. The Stop 
button cancels the operation and removes the dialog.

Fig. 4.4.3.2.-2 The communication dialog

If the communication error is such that the relay unit does not answer, a dialog is 
opened, which prompts you to select whether to Retry or Cancel the downloading 
process.

If an error occurs during communication (the relay answers with the NAK code), the 
error dialog is shown with the possibility to either skip, retry or cancel the reading.

Fig. 4.4.3.2.-3 An example of a communication error dialog 

Fig. 4.4.3.2.-4 Another communication error dialog 

After the uploading/downloading process is completed, the dialog is closed and the 
tool area is updated.
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4.4.3.3. Store

� The Store function applies only to certain relays.

Table 4.4.3.3-1 The Store function:

Fig. 4.4.3.3.-1 The dialog in which the storing of parameter values is confirmed 

Fig. 4.4.3.3.-2 The dialog indicating progress in the storing process

Clicking the Close button in Fig. 4.4.3.3.-2 does not interrupt the storing operation, 
but asks you whether you want to close the dialog or not (see Fig. 4.4.3.3.-3). Close 
the dialog by selecting Yes. You will however not receive any information whether 
storing was successful or not. If you select No, the program will return to the Storing 
dialog (see Fig. 4.4.3.3.-2).

Selection Functionality

Store Stores settings to the non-volatile memory in the relay unit. Clicking 
Close in the Storing dialog does not cancel storing operation in the 
relay unit. But then it cannot be guaranteed that storing has been 
completed successfully (see Fig. 4.4.3.3.-1). This function is not 
provided by all relays.
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Fig. 4.4.3.3.-3 Dialog asking whether you want to close the storing dialog

Fig. 4.4.3.3.-4 Storing completed successfully!

4.4.3.4. Reset (example)

Table 4.4.3.4-1 The Reset function:

Fig. 4.4.3.4.-1 The dialog for resetting relay unit

Selection Functionality

Reset... Opens a dialog for some general resetting operations. Select the 
wanted action and click Send. See the example in Fig. 4.4.3.4.-1.
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Fig. 4.4.3.4.-2 The dialog in which the selected action can be confirmed

4.4.4. Tools menu
The Tools menu contains miscellaneous tools and commands.

Fig. 4.4.4.-1 Tools menu

4.4.4.1. Compare

Table 4.4.4.1-1 The Compare function:

Fig. 4.4.4.1.-1 Compare dialog in which the comparing process can be started by 
pressing the Compare button.

Selection Functionality

Compare The purpose of this function is to check that the values in the 
parameter file and in the relay are the same. The Compare dialog 
contains two pages: 

• Present Values page shows the differences between the Present 
Values in the file and the values in the relay. 

• New Values page shows the differences between the New Values in 
the file and the values in the relay.
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In the Present Values and in the New Values pages (see Fig. 4.4.4.1.-1) there are 
several fields: 

• in the first field the character # stands for a consecutive number 
• the second field (called Parameter) indicates the description of the parameter
• in the third field the database name is presented 
• in the fourth field the File Value is given 
• in the last field the Relay Value is given. 

The values will be shown only if the values in the parameter file differ from the 
values in the relay. In case there has been an error during the reading process, an 
error message will be shown in the Relay Value field. You can start the comparing 
process by pressing the Compare button in the lower part of the dialog. Click Close 
to exit the dialog without starting the comparing process.

Fig. 4.4.4.1.-2 Compare Uploading dialog

When you click a field in the Present Values or New Values page, the field is 
activated (shown in blue as presented in Fig. 4.4.4.1.-3). A menu path is shown in 
the field on the left-hand side of the dialog in the status bar. The time when the File 
Value was updated last time is shown on the right-hand side in the status bar.
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Fig. 4.4.4.1.-3 Compare New Values dialog

To exit the dialog, click Close.

4.4.4.2. Edit History

Table 4.4.4.2-1 The Edit History function:

 

Fig. 4.4.4.2.-1 Edit History dialog

To erase all information from the dialog, click Clear. To exit the dialog, click Close.

Selection Functionality

Edit History Made changes are collected and presented in the Edit history dialog. 
These changes remain in the dialog only until the end of the session 
(i.e. they are not saved).
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4.4.4.3. View Transducers

Table 4.4.4.3-1 The View Transducers function:

Fig. 4.4.4.3.-1 Transducers dialog

To exit the dialog, click Close.

4.4.5. Options menu
The Options menu contains miscellaneous tools and commands.

Fig. 4.4.5.-1 The Options menu

4.4.5.1. Resize Dialog 

Table 4.4.5.1-1 The Resize Dialog function:

Access: User level 1.

Selection Functionality

View Transducers Nominal values can be viewed in the View Transducers dialog. These 
nominal values are used when calculating primary values for certain 
parameters (4.4.7.2.-1, note 6). Values are defined in the Object 
Configuration Tool, please see Chapter 1.“SM/RED” on page 1.

Selection Functionality

Resize Dialog Opens a dialog in which the size of the dialog can be changed (see 
Fig. 4.4.5.1.-1).
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Fig. 4.4.5.1.-1 Dialog for resizing the Relay Setting Tool

4.4.5.2. Rebuild Active Menu

Table 4.4.5.2-1 The Rebuild Active Menu function:

Under Source HSI files there is a page for every HSI file. These pages contain 
information about file location, relay type, software number, version and state, date 
of creation and author. These files are used when building the new active menu.

Under Build Active Menu File there is information about the current active menu 
file: file location path, date of creation and status. Details of used HSI files can be 
found under Files Used.The active menu file has been created on the basis of these 
used HSI files.

Access: User level 1.

Selection Functionality

Rebuild Active 
Menu

Opens a dialog, where the building of the Active Menu File is started. 
You need this file to present the HSI in the Relay Setting Tool. The 
dialog is automatically opened at the startup of the relay setting tool, if 
the relay unit application has been reconfigured.
NOTE! The Rebuild Active Menu function does not apply to the 
REX52x relays.
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Fig. 4.4.5.2.-1 The dialog for building the Active Menu File

4.4.5.3. Menu Configuration

Table 4.4.5.3-1 The Menu Configuration function:

Access: User level 2.

An example of how to add a function to the View menu is shown in the following 
section. The method is the same for both View and Transfers. You can add several 
new selections to the menus. It is also possible to delete inactual selections from the 
menus.

Selection Functionality

Menu 
Configuration

With this function you have the possibility to customize the View and 
Transfers menu options. All menu configuration settings apply only to 
the object that has been selected in a station picture (in LIB/
MicroSCADA environment) or in the navigation tree (in CAP 501/505 
environment).
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Menu Configuration/View Menu

Fig. 4.4.5.3.-1 Adding a new configuration to the list of Configurations

Start by creating a new configuration with the function Create. After you have 
pressed the Create button, the “raw material” New Config1 is added to the 
Configurations list. Select this item and click Properties.
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Fig. 4.4.5.3.-2 Giving the properties for Serial number

Table 4.4.5.3-2 The function Properties has the following fields and 
functions:

After New Config1 has been configured, it will have the name Serial number. The 
following step is to prepare the Menu Commands. Start by pressing Add, and the 
New Command1 appears on the list.

Selection Functionality

Name Give a useful name for the configured function, otherwise it will remain 
as e.g. New Config1. In the example mentioned above the name Serial 
number has been given by the user.

Menu Tree Navigate in the menu tree and select the wanted function.

Parameters The selectable parameters are shown in this field. Select the ones 
needed.

OK Verify the choices made.

Cancel Regret and return without changes.
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Fig. 4.4.5.3.-3 A new menu item New Command 1 is added to the Menu 
Commands, but it still has to be prepared with the help of the 
Properties functions.

Select New Command1 and press Properties.

Fig. 4.4.5.3.-4 Giving the name for the menu function and binding it to the 
appropriate configuration.
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Table 4.4.5.3-3 Menu Properties contains the following fields and functions:

The new menu selection is at your disposal after closing the Options/Menu 
configuration function.

Fig. 4.4.5.3.-5 The new menu selection is at your disposal

Menu Configuration/Transfers Menu
You have the possibility of preparing your own Transfers menu. The method is 
exactly the same as described in the previous section regarding the View menu, see 
Section 4.4.5.3.

Fig. 4.4.5.3.-6 The Transfers menu is customized in the same way as the View 
menu. In this connection the option Properties has slightly different 
functions as in the View menu, see Fig. 4.4.5.3.-3.

Selection Functionality

View name Rename the New Command1 with the name you intend to present in 
the View menu.

Bind to 
Configurations

You will now have to bind a configuration with the menu selection.

OK Verify your changes/setup

Cancel Regret and leave without changes
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Select Properties for the created New Config 1, see Fig. 4.4.5.3.-7:

Fig. 4.4.5.3.-7 Giving the properties for the new configuration

Table 4.4.5.3-4 The fields and functions are used in the following way:

Remarks regarding Fig. 4.4.5.3.-7: 

As it can be seen in the Source list in Fig. 4.4.5.3.-7, a huge amount of parameters/
items can be selected and added to the Target list. Normally, the idea is not to make 
parametrization of the relay parameters via the Transfers menu even if it is possible, 

Selection Functionality

Name Give a useful name for your configured function, otherwise it will 
remain as e.g. New Config 1. In the example above the name Outputs/
Events is given by the user.

Source Select the wanted parameters or items to be added to the Target and 
click the Add button

Target The Target list contains a list of all added items from the Source list. By 
selecting the items one by one, the text can be edited. The field for the 
parameter code, e.g. F127V107 cannot be edited, but the value in the 
field to the right can be changed. Click Apply to verify each change of 
an item on the Target list.

Add Adds the selected item from the Source list to the Target list

Remove Removes the selected item from the Target list

OK Verify your selections and modifications made

Cancel Regret and return without changes, also those confirmed with the  
Apply button
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but to enable e.g. resetting of registers, indications etc. in the relay. Relay 
parametrization and monitoring is described further on in Section 4.4.7.

Furthermore, the user should check that the value of each parameter/item in the 
Target list has the right value (in the field on the right side of the parameter code). 
In other words, you should ensure that the parameter/item has the value you want to 
send to the relay. The default value is not always the wanted one. The values can, of 
course, be changed afterwards, whenever necessary. It is also recommended to take 
into consideration that giving “wrong” value may result in that the expected result 
remains unfulfilled when executing the menu selection in the Transfers menu.

4.4.6. Help
The Help menu contains an on-line help for the tool functions.

Fig. 4.4.6.-1 The Help menu

4.4.6.1. About Relay Setting Tool

Table 4.4.6.1-1 About Setting Tool:

Access: No limitations.

4.4.7. Monitoring and changing parameters
The RED Relay Setting Tool gives you a powerful tool for monitoring and 
configuring the relay units.

4.4.7.1. RED menus
When a menu from the Relay Setting Tool is selected, a menu hierarchy of the 
functions (see Fig. 4.4.7.2.-1, item 1) available for the relay unit is displayed in the 
tool area. Each function holds several tabbed pages of configurable parameters.

4.4.7.2. Tabbed pages
The Relay Setting Tool Main View contains tabbed pages. The hierarchy and the 
number of these tabbed pages depends on the selected relay. A tabbed page can be 
selected by clicking the wanted page with the mouse, e.g. page 41 (see item 2 in Fig. 
4.4.7.2.-1). Item 3 in Fig. 4.4.7.2.-1 indicates the last page (214).

Selection Functionality

About Setting Tool Gives information regarding the setting tool.
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Fig. 4.4.7.2.-1 Relay Setting Tool Main View

4.4.7.3. Parametrization
The Setting Tool pictures hold a field indicating the Present Value and a field 
indicating the New Value. After you have changed the new values, the changes have 
to be downloaded to the relay unit. To download parameters, select Transfers menu 
and click Download parameters. The Present Value field is updated when you have 
downloaded the new values.

If there are multiple choices, the suitable alternative can be selected from the drop-
down combo box (see item 4 in Fig. 4.4.7.2.-1). If the relay unit is protected by a 
password, the password is prompted before you can download the changes. To enter 
a new value, press the mouse button or any key in the New Value field (item 5 in 
Fig. 4.4.7.2.-1). A dialog opens in which you can enter the new value (see Fig. 
4.4.7.3.-1). Item 6 is also an input field for the new value. Whether this is in use or 
not, is defined in the Object Configuration Tool.
178



1MRS752008-MUM CAP, LIB, SMSTools for Relays and Terminals
User’s Guide 4.  RED Relay Tool

4

Fig. 4.4.7.3.-1 The input field of the Setting Tool

4.5. PQ-Monitoring Tool in LIB510/MicroSCADA

4.5.1. General
The Power Quality Monitoring Tool is used to visualise the data generated by PQ 
IEDs (Power Quality Intelligent Electronic Devices) and uploaded by 
MicroSCADA.

4.5.2. Start-up
You start by clicking the relay units' push-button in the station picture. Select the 
PQ-Monitoring Tool from the opened dialog and click Run.

Fig. 4.5.2.-1 Tool Menu for a relay unit object

If the selected relay unit does not have any PQ-Monitoring Function, the Monitoring 
Tool will not open and the following dialog will appear on the screen.
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Fig. 4.5.2.-2 A dialog indicating that PQ function is not available

4.5.3. Main view

Fig. 4.5.3.-1 Main view of the PQ-Monitoring Tool

This is a main view of the tool when Voltage waveform distortion measurement is 
selected (the other implemented function, Current waveform distortion 
measurement, looks exactly the same). The main view consists of the following 
functions:

1. Menu bar
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A set of menus for basic functions of the tool.

2. Toolbar

A bar of buttons for commonly used operations.

3. Tabbed page

A tabbed page where each page opens a new visualization area depending on the 
used monitoring function.

4. Visualization area

An area where the monitored data is displayed.

5. Status bar

A bar where some various monitoring information is displayed.

4.5.3.1. Menu bar
The Menu bar includes the following menus.

File menu
The File menu contains the file handling functions.

Fig. 4.5.3.1.-1 File Menu

Table 4.5.3.1-1 The Print Setup function:

Selection Functionality

Print Setup Opens a dialog in which the used printer setup can be modified if the 
used MicroSCADA Monitor type is VS Local.
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Fig. 4.5.3.1.-2 Print Setup dialog 

If the used MicroSCADA Monitor type is VS Remote, the following error dialog 
appears on the screen.

Fig. 4.5.3.1.-3 Print Setup error dialog 

When the VS Remote monitor is used the printer selection must be done when 
starting the MicroSCADA monitor.
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Fig. 4.5.3.1.-4 VS Printer selection in MicroSCADA VS Remote Monitor startup

Table 4.5.3.1-2 The Print function:

Fig. 4.5.3.1.-5 Print dialog on a VS Local Monitor

Selection Functionality

Print Opens a printing dialog of the current page where the setup can also 
be changed (VS Local Monitor type). If the used Monitor type is VS 
Remote, the Print dialog is another.
183



1MRS752008-MUMTools for Relays and TerminalsCAP, LIB, SMS
4. RED Relay Tool User’s Guide
Fig. 4.5.3.1.-6 The Print dialog on a VS Remote Monitor

�
Printing needs information from the active menu of the used relay. If the active menu 
file of the relay is not found, an error dialog pops up (see Fig. 4.5.3.1.-7) and the 
menu should be build with the Relay Setting Tool.

Fig. 4.5.3.1.-7 Error dialog when Active Menu file was not found

Table 4.5.3.1-3 The Exit function:

Fig. 4.5.3.1.-8 Exit dialog 

View menu
The available PQ-Monitoring functions are listed and selectable in the View menu 
of the tool.

Selection Functionality

Exit Exits the PQ-Monitor Tool.
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Fig. 4.5.3.1.-9 View menu

Table 4.5.3.1-4 The selectable PQ-Monitoring functions:L

Options menu
This menu includes some configurable options of the PQ-Monitoring Tool.

Fig. 4.5.3.1.-10 Options menu

The automated data uploading is started by selecting "Harmonic violation" and 
"Obs. Period ended" events. In this menu you can enable or disable (toggle on and 
off) the auto-upload feature by selecting the modifiable item. In the menu above, the 
first two items are enabled and the last two disabled.

�
Enabling and disabling automated data upload is only allowed on authorization level 
Engineering (2), or higher. If the rights of the user are insufficient, the following 
error dialog will appear on the screen.

Fig. 4.5.3.1.-11  Insufficient user rights to change the auto-upload option

Help menu
The Help menu includes the on-line help of the tool functions.

Selection Functionality

PQVO3H Opens a view of "Voltage waveform distortion measurement". The 
monitorable PQ indices can be seen and selected on the pages of the 
opened page.

PQCU3H Opens a view of "Current waveform distortion measurement". The 
monitorable PQ indices can be seen and selected on the pages of the 
opened page.
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Fig. 4.5.3.1.-12  Help menu

Table 4.5.3.1-5 The Help menu functions:

4.5.3.2. Toolbar
The Toolbar includes the commonly used buttons presented in the following table: 
The first three buttons do the same file handling functions as the choices in the File 
menu.

Table 4.5.3.2-1 Commonly used buttons in the toolbar:

Some further information is also viewed on the toolbar. The presented information 
depends on what is being monitored. If the on-line values are viewed, the 
information of "Measured input" is shown. In the case of harmonic violation the 
"Violation Period" is shown and can be selected from the toolbar. If the values from 
a certain period are monitored, the "Observation Period" is shown and selectable on 
the toolbar.

Fig. 4.5.3.2.-1 Information of the selected Harmonic Violation Period

4.5.3.3. Tabbed page
A tabbed page is opened, when you make a selection of the monitoring function 
(Voltage or Current waveform distortion measurement) from the View menu. When 
you click the wanted page, the actual page for visualization opens.

Selection Functionality

Help Opens a dialog containing the on-line help of the tool functions.

About PQ-
Monitoring Tool

Opens a dialog containing some general information of the PQ-
Monitoring Tool.

Button Functionality

Exit

Print Setup

Print

Upload button used to upload on-line data from the relay
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Fig. 4.5.3.3.-1 The list of monitored data on Voltage or Current Harmonics

If there is no saved data for a Harmonic Violation Period or an Observation Period 
the following information dialog appears on the screen.

Fig. 4.5.3.3.-2 An information dialog of saved data not available

4.5.3.4. Visualization area
This is the area where the actual results are being visualized. The uploaded or saved 
data is shown on a bar chart of harmonics or on a cumulative curve of the selected 
harmonic.

The bar chart of a Harmonic Violation Period consists of bars and a curve.
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Fig. 4.5.3.4.-1 A bar chart of a Selected Harmonic Violation Period

In this picture, the height of each bar describes the magnitude of a harmonic value. 
The values under the adjustable limits (yellow lines) are shown with green bars and 
the values over the limits with red bars. The continuous black curve describes the 
limits of the EN 50160 Standard for each harmonic.

A picture of a Selected Harmonic during a selected Observation Period is shown in 
the following figure (see Fig. 4.5.3.4.-2).
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Fig. 4.5.3.4.-2 A cumulative curve of selected harmonic during an Observation Period (Requirements fulfilled)

This curve is drawn according to five percentiles (1%, 5%, 50%, 95% and 99%) 
calculated by the relay unit. The adjusted limit value for a selected harmonic is 
shown with a red horizontal line. If the 95% percentile value for the selected 
harmonic is under the adjusted limit, the cumulative curve is blue and the 
requirements are fulfilled.

If the 95% percentile value for the selected harmonic exceeds the adjusted limit, the 
cumulative curve changes to red and the requirements are not fulfilled.
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Fig. 4.5.3.4.-3 A cumulative curve of selected harmonic during an Observation Period (Requirements not 
fulfilled)

4.5.3.5. Status bar
Various information is displayed on this bar depending on the monitoring function.

Fig. 4.5.3.5.-1 A status bar information on a selected Harmonic Violation period

The status bar presents always the information and explanation of the data 
generating Function Block. The rest depends on what is being monitored:

• If on-line values are monitored, the status bar includes the information of the 
ending of current observation period. 

• When a harmonic violation period is displayed, the status bar shows the time 
stamp of the recorded maximum values. 

• If the X% values are monitored, the adjusted X (percentile) is shown. 
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• A number of the harmonic (or THD) is viewed, when the curve of selected 
harmonic is presented.

4.5.4. Monitoring functionality
After the PQ-Monitoring Tool has been started, you should select the wanted 
monitoring function from the View menu. By selecting the first or second page from 
the opened page (On-line 3 sec. Values and On-line 10 min. Values), the on-line 
values from the relay can be uploaded. The on-line mode is also indicated by the 
upload button. 

The rest of the pages are used for saved data visualization. When any of these tabbed 
pages is selected, the upload button is disabled.

4.5.4.1. On-line monitoring
The on-line monitoring is started by pressing the upload button on the toolbar. When 
the uploading begins, the following indicator of the process proceeding pops up.

Fig. 4.5.4.1.-1 An indication dialog of the uploading process proceeding

If the relay unit does not answer or there is some other communication problem, an 
error dialog appears on the screen (see Fig. 4.5.4.1.-3)

Fig. 4.5.4.1.-2 An error dialog of communication problem

� The manual data uploading requires authorization level Control (1) or higher. 
Otherwise, the following information dialog is opened (see Fig. 4.5.4.1.-3).
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Fig. 4.5.4.1.-3 Insufficient user rights to manual data uploading

4.5.4.2. Monitoring of saved data
To monitor the previously saved data, select the wanted time period from the drop-
down list on the toolbar.

Fig. 4.5.4.2.-1 Selection of a harmonic violation period from a drop-down list

When you have selected a period, the progress indicator opens and the saved data is 
read from the disk. After that, the results are ready to be visualized.
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1MRS752008-MUM
5. DR-Collector Tool

5.1. General
DR-Collector Tool is a disturbance recorder tool used for:

• Uploading recordings from the disturbance recorder, also automated uploading in 
LIB510/MicroSCADA

• Monitoring
• Deleting recordings
• Remote triggering
• Copying, deleting, moving

Recorder files are created in COMTRADE format.

DR-Collector Tool is used in LIB 510 in MicroSCADA, CAP 501, CAP 505 and in 
SMS 510 environments.

�
The DR-Collector Tool that was integrated into SPA Relay Setting Tool in LIB 510 
Version 9.0.2 or older cannot be used at the same time as the new version of DR-
Collector Tool.

5.1.1. Communication support
LIB 500/510 in MicroSCADA
•  LON
•  SPA

CAP 501
•  SPA (Front connector)

CAP 505
•  SPA
•  LON

5.1.2. Supported disturbance recorders
•  MEDREC16 Function Block
•  SPCR 8C27 (Communication via front port not supported, see Section 5.3.7.3 

Transfers menu)
•  Internal recorders in SPCD 2D55 and SPCD 3D53
•  Internal recorders in REJ and REU relays
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5.2. Using DR-Collector Tool
5.2.1. General

If an object is configured in the way that it contains a Disturbance Recorder module/
function block, the object in question can be seen in the navigation tree of the 
Recorder Tool in the DR-Collector Tool. For instance, REF 54x has to be configured 
to contain MEDREC 16 function block. After that the REF 54x object can be seen 
in the navigation tree. If you want the SPACOM object to be visible in the navigation 
tree, SPCR 8C27 has to be visible on the Rack Configuration page in the SPACOM 
configuration.

For more information on Recorder Tool, see Section 5.3.

5.2.2. Starting DR-Collector Tool 
The DR-Collector Tool can be started in different ways, depending on the software 
environment. In LIB 510 in MicroSCADA, DR-Collector Tool is started as 
described in Section 5.2.2.1.The procedure how to start DR-Collector Tool in CAP 
501/505 and in SMS 510 environments is described in Section 5.2.2.2. 

5.2.2.1. Starting from LIB 510 in MicroSCADA
In LIB 510, you can start the DR-Collector Tool from the Options Menu in 
MicroSCADA main view, see the following figure. 

Fig. 5.2.2.1.-1 DR-Collector Tool started from the Options menu

HV/Collect is used for disturbance uploading for high-voltage relays (LIB 520).

�
If an error message appears on the screen after selecting DR-Collector Tool in the 
Options menu, one possible reason is that the DR-Collector Tool has not been 
installed at all. To install the tool, please contact the project engineer. 

5.2.2.2. Starting from CAP 501/505 and SMS 510
In CAP 501/505 and in SMS 510 environments, you start the DR-Collector Tool by 
selecting it from the System Tools menu (see Fig. 5.2.2.2.-1).
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Fig. 5.2.2.2.-1 Starting DR-Collector Tool from the System Tools menu

After this the DR-Collector view appears on the screen (see Fig. 5.2.3.-1). DR-
Collector Tool is started directly, i.e. no object selection is required.

5.2.3. DR-Collector Tool overview
The view appearing after the DR-Collector Tool has been started, consists of the 
following parts:

Fig. 5.2.3.-1 DR-Collector Tool view

1. Menus
2. Toolbar buttons
3. Line number
4. Date of recording 
5. Time of recording
6. Location indicating the relay/recorder that originates the recording
7. The name of the File that originates the recording
8. Identification of the disturbance recorder originating the recording
9. Trigger (i.e. the type of signal generating triggering)
10.Path indicating the location of recording files (the Path and Location together 

specify the directory where the recording file resides)
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�
This applies to LIB510/MicroSCADA only: the name given in square brackets (e.g. 
[FIMIT-RVS-S11]) indicates the name of the MicroSCADA Base System computer 
when Remote Monitor is selected. The letter in the beginning of the path (e.g. C, E, 
H) refers to the drive name of the MicroSCADA Base System computer, not to the 
drive name of the computer of the Remote Monitor.

11.The amount of free space left in drive C. In case there is less than 100 kb free 
space left in drive C, the commands Refresh, Recorder Tool, Evaluation 
program and Comment cannot be carried out.

The Options dialog (see Fig. 5.2.4.2.-2) you can open by clicking Options in the 
View menu. Here you can choose which columns (see Fig. 5.2.3.-1, items 4-9) are 
to be shown in the DR-Collector Tool main view.

Recording files are named in the following way: YYMDDNNN.EEE. Below you 
can find the meanings:

YY the year of the time tag in the trigger information (0.99)
M the number of the month in the trigger information in the 

hexadecimal format (1.C)
DD the number of the day in the trigger information
NNN the disturbance number and stored in a decimal format
EXT the extension identifying the format, e.g.

95802001.CFG
95802001.DAT

.CFG the extension for COMTRADE header files

.DAT the extension for COMTRADE data files

.INF the extension for COMTRADE information files

.HDR the extension for Comment files

To view the uploaded recordings (that are located in the subdirectory under the 
Path), click Refresh in the View menu. For more information on this command, 
please refer to Section 5.2.4.2.
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Fig. 5.2.3.-2 DR-Collector Tool presented with a list of recordings

5.2.4. Menus
There are four menus in the DR-Collector Tool main view. The commands provided 
in the menus are described in the following.

5.2.4.1. File menu

Fig. 5.2.4.1.-1 File menu

The File menu provides access to the commands Move, Copy, and Delete. These 
commands are available only when there are recordings in the DR-Collector Tool 
main view and at least one recording has been activated (see Fig. 5.2.3.-2). One 
recording may consist of several files (e.g..DAT,.CFG and HDR files). Due to this, 
when you select any of the commands Move, Copy and Delete it concerns all files 
connected to a certain recording.

When you select Remote Monitor, give the same drive name as defined in the 
MicroSCADA Base System computer. Or, you can give the path in the form: \\name 
of the personal workstation\shared directory. For example, in order to copy a 
recording from the MicroSCADA Base System computer to your personal 
workstation:

1. Share the desired directory in your personal workstation.
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2. Give the path in the form \\name of the personal workstation\shared directory.

Move

Fig. 5.2.4.1.-2 Move dialog

The Move command is used for moving a (selected) recording to the desired 
destination. You can indicate the desired destination in two ways:

• Type the path leading to the directory in the To: field.
• Click the Browse button and select the desired directory in the Select A Directory 

(see Fig. 5.2.4.1.-3)

If the check box ‘with Location’ is selected, a directory structure as defined by 
Location is created when you move the recording to the desired directory. If the 
check box ‘with Location’ is not selected, the recording is moved directly to the 
directory you have specified in the To: field. 

Click OK to approve moving. To exit the dialog without moving any recordings, 
click Cancel.

Fig. 5.2.4.1.-3 Select Directory dialog
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Copy

Fig. 5.2.4.1.-4 Copy dialog

The Copy command is used for copying a (selected) recording to the desired 
destination. You can indicate the desired destination in two ways:

• Type the path leading to the directory in the To: field.
• Click the Browse button and select the desired directory in the Select A Directory 

(see Fig. 5.2.4.1.-3)

If the check box ‘with Location’ is selected, a directory structure as defined by 
Location is created when you copy the recording to the desired directory. If the 
check box ‘with Location’ is not selected, the recording is copied directly under the 
directory you have specified in the To: field.

Click OK, to approve copying. To exit the dialog without approving copying, click 
Cancel.

Delete
The Delete command deletes the selected file(s) in the directory. Click Yes to delete 
the selected file/s. Click No to exit the dialog without deleting any file(s).

Fig. 5.2.4.1.-5 DR-Collector Tool dialog

Exit
To close the DR-Collector Tool, select the Exit command in the File menu.

5.2.4.2. View menu
The View menu contains the commands Refresh and Options.

Fig. 5.2.4.2.-1 View menu
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Refresh
The Refresh command in the View Menu can be used for searching the files defined 
in the Path in the lower part of the dialog (see Fig 5.2.2.1.-1 and Fig. 5.2.3.-2). The 
command shows them on the screen if the files are recording files. This is not, 
however, an automatic operation when starting the program.

Options
Click the View menu and select Options. 

Fig. 5.2.4.2.-2 Options dialog

The first field in the upper part of the dialog shows which disturbance recording 
format(s) is (are) supported. In this example, only the COMTRADE format is 
supported. 

In order to search recording files that are shown in the DR-Collector main view and 
in the Recorder Tool, you have to give a path to the files in the field. The path also 
defines where the recordings that will be uploaded are going to be saved. By default, 
the field contains a logical default path, and its real (absolute) path is shown in the 
lower part of the main view (see Fig. 5.2.3.-1 item 10). Click OK or Apply to start 
the search.

�
Applies only to LIB510/MicroSCADA! If Remote Monitor has been opened from 
another computer, you must indicate a drive that has been defined in the 
MicroSCADA Base System computer.
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If you want to change the default path, clear the check box Use Default Directory. 
After this the Path field is activated and you may change the path. In this case, select 
the check box Create Directories for the program to create the necessary directories, 
and click OK or Apply.

Furthermore, in the lower part of the dialog the user has to select which columns are 
to be shown in the DR-Collector Tool main view. To close the Options dialog 
without making any changes, click Cancel.

5.2.4.3. Tools menu

Fig. 5.2.4.3.-1 Tools menu

Recorder Tool
Recorder Tool is described in detail in Section 5.3 Recorder Tool.

Evaluation Tool
Evaluation Tool is used for analysing the searched recording. Please note that the 
DR-Collector Tool package does not contain any evaluation program. When you 
choose an evaluation tool, you have to take into consideration that the evaluation 
program should support the format of this program (DR-Collector Tool), e.g. 
COMTRADE. 

The options Evaluation Tool and Comment are unavailable until you have selected 
one of the recordings in the DR-Collector Tool dialog.

Start the Evaluation Tool by selecting Evaluation Tool in the Tools menu. Define 
the program in the Options dialog which is found in the Tools menu. You can also 
start The Evaluation Tool by double-clicking any recording in the list of recordings.

Comment
The option Comment opens a dialog in which you can type a more detailed analysis 
of a recording etc. The name of the file is otherwise the same as the name of the 
recording, except that it is provided with the extension HDR.

Fig. 5.2.4.3.-2 Comment dialog.
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Options

Fig. 5.2.4.3.-3 Options dialog

�
In the Options dialog, the Disturbance Evaluation Tool group box (see Fig 5.2.4.3.-
3, item 1) concerns both CAP 501/505, SMS 510, and LIB510/MicroSCADA. The 
Recording Path … group box (see Fig. 5.2.4.3.-3, item 3) applies only to LIB510/
MicroSCADA.

In the Disturbance Evaluation Tool group box (see Fig. 5.2.4.3.-3), the settings 
are unique for each Remote Monitor in LIB510/MicroSCADA. The path to the 
evaluation program is shown in the field called Path. 

You may type the path directly into the field. You can also define the path by 
clicking the Browse button and by making desired selections in the Open dialog. The 
Browse button is, however, disabled when Remote Monitor is opened from another 
computer.

In the Start-up Program group box, the function of the upper button on the right-
hand side (see Fig. 5.2.4.3.-3, item 2) changes depending on which one of the option 
buttons (Default or the User defined) is selected. When the Default option button is 
selected, the function of the button is View. When the option button User defined is 
selected, the function of the button is Edit.

Click the Edit button to view the SCIL program that is run when you start the 
Evaluation Tool. Select the check box Default to use the predefined code (i.e. no 
changes can be made to the code). If you want to make changes to the SCIL Program 
code, select the check box User defined. Click the Test button to test whether the 
program runs properly by using the code which you have selected in the check box.

3

2

1
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� If problems arise when using Reval Evaluator Program, one possible reason may be 
that Reval Evaluator Program cannot read paths given in the form \\… .

If the Reval Evaluator Program fails to open the disturbance recording file at start-
up, a possible reason is that the path name of the disturbance recording file contains 
space characters or that this program is run from a network drive. This can be 
circumvented by defining the correct path in the REVAL.INI file, using the 
“TMPL_DIR” attribute as shown in the example below:

TMPL_DIR=L:\REVAL\TMPL

RECOM_FILE=RCM-SEL.DAT

HELP_DIR=C:\DR-Analys\REVAL\HELP

RECOM_DIR=C:\DR-Analys\REVAL\RECOM

DEF_DIR=C:\SC\APL\510_401_1\RECORDER\402_TEST1\

The Recording Path on … group box (see Fig. 5.2.4.3.-3) is activated when Remote 
Monitor has been opened from another computer as MicroSCADA, and when 
Recording path contains a drive name, e.g. C:\reval\reval_nt.exe (i.e. the Recording 
path is not given in the form \\…., e.g. \\Fimit-RVS_W0314\sc\apl\demo\recorder.

� MicroSCADA W-server has to be activated before the Recording Path on… group 
box is available.

Enter the drive name of the mapped directory into the Drive field. The path appears 
in the Path field. The path is used when you start the Disturbance Evaluation Tool. 
The selected disturbance recording is opened in the Disturbance Evaluation Tool 
from the computer defined in the upper part of the group box (see Fig. 5.2.4.3.-3, 
e.g. FISUB-VA-W0392).

If the recording path to the directory is not found under the given drive, check that 
the given drive has been mapped, and that one of the directories of the path is defined 
to have shared writing rights.

The shared directory has to be mapped into the computer from where Remote 
Monitor is opened.

To accept changes, click OK. To exit the dialog without accepting the made 
changes, click Cancel.

Automated Upload…

� This function is only available in LIB 510 in MicroSCADA environment.
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The automated upload is monitored and configured by the Automated Upload 
dialog. The status of the automated upload can be:

•  Automated upload not in use 
•  Automated upload temporarily not in use 
•  Automated upload in standby 
•  Automated upload in progress 

The other fields can be available or unavailable depending on status.

� Changing the settings requires authorization level 1.

Automated Upload not in use
If the Automated Upload is configured in a way that it does not start uploading 
automatically, the status ‘Automated upload not in use’ is shown in the Status field 
(see Fig. 5.2.4.3.-4). You can configure the automated upload in a dialog that opens 
when you click the Settings... button.

Fig. 5.2.4.3.-4 Automated upload not in use

Automated Upload temporarily not in use
The status ‘Automated upload temporarily not in use’ is shown if you select the 
option ‘Disable automated upload until this session ended’ (see Fig. 5.2.4.3.-5). The 
automated upload is in that case disabled during the current session, not during the 
next session. This selection is cleared by default. Please note that this selection 
applies to all monitors in LIB 510/MicroSCADA. This means that when this 
selection is made in one monitor, the function becomes activated also in other 
monitors containing a DR-Collector Tool.
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Fig. 5.2.4.3.-5 Automated Upload temporarily disabled

Automated Upload in stand-by
The status ‘Automated upload in stand-by’ (see Fig. 5.2.4.3.-6) indicates that the 
automated uploading is in use and waits a start event and/or next periodical 
inquiring.

Fig. 5.2.4.3.-6 Automated upload in standby

Automated upload in progress
Progress of uploading is monitored in the ‘Automated upload in progress’ group box 
(see Fig. 5.2.4.3.-7). This group contains exactly the same fields as the progress 
indicator of the visible DR-Collector Tool. You can interrupt the current uploading 
by clicking Stop. 
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This dialog is opened automatically by default whenever you start the automated 
upload. However, automatic opening can be disabled when you select the option ‘Do 
not open this dialog automatically during this session’.

Fig. 5.2.4.3.-7 Automated upload in progress dialog

The DR-Collector Tool uploads only from one Disturbance Recorder at a time. 

Queue
The uploading requests, that are made while uploading is still under process, are put 
in a queue. This queue can be seen in the Queue dialog. The queue is deleted by 
clicking Clear.

Fig. 5.2.4.3.-8 Recorders in Queue dialog
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Settings

Fig. 5.2.4.3.-9 Automated Upload - Settings dialog/Start page

The configuration of automated upload is done on the Start page of the Settings 
dialog: Open the Settings dialog by clicking the Settings button in the Automated 
upload dialog. You can define the uploading to start regularly at certain periods and/
or on the basis of certain events. 

The Settings dialog consists of two pages: Start and General. The Start page contains 
two group boxes: Starts on periodic inquiry, and Starts on Events (see Fig. 5.2.4.3.-
9). If you clear both check boxes ‘Starts on periodic inquiry’ and ‘Starts on events’, 
the automated upload is disabled.

If you check the Starts on periodic inquiry check box (see Fig.5.2.4.3.-9), you can 
set its attributes. All recorders are always uploaded on the basis of the definitions 
made in the fields below. The following alternatives are available for cycle: 

•  Fixed intervals, no synchronization
•  Absolute point of time, once an Hour 
•  Absolute point of time, once a Day 
•  Absolute point of time, once a Week 
207



1MRS752008-MUMTools for Relays and TerminalsCAP, LIB, SMS
5. DR-Collector Tool User’s Guide
•  Absolute point of time, once a Month 

Define the cycle by selecting the appropriate alternative in the Cycle drop-down 
combo box. You can define the date and time with the help of the drop-down arrows. 
However, the Date and Time fields may be available or unavailable depending on 
which option you have selected in the Cycle drop-down combo box. 

In the Starts on Events group box (see Fig. 5.2.4.3.-9) the objects (relays) that 
contain disturbance recorder are listed on the left side of the table. If you select the 
Starts on Events check box, the events that trigger uploading are defined in the field 
in the middle of the table. 

Automated upload can be defined separately for every event. The field in the right 
side indicates whether the automated uploading of an event has been defined to be 
in use or not. You can change the state of a single event by double-clicking the 
column In Use. The text ‘Yes’ and ‘No’ changes automatically. However, the state 
in the In Use field may also be e.g. Error 1 when you click the Apply button. If you 
select this field (Error 1), the state is changed into Yes or No. The error codes are the 
following.

Table 5.2.4.3-1 Error codes and their explanations.

�
The option ‘Yes’ means that the event is sent to the Event List regardless of the 
settings previously defined for the event in the Event Editor. In case the state of a 
single event is ‘Yes’ in the In Use column, but the state of that same event is changed 
into ‘No’ in the Event Editor, the state is changed to ‘No’ also in the In Use column.

� The event mask of the relay has to be set that it allows the uploading of a certain 
event.

Error Code Explanation

1 Initialization has failed due to time out.

3 Protocol module cannot be loaded. Communication 
configuration is missing or has not been configured properly.

101 Process object address overlap. This status occurs in 
situations when trying to create a process object by using the 
object address (OA) and unit number (UN) that are already 
used by another logical name (LN). Existing process object 
must be removed before new configuration can be created.

102 Relay configuration does not contain the requested function 
block.

103 Base system configuration has not been configured properly. 
The definition of the STA object has probably been changed 
or it is missing, and therefore, event handling objects could 
not be created.
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Fig. 5.2.4.3.-10 Automated Upload – Settings dialog/General page

In the Event notification group box (see Fig. 5.2.4.3.-10) in the General page it is 
possible to make the following selections: 

• Generate an event whenever uploading is started. The event text is sent to the 
event list when automated upload is started.

• Generate event whenever uploading is completed. The event text is sent to the 
event list when automated upload is finished.

• Generate event whenever uploading is canceled. The event text is sent to the 
event list when automated upload is canceled.

Automated upload affects the operating rate of other programs. To leave processing 
time for other programs as well, you are able to alter the operating rate of automated 
uploading. This is done in the Settings dialog/General page which contains 
Communication priority drop-down combo box (see Fig. 5.2.4.3.-10). Select the 
priority level in which Automated Upload is performed from the following 
alternatives:

•  Maximum priority
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•  High priority
•  Medium priority
•  Low priority
•  Minimum priority

The default alternative for communication priority is Medium priority. Maximum 
priority means that recordings are read as quickly as possible, and Minimum priority 
means that recordings have the lowest priority, and processing time is left for other 
programs, too. In other words, the lower priority selected in the drop-down combo 
box, the slower uploading.

5.2.4.4. Help menu

Fig. 5.2.4.4.-1 Help menu

About DR-Collector Tool
The dialog About DR-Collector Tool contains information on the current version of 
the DR-Collector Tool. Click OK to close the dialog.

5.2.5. Toolbar buttons
The most important menu functions are also available as toolbar buttons. These 
functions are described in detail in Section 5.2.4.
210



1MRS752008-MUM CAP, LIB, SMSTools for Relays and Terminals
User’s Guide 5.  DR-Collector Tool

5

Fig. 5.2.5.-1 DR-Collector Tool toolbar buttons

5.3. Recorder Tool
5.3.1. General

As described in Section 5.2.4.3, start the Recorder Tool by selecting Recorder Tool 
in the Tools menu in the DR-Collector Tool.

The Recorder Tool contains different kinds of functions depending on the recorder, 
e.g. monitoring, manual uploading of functions, such as remote triggering, delete 
recording, and possibly other special functions, too. 

5.3.2. Functions
Information given in the Recorder Tool dialog (see Fig. 5.3.2.-1, items 4 and 5) 
depends on what kind of relay/recorder you have selected. When entering the 
Recorder Tool, there are no monitoring fields on the right in the dialog (see Fig. 
5.3.2.-1, items 4 and 5). Only when you select a recorder in the tree structure, the 
monitoring fields on the right are visible.

Information given in the monitoring fields depends on the recorder. The example 
given below concerns disturbance recorders configured for RED 500 relays. In 
addition to the standard menus, there may also be other menus available depending 
on the recorder.

All installed relays that contain a disturbance recorder are shown in the tree 
structure.

Exit

Copy

Delete (requires authorization level 1)

Refresh

Recorder Tool

Evaluation program

Comment
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The object Eastwick in the tree structure corresponds to the information given in the 
Location column found in the DR-Collector Tool main view.

Fig. 5.3.2.-1 An example of a Recorder Tool main view with the tree structure 
and information concerning the MEDREC16 disturbance recorder 
configured for REF 54X relay.

1. Menus
2. Toolbar buttons
3. Tree structure (i.e. hierarchy of relays and disturbance recorders)
4. Monitoring fields, i.e. information concerning the disturbance recorder 

MEDREC16 configured for REF 54X
•  Identification identifies the recorder
•  # of Recordings indicates the number of recordings
•  Memory Size indicates the maximum amount of recordings the memory pool 

of the recorder can hold
•  Operation Mode is discussed in Section 5.3.3 on page 213.

5. Monitoring fields, i.e. information concerning recording when MEDREC16 
disturbance recorder is configured for REF 54X relays.

•  Date and time indicate when triggering was generated
•  Trigger specifies the reason of triggering (e.g. Manual/External)
•  Extension is a type of a recording. When the type of the recording is 

Extension, the program intends to combine the recording with the previous one 
to form only one recording. If this operation is not successful, recordings 
remain as separate recordings.

•  File indicates the file name of the recording
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6. Object selected in the tree structure from which recordings are made
7. Type of the object selected in the tree structure (i.e. type of relay)
8. The date and time when the dialog was refreshed the last time

5.3.3. RE_54_ transient disturbance recorder (REF54x, REM54x, 
REC523)
There are three types of Operation Modes (see Fig. 5.3.2.-1, item 4); Saturation 
mode, Overwrite mode, and Extension mode. For more information on the different 
modes, please refer to the RE_54_ Transient Disturbance Recorder (MEDREC16) 
manual.

ID is composed of the parameters Identification (M18) and Main header (M20).

5.3.4. Disturbance recorder SPCR 8C27

Fig. 5.3.4.-1 An example of a Recorder Tool main view with the tree structure 
and information concerning the SPCR 8C27 disturbance recorder 
configured for SPACOM relay.
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5.3.5. Internal disturbance recorder SPCD 2D55, SPCD 3D53

Fig. 5.3.5.-1 An example of a Recorder Tool main view with the tree structure 
and information concerning the SPCD 2D55 relay module 
containing a disturbance recorder configured for SPACOM relay.

Remote triggering is not available, because SPCD 2D55 does not support triggering.
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5.3.6. Internal disturbance recorder REU5xx, REJ 5xx

Fig. 5.3.6.-1 An example of a Recorder Tool main view with the tree structure 
and information concerning the internal disturbance recorder of 
REJ 5xx relay module.

5.3.7. Menus
The Recorder Tool view contains three standard menus which are presented in the 
following.

5.3.7.1. File menu

Fig. 5.3.7.1.-1 File menu

Exit
Exit from the Recorder Tool dialog is provided by the Exit command in the File 
menu. 

5.3.7.2. View menu

Fig. 5.3.7.2.-1 View menu
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Refresh
The command Refresh is available in the View menu only you have selected a 
recorder in the tree structure. The Recorder Tool reads necessary information from 
the disturbance recorder in order for the recorder tool dialog to be updated.

5.3.7.3. Transfers menu

Fig. 5.3.7.3.-1 Transfers menu

�
Authorization level 1 is required to execute "Upload recording", "Delete recording" 
and "Remote triggering" functions. If the "MV_RELAYS" -authorization group has 
been defined in the user management, then DR-Collector Tool uses an authorization 
level defined for that group. Otherwise it uses the "GENERAL" group.

Reservation of communication
The Recorder Tool reserves communication to the selected object upon a 
transaction. The transaction can be whatever communication between the tool and 
the recorder (Refresh, Upload etc.). Communication is reserved until either the tool 
is closed, or until fifteen (15) minutes has elapsed since the transaction ended, after 
which the communication will be automatically released.

Upload Recording
Uploading concerns the recorders that are shown under the selected object in the tree 
structure. In case you have selected the root in the tree structure, uploading concerns 
all recorders in the tree structure below the root. Therefore, click Yes to upload all 
recordings from the allocated recorders under the root in the tree structure. Click No 
to exit the dialog without uploading any recordings.

Fig. 5.3.7.3.-2 Upload Recording dialog when the Root is selected

�
Applies to MEDREC16 only: If you interrupt the uploading procedure, the 
recording remains locked in the transfer buffer. This recording will not be deleted if 
you have emptied the memory pool by using the relevant buttons in the front panel 
of the relay, or when the operation mode is Overwrite. If you wish to delete a 
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recording from the memory pool, it is recommended to use the Delete Recording 
function of the DR-Collector Tool. 

Applies to SPCR 8C27: Uploading of disturbance recordings from SPCR 8C27 is 
performed over the SPA bus, i.e. using the rear connector of the host relay or the 
SPTO front connector (SPAC 500/600 series feeder terminals). The uploading of 
disturbance recordings through the front connector of the SPCR 8C27 is not 
supported.

In case you have selected one of the recorders below the Root in the tree structure, 
uploading concerns only the recordings registered by that specific recorder.

Fig. 5.3.7.3.-3 Upload Recording dialog when a recorder is selected

In the Upload Recording Dialog (see Fig. 5.3.7.3.-3) you may choose the following:

• Upload of all recordings from the selected recorder module, click the Upload All 
button.

• Upload of one recording from the selected recorder module, click the Upload One 
button.

• To exit the dialog without uploading any recordings, click Cancel.

The button Upload One may also be clicked repeatedly, i.e. several recordings can 
be uploaded one by one by clicking the button repeatedly.

Remote Triggering
Disturbance Recording is triggered by a remote command.

Remote triggering concerns the recorders that are shown under the selected object 
in the tree structure. If you have selected the Root in the tree structure, remote 
triggering concerns all recorders in the tree structure below the Root. Click Yes to 
trigger remotely all allocated recorders under the object Root in the tree structure. 
Click No to exit the dialog without triggering any recorders.
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Fig. 5.3.7.3.-4 Remote Triggering dialog when the Root is selected

Fig. 5.3.7.3.-5 Remote Triggering dialog when a recorder is selected

If you have selected one of the recorders below the Root, only the specific recorder 
can be triggered remotely. Click Yes to trigger the selected recorder module 
remotely. Click No to exit the dialog without triggering the selected recorder module 
remotely.

Delete Recording
Delete recording concerns the recorders that are shown under the selected object in 
the tree structure. If you have selected the Root in the tree structure, the command 
Delete Recording concerns all recorders in the tree structure below the root. Click 
Yes to delete all recordings from the allocated recorders under Root in the tree 
structure. Click No to exit the dialog without deleting any recordings.

Fig. 5.3.7.3.-6 Delete Recording dialog when the Root is selected

In case one of the recorders below the root has been selected, the Delete Recording 
command concerns only recordings registered by the specific recorder.
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Fig. 5.3.7.3.-7 Delete Recording dialog when a recorder in the tree structure is 
selected

In the Delete Recording Dialog (see Fig. 5.3.7.3.-7) you may choose the following:

• Delete all recordings from the selected recorder module, click the Delete All 
button.

• Delete of one recording from the selected recorder module, click the Delete One 
button.

• To exit the dialog without deleting any recordings, click Cancel.

Notification dialog
If you have selected a command that includes more than one recorder in the 
following dialogs: Upload Recording, Remote Triggering or Delete Recording, a 
notification dialog appears on the screen (see Fig. 5.3.7.3.-8). This notification 
dialog shows all recorders (i.e. objects) included in the command. It also shows the 
status, i.e. whether the action of the command was successful or not.

Fig. 5.3.7.3.-8 Upload Recording - Notification dialog

5.3.7.4. Reset menu
Reset Menu is available when you have selected SPACOM object and SPCR 8C27 
module in the Recorder Tool.
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Fig. 5.3.7.4.-1 Reset menu

Unit (warm start-up)
Reset Unit (warm start-up) restarts the recorder without deleting existing recordings.

Monitored signals
The recorder records minimum and maximum values and gives time stamps for 
them. The minimum and maximum values and their time stamps are read from the 
parameters V2 … V14. The Reset Monitor signals option resets time stamps and 
values, i.e. the minimum value 0, maximum value 0 and time stamp 0 are written in 
the parameters V2 … V14. 

5.3.7.5. Toolbar buttons
The most important menu commands are also presented as toolbar buttons.

Fig. 5.3.7.5.-1 Recorder Tool standard toolbar buttons

In addition to the standard buttons presented above, there may also be other buttons 
and/or objects depending on the recorder.

5.4. SMS 510s interconnected over LAN or RAS

�
The functionality described below is supported only, when two SMS 510 systems 
are interconnected via LAN or RAS. The disturbance recordings cannot be uploaded 
from the SYS 500/LIB 5xx or COM 500 to the SMS 510. However, communication 
from the SMS 510 to the relays is established via SYS 500/LIB 5xx and COM 500, 
if their application has been built using LIB 500/5x0

Exit

Refresh

Upload Recording

Remote Triggering

Delete Recording
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If a remote connection has been established, the following functions are enabled; 
DR-Collector Tool shows also the header information of the new recordings located 
on the remote station (see Figure 5.4.-1). The disturbance recordings that are located 
in the remote SMS 510 computer are marked with the [remote] keyword and the 
recordings that reside on the local computer are marked with the [local] keyword.

You can upload the [remote] disturbance recordings from the remote station/SMS 
by selecting Upload Recording Files… on the Tools menu or by clicking the 
respective toolbar button. You can either copy or move the disturbance recordings 
from the remote station (see Figure 5.4.-2). A remotely stored recording can be 
uploaded only once regardless of the selected option (copy/move). 

Internally, the DR-Collector Tool maintains a locally stored list, which contains the 
new recordings that the tool has uploaded from the disturbance recorders. When a 
connection between two SMS 510 systems has been established, the local DR-
Collector Tool reads the list on the remote computer and indicates the remotely 
stored recordings using the keyword [remote]. Upon completion of every successful 
recording upload from a remote to local SMS 510, the list on the remote computer 
is cleared. This means that the recordings are available for upload only once.

The Copy, Move, Delete, Evaluation Tool and Comment functions are enabled for 
[local] recordings only.

Fig. 5.4.-1 Disturbance recording list in the DR-Collector tool. Both remotely 
and locally stored recordings are displayed.
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Fig. 5.4.-2 The prompt for the type of the upload

5.5. Engineering information

5.5.1. LIB 500 menu configuration for DR-Collector Tool
The DR-Collector Tool is started from a menu in the station picture. By default, the 
menu item of the DR-Collector Tool is located in the Options menu. The menu item 
uses the settings as defined in Fig. 5.5.1.-1 and in Fig. 5.5.1-2. The menu 
configuration can be done using the Menu Configuration Tool of the LIB 500.

Fig. 5.5.1.-1 Add Menu Item dialog
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Fig. 5.5.1.-2 Advanced settings for the menu item

5.5.2. Command procedures
Automated upload uses some command procedures that are executed as parallel 
tasks.

The default queue for automated uploading is six (PE = 6). If this queue is already 
in use for time critical objects, the value of this attribute can be changed but NOT 
set to 0. To change the default value 6, open the following file: 
\Sc\Lib4\base\bbone\use\BGU_Product.ini, and change the value of the following 
attribute: DRCT_Parallel_Queue = 6.

� The value of the attribute Parallel queues in the base system configuration may not 
be lower than the value of the PQ attribute (APL:BPQ).

5.5.3. Configuring SRIO parameters when connected to MicroSCADA
If recordings are read through SRIO, SRIO’s timeout value must be increased from 
50 ms to 300 ms. The disturbance recorder has several exceptionally long parameter 
values that can cause communication problems, if the timeout default value (50 ms) 
is used. Please refer to SETUP 2 command in the programming manual for SRIO 
1000M and 500M for more details of this command.

5.5.4. Other information

� Only SPCR 8C27 is supported, not SPCR 8C19.
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6. SPA-Terminal Emulator

6.1. Description
The SPA-Terminal Emulator program is a DOS based tool intended for low level 
communication on parameter level over the SPA protocol to SPA protocol relays. 
The tool uses the serial port of the PC for the communication.

The SPA-Terminal Emulator provides the user with a convenient method of 
communicating with SPA relays without having to write the whole SPA protocol 
syntax. The communication is done on a manual basis and initiated by the user.

 The tool is used for the following purposes:

• Testing and analysing the communication to certain SPA devices, e.g. trouble 
shooting communication failure situations from CAP 50x/SMS 510.

• Simple setting operations, like changing of addresses of the relay.
• Reading parameter values.

�
The SPA-Terminal Emulator is a powerful tool. For relay setting or relay 
configuration purposes the user shall use therefore dedicated tools provided by CAP 
50x/SMS 510. However, if the user uses SPA-Terminal Emulator for setting 
purposes, other than changing SPA addresses, the user shall carry the responsibility.

6.1.1. Communication support
The SPA-Terminal Emulator can be connected to the SPA devices by using a cable 
directly between the PC serial port and the SPA device (see hardware section for list 
of cables in CAP 501 or CAP 505 Installation and Commissioning Manuals). It can 
also be connected to a fiber optical SPA bus with numerous units. Telephone 
modems are not supported.

�
Limitations: SPA-Terminal Emulator does not support communication via cable 
1MKC950001-1. If you connect a SPA-Terminal Emulator to a relay that uses 
1MKC950001-1 in the front, you have to connect the emulator to the rear 
communication port.

6.1.2. Starting the program
The SPA-Terminal Emulator is activated from the Tools folder in CAP 50x/SMS 
510.

You cannot have other programs running which have access to the same serial port 
that you intend to use with the SPA terminal program. Therefore, close e.g. CAP 
50x/SMS 510 before running the SPA-Terminal Emulator.

In Table 6.1.2-1 you can see the start-up screen for the SPA-Terminal Emulator. The 
last two lines contain the actual communication parameter settings.
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6.1.3. Exiting the program
To exit the SPA-Terminal session press <Ctrl> Z followed by <Enter>.

6.1.4. Communication setup 
The communication settings are changed by typing the following: ”- +  
corresponding letter + new value (-ParametreNew_Value)”

Parameters that can be set:

• -a The SPA-slave address to which communication will take place
• -b Baud rate used
• -c The communication port of the computer
• -d Databits
• -p Parity

Example: -a29 changes the settings of the SPA-Terminal Emulator to use address 29 
for all SPA messages sent, until other is defined.

After the setting of the communication parameters is completed, the communication 
to the SPA device can begin, provided that the SPA-Terminal is properly connected 
to the SPA device.

6.1.5. Reading and sending of SPA messages
Messages are sent either to the module as a read (R = Read) or a write (W = Write) 
message. Write messages change the actual parameter setting in the SPA device.

�
Some parameters depending on SPA device are protected by a remote setting 
password (concerns only Write function). Please refer to SPA device manual 
parameter listing.

Give the messages you want to send without start characters, address or checksum. 
These are added automatically by the tool.

Also see communication examples in the next Section 6.1.6 SPA-Terminal 
Emulator examples.

Table 6.1.2-1 The standard start-up screen for the SPA-Terminal Emulator
SPA-program for SPACOM communication. Version 4.0

Type SPA-commands without address and checksum. For example: RF (not 
>3RF:XX).
To change a parametre value on line type -ParametreNew_Value
e.g. -a23 to change SPA address or -b1200 to change baud rate.
To exit type CTRL/Z ENTER
Com1 9600 bps 7 dbits parity=e No handshake SPA-addr=1 multi_line_answer=2 
lower_case=0
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In certain types of relay modules, the settings have to be stored by a separate store 
command: WV151:1. This concerns e.g. SACO annunciators and SPTO control 
modules.

6.1.6. SPA-Terminal Emulator examples
This section illustrates the communication between a SPA device e.g. a SPAJ 140 C 
and the SPA-Terminal Emulator. Refer to the SPA device manual for listing of all 
available parameters, with settings, ranges and identity. 

R = Read, i.e. read parameters from the module, W = Write, i.e. send new settings 
for a parameter in the module. Capital letters may also be used.

Conditions in the example:

A SPAJ 140 C relay with the module SPCJ 4D29 with SPA slave address 12 is 
connected via a SPA-ZP-5A3 cable to the COM2 port of the PC. The example 
features also a change of the address to 43.

To avoid mixing the comments with the original texts presented in the SPA-
Terminal Emulator, the comments are written in bold.

Default tool settings

COM1   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=1               

multi_line_answer=2    lower_case=0   

Change the communication address to 12, (SPA Device with address 12)

COM1   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=1 

multi_line_answer=2    lower_case=0

-a12    

The address is changed to 12 in the tool

COM1   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=12

multi_line_answer=2    lower_case=0 

Identify the module with RF command

COM2   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=12

multi_line_answer=2    lower_case=0

rf                    

>12RF:13 (Master request)                <12D:SPCJ 4D29:2A   (Slave reply)

Table 6.1.5-1 The example below shows a module type request (F) and the 
reply from the module.

• Master - RF • F should give the relay type as a reply

• Slave - <1D:SPCJ 4D29:18 • This is a SPCJ 4D29 module!
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The message >12RF:13     <12D:SPCJ 4D29:2A consists of two parts; the master 
request and the slave reply. >12RF:13 is the message sent by the master ( > sign). 
<12D:SPCJ 4D29:2A is the message sent by the slave (< sign). In this case it is a 
SPCJ 4D29 module and has the address 12. 2A is the checksum.

What will happen if you test with the wrong address or there is a 
communication failure?

Change address to 13

COM2   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=12      

multi_line_answer=2    lower_case=0

The address is now 13, identification by RF.

COM2   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=13     

multi_line_answer=2    lower_case=0                                     

rf

Identify yourself!

>13RF:12                 TIMEOUT***ERROR***          

The message >13RF:12  TIMEOUT***ERROR***   means that no contact has been 
established with address 13. The reason does not appear, but usually some 
communication parameters are set wrong, (check with the settings in the 
module on the front panel display), wrong cable is used, serial port broken on 
PC etc.

Change back to the right address, 12.

COM2   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=13     

multi_line_answer=2    lower_case=0

-a12

Check if connection is achieved.

COM2   9600 bps   7 dbits   paritet=e   No handshake   SPA-addr=12     

multi_line_answer=2    lower_case=0

rf

>12RF:13                 <12D:SPCJ 4D29:2A 

Change of the SPA device address to e.g. 43 means that parameter V200 shall 
get a new value.

wv200:43

>12WV200:43:09           <12A:44

Also change the address to the SPA-Terminal Emulator.

-a43

COM1   9600 bps   7 dbits   parity=e   No handshake   SPA-addr=43

multi_line_answer=2    lower_case=0
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Check the communication, rf command.

rf

>43RF:17                 <43D:SPCJ 4D29:2E

With e.g. SACO and SPTO SPA devices you also need to separately store the 
settings and address changes.

wv151:1

>43WV151:1:3C            <43A:40

Exit by pressing <Ctrl> <Z> and <Enter> .

^Z
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